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Product description

The Oncomine™ BRCA Assay GX (Cat. No. A47912) is a comprehensive targeted next generation
sequencing (NGS) assay designed for sensitive detection of all coding regions of the human BRCA1
and BRCA2 genes.

Each kit includes 2 pools of lon AmpliSeg™ oligonucleotide primers (DNA panel) and Genexus™ library
reagents sufficient to sequence up to 32 samples on the Genexus™ Integrated Sequencer, using a
GX5™ Chip (see “Oncomine™ BRCA Assay GX” on page 9). One end-to-end sequencing run uses

1 lane on a GX5™ Chip and accommodates up to 16 samples. The provided reagents are sufficient for
2 end-to-end runs. Additional Genexus™ Integrated Sequencer reagents and supplies must be ordered
separately (see “Required materials not supplied for use with the Genexus™ Integrated Sequencer” on
page 20).

When used with the Oncomine™ BRCA Assay GX, the Genexus™ Integrated Sequencer performs library
preparation, sequencing, analysis, and reporting in an automated sample-to-result workflow (when
using the Genexus™ Purification System). Depending on the workflow, results can be obtained in as
little as a single day. Multiplex primer design and sample barcoding leverage lon AmpliSeq™ technology
to generate results from multiple samples in a single run. Sequencing results are automatically analyzed
in the Genexus™ Software using an optimized assay-specific analysis workflow.

This user guide provides the following instructions.

* How to use the Oncomine™ BRCA Assay GX to perform a Sample to Result next-generation
sequencing (NGS) run on the Genexus™ Purification Instrument for nucleic acid isolation, followed
by sequencing on the Genexus™ Integrated Sequencer.

* How to use the Oncomine™ BRCA Assay GX to perform a Nucleic Acid to Result next-generation
sequencing (NGS) run on the Genexus™ Integrated Sequencer.

* How to perform data analysis of the sequencing run.

Oncomine™ BRCA Assay GX User Guide 7
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Product description

About BRCA genes

BRCA1 and BRCAZ2 genes are tumor suppressor genes that code for proteins that are vital components
of the homologous recombination pathway of DNA damage repair. BRCA mutations that result in the
deficiency of either gene have been shown to result in inefficient activation of DNA damage repair and
are linked to hereditary predisposition to cancer. Errors in the coding sequence of the BRCA genes have
been detected in both inherited DNA found in all cells and in mutated DNA found in localized tumor
cells. The Oncomine™ BRCA Assay GX is a complete kit that supports the amplification of the entire
exonic region of both BRCA genes.
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Oncomine™ BRCA Assay GX

The Oncomine™ BRCA Assay GX (Cat. No. A47912) includes a 2-pool DNA panel, Genexus™ Strip 1,
and Genexus™ Strip 2-AS. The contents of each kit are sufficient for up to 32 x 2-pool reactions. The
panel is provided in 2 packs of 8 tubes (4 tubes of BRCA DNA Pool 1 and 4 tubes of BRCA DNA Pool 2
per pack). Each primer pool in the panel is provided in pairs of tubes, where each tube pair contains
one tube with primers in position 1 and one empty uncapped tube in position 2. Two 8-strip packs

of the Genexus™ Strip 1 and Genexus™ Strip 2-AS (16 total of each strip) are provided with each

kit. If needed, the Genexus™ Library Strips 1 and 2-AS combo kit (Cat. No. A40252) can be ordered

separately.

Table 1 Oncomine™ BRCA Assay GX (Cat. No. A47912)

Chapter 1 Product information ~ [E5H#
Oncomine™ BRCA Assay GX

Ns e

Contents Carrier color Number of reactions Amount Part No. Storage

Oncomine™ BRCA Assay GX pools

BRCA DNA Pool 1 Magenta 2 x 16 (4 reactions/tube) 2 x 4 tubes, A44353 |-30°C to -10°C

(position 1) 140 plL/tube

BRCA DNA Pool 2 Pale green 2 x 16 (4 reactions/tube) 2 x 4 tubes,

(position 1) 140 pl/tube

Genexus™ Library Strips 1 and 2-AS (Cat. No. A40252)

Genexus™ Strip 1 Light red 2 x32 2 x 8 strips A46812 2°C to 8°C
(4 single-pool reactions/strip)

Genexus™ Strip 2-AS | Light blue 2 x32 2 x 8 strips A46813 | -30°C to -10°C
(4 single-pool reactions/strip)

Oncomine™ BRCA Assay GX User Guide
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M Chapter 1 Product information

T

Sample to Result workflow

Sample to Result workflow

Using the Oncomine™ BRCA Assay GX, the Sample to Result workflow starts from unprocessed
samples and isolates nucleic acid on the Genexus™ Purification Instrument. The resultant 96-well output
plate can be loaded directly into the Genexus™ Integrated Sequencer for sequencing.

Note: If using the Genexus™ Purification Instrument in standalone configuration, proceed to the
appropriate purification chapter and follow the guidance for on-instrument run planning.

Select a system-installed assay (page 31)

System-installed assays are available in the Genexus™ Software for use

with the Genexus™ Purification Instrument. Each system-installed assay is
configured with settings that are optimized for a specific sample type. Create
a new assay by copying an existing system-installed assay and modifying the

parameters.
@ Enter samples (page 32)
30 min Before you plan a run in Genexus™ Software, you must first enter sample
information in the software to assign sample names and provide other -
information.

Create a Sample to Result run plan (page 33)

In the Genexus™ Software, create a Sample to Result run plan to integrate both
nucleic acid purification and sequencing. The run plan defines the samples,
assays, purification kit, sequencing reagents, and the number of sequencing
chip lanes that will be required.

Prepare FFPE samples (page 38)

AND/OR
Prepare whole blood samples (page 67) @

Sample processing prior to adding to the appropriate purification plate and
loading onto the instrument for purification of DNA.

Load the Genexus™ Purification Instrument

The Sample to Result run plan is selected and the run initiated. The instrument
performs a prerun UV clean, then samples, reagents, and consumables are
loaded on to the instrument.
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Chapter 1 Product information [
Sample to Result workflow

Start the run
After the sample plate and all reagents and consumables have been loaded the
instrument door is closed and the run started.
U

Unload the purified nucleic acids

Remove the 96-Well Nucleic Acid Output Plate and proceed immediately to
sequencing of the purified sample. Remove and seal the 48-Well Nucleic
Acid Archive Plate, then store as directed for later use. Used reagents and
consumables are removed from the Genexus™ Purification Instrument and a
UV clean is performed.

Sequence the purified nucleic acids on the Genexus™
Integrated Sequencer (page 93)

Load the output plate with the purified nucleic acids, and all reagents and
consumables required for the run, onto the integrated sequencer. Select the
Sample to Result run plan, then press start.

&
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Chapter 1 Product information
Nucleic Acid to Result workflow

Nucleic Acid to Result workflow

Using the Oncomine™ BRCA Assay GX, the Nucleic Acid to Result workflow starts from purified and
quantified nucleic acid samples. Samples are loaded into a 96-well sample input plate and then loaded
into the Genexus™ Integrated Sequencer for library preparation, templating, and sequencing.

Note: If using the Genexus™ Purification Instrument in standalone configuration, proceed to the
appropriate purification chapter and follow the guidance for on-instrument run planning.

3 hr

12

Prepare purified DNA

The Genexus™ Purification Instrument is not required for Nucleic Acid to Result
sequencing runs. Any of the recommended nucleic acid purification kits can be
used to purify DNA for use in Nucleic Acid to Result runs.

If sample quantitation was not performed as part of the purification run, use a
Qubit™ Fluorometer to accurately measure sample concentration.

For more information see the appropriate purification protocol chapter.

Enter samples (page 32)

Before you plan a run in Genexus™ Software, you must first enter sample
information in the software to assign sample names and provide other
information.

Create a Nucleic Acid to Result run plan (page 35)

In the Genexus™ Software, create a Nucleic Acid to Result run plan to create a
sequencing run that starts with nucleic acid samples. The run plan defines the
samples, assays, sequencing reagents, and the number of sequencing chip
lanes that will be required.

Sequence the purified DNA on the Genexus™
Integrated Sequencer (page 93)

Transfer extracted nucleic acid, from the archive plate if a Genexus™ Purification
Instrument was used, to a 96-well plate which serves as the sample input plate
for the Genexus™ Integrated Sequencer. Load the input plate with the purified
nucleic acids, and all reagents and consumables required for the run, onto the
integrated sequencer. Select the Nucleic Acid to Result run plan, then press
start.

[

&
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Purification-only workflow (standalone configuration)

Purification-only workflow (standalone configuration)

The following workflow outlines using the Genexus™ Purification Instrument in standalone configuration
to prepare purified DNA for use in Nucleic Acid to Result runs or other non-sequencing applications.

Note: When using the Genexus™ Purification Instrument in standalone configuration, proceed to the
appropriate purification chapter and follow the guidance for on-instrument run planning.

Create a purification run plan

Create a new purification run plan or copy/edit an existing purification run
plan that best represents your experiment, then edit the settings as needed.
Purification run plans contain instrument settings that are used in sample
purification.

Prepare samples

Depending on the sample type, samples may require preparation before
loading into the appropriate purification plate and starting the run. For more
information see the appropriate purification protocol chapter.

Load the Genexus™ Purification Instrument

Using the instrument touchscreen, the purification run plan is selected and the
run initiated. The instrument performs a prerun UV clean, then samples and
consumables are loaded on to the instrument.

Start the run

After the sample plate and all reagents and consumables have been loaded the
instrument door is closed and the run started.

Unload the purified nucleic acids

Remove and seal the 48-Well Nucleic Acid Archive Plate, then store as directed
for later use. Used reagents and consumables are removed from the Genexus™
Purification Instrument and a UV clean is performed.

Oncomine™ BRCA Assay GX User Guide
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8  Chapter 1 Product information

Purification-only workflow (standalone configuration)

Sequence the purified nucleic acids on the Genexus™
Integrated Sequencer (page 93)

Transfer purified and quantified DNA samples from the archive plate to a
96-well plate which serves as the sample input plate for the Genexus™
Integrated Sequencer. Load the sample input plate with the purified nucleic
acids, and all reagents and consumables required for the run, onto the
integrated sequencer. Select the Nucleic Acid to Result run plan, then press
start.

i
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Recommended materials for use with the Oncomine™ BRCA Assay GX ..............cuv.n.. 16
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This chapter lists the reagents, supplies, and materials needed to operate the Genexus™ Purification
Instrument and Genexus™ Integrated Sequencer, and provides consumables ordering and storage
information. Reagents and supplies can be ordered as kits and starter packs, but most consumables
can also be ordered individually as your needs require.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers
cannot be ordered individually.
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Chapter 2 Reagents, supplies, and required materials
Recommended materials for use with the Oncomine™ BRCA Assay GX

Recommended materials for use with the Oncomine™
BRCA Assay GX

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Recommended materials for nucleic acid isolation, quantification, and
quality control

Note: These materials are only recommended for Nucleic Acid to Result runs when not using the

Genexus™ Purification System.

Item Source
Nucleic acid isolation
MagMAX™ DNA Multi-Sample Ultra 2.0 Kit (Blood samples) A36570
PureLink™ Genomic DNA Mini Kit (Blood samples) K1820-01
MagMAX™ FFPE DNA/RNA Ultra Kit (FFPE samples) A31881

RecoverAll™ Multi-Sample RNA/DNA Workflow (FFPE samples)

A26069, A26135

Nucleic acid quantification

Qubit™ 4 Fluorometer('l and one or more of the following kits:
* Qubit™ dsDNA BR Assay Kit (Blood samples)
* Qubit™ dsDNA HS Assay Kit (FFPE samples)

Q33238
Q32850, Q32853
Q32851, Q32854

Nucleic acid quality control

Agilent™ 2100 Bioanalyzer™ Instrument and one or more of the following kits: G2939BA
* Agilent™ High Sensitivity DNA Kit (DNA samples) 50687-4626
(Agilent)
1 Qubit™ 2.0 Fluorometer and later are supported.
Recommended sample controls
Item Source

Seraseq™ Inherited Cancer DNA Mix v1

0730-0003 (SeraCare)

BRCA Germline | (gDNA)

HD793 (Horizon)

BRCA Somatic Multiplex | (FFPE)

HD810 (Horizon)

16
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Genexus™ Controls

Reagents and supplies for use with the Genexus™ Purification Instrument

Chapter 2 Reagents, supplies, and required materials

The lon Torrent™ Genexus™ Controls kit (Cat. No. A40267) provides sufficient Genexus™ Control
Library-AS to perform four Library to Result runs. The kit also provides sufficient Genexus™ Control
Panel-AS and Genexus™ DNA Control to perform eight Nucleic Acid to Result runs.

e

Note: The Genexus™ Control Library-AS is barcoded with lonCode™ 0101.

Component

Quantity

Storage

Genexus™ Control Library-AS

1 tube

Genexus™ Control Panel-AS

8 carriers (white)

Genexus™ DNA Control

2 tubes

-30°C to -10°C

Reagents and supplies for use with the Genexus™
Purification Instrument

Genexus™ Purification Instrument reagents and supplies can be ordered as kits and starter packs, but

most consumables can also be ordered individually as your needs require.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers

cannot be ordered individually.

Genexus™ Purification System

The Genexus™ Purification System (Cat. No. A48148) includes the following components.

Components Part. No.
Genexus™ Purification Instrument A47646
Genexus™ Purification Install Kit A48549(1]

' Not available for separate purchase.

Oncomine™ BRCA Assay GX User Guide
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5F Chapter 2 Reagents, supplies, and required materials
Recommended materials not supplied for use with the Genexus™ Purification System

lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit

The lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit (Cat. No. A45539) includes the
following subkits sufficient for 48 sequential DNA and RNA isolations from FFPE curls or slides.

IMPORTANT! Store all kit components in the upright orientation.

Component Part No. Storage
Genexus™ FFPE DNA and RNA Purification A45532 15°C to 30°C
Genexus™ Nucleic Acid Quantitation A45538 2°C to 8°C
Genexus™ Purification Supplies 2 A45574 15°C to 30°C

lon Torrent™ Genexus™ Multisample DNA Purification Kit

The lon Torrent™ Genexus™ Multisample DNA Purification Kit (Cat. No. A45540) includes the following
subkits sufficient for 48 DNA isolations from whole blood, bone marrow, peripheral blood leukocytes,

cultured cells, and fresh or frozen tissue samples.

IMPORTANT! Store all kit components in the upright orientation.

Component Part No. Storage
Genexus™ Multisample DNA Purification A45533 15°C to 30°C
Genexus™ Nucleic Acid Quantitation, Broad Range A45537 2°Cto 8°C
Genexus™ Purification Supplies 1 A45529 15°C to 30°C

Recommended materials not supplied for use with the

Genexus™ Purification System

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Item

Source

Equipment

Bench top microcentrifuge

* Cole-Parmer EW-17414-06
¢ Eppendorf 022620304

18
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Chapter 2 Reagents, supplies, and required materials ~ FP59
Recommended materials not supplied for use with the Genexus™ Furification System

)

(continued)
ltem Source
For use with Genexus™ FFPE DNA and RNA Purification Kit

Sorvall™ ST 8 Small Benchtop Centrifuge, with 75007200
Thermo Scientific™ M10 Microplate Swinging Bucket Rotor, and 75005706
Sealed Bucket; Capacity: 4 Standard or 2 Midi-Deepwell plates (Set of 2) 75005721
(or equivalent)

S50441A

Economy Lab Incubator (2, 60°C and 90°C)

fisherscientific.com

Heating block (2, 60°C and 90°C) MLS
Precision™ General Purpose Water Bath (or equivalent) MLS
Equipment and consumables for AutoLys M FFPE sample extractionl']

AutoLys M Tubes and Caps kit A38738
AutolLys M Tube Rack A37955
AutolLys M Tube Locking Lid A37954
AutoLys M TubelLifter or A37956
AutolLys M Tube Pliers A38261
For use with Genexus™ Multisample DNA Purification kit

Fisherbrand™ Bead Mill 24 Homogenizer (or equivalent) 15-340-163

Polytron homogenizer

Pro Scientific, PRO250

Tubes, plates, and other consumables

MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with
Barcode

4483354, 4483352

Adhesive PCR Plate Foils AB0626
CitriSolv™ Clearing Agent 22-143-975
Xylene MLS
Ethanol, 100% MLS

' For use with the Genexus™ FFPE DNA and RNA Purification Kit.
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Required materials not supplied for use with the Genexus™

Integrated Sequencer

Genexus™ Integrated Sequencer reagents and supplies can be ordered as kits and starter packs. In
addition, most consumables can also be ordered individually. The following tables provide information
about the various ordering options.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers

cannot be ordered individually.

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Genexus™ Integrated Sequencer

Components

Cat. No.

Genexus™ Integrated Sequencer

A45727

Genexus™ Barcodes AS

lon Torrent™ Genexus™ Barcodes AS are supplied in plates containing 32 dual barcodes per plate. The
barcodes can be ordered as a set of three plates (Cat. No. A40257), or ordered individually.

Item Label color Cat. No. Quantity Storage

Genexus™ Barcodes 1-96 AS Blue A40257 3 plates
Genexus™ Barcodes 1-32 AS Blue A40258 1 plate

Genexus ™ Barcodes 1-32AS , |"°

Qty: 32 Barcodes .2 VVVV-I::II\:I’;::::)Ws I-T:T‘”‘z’igk

15°C to 30°C

Genexus™ Barcodes 33-64 AS Blue A40259 1 plate
Genexus™ Barcodes 65-96 AS Blue A40260 1 plate

20
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Genexus™ Templating Strips 3-GX5™ and 4

lon Torrent™ Genexus™ Templating Strips 3-GX5™ and 4 (Cat. No. A40263) are ordered as kits with

8 pairs of strips per kit.

Component Carrier color | Part No. | Quantity per kit Storage
Genexus™ Strip 3-GX5™ Brown A46815 8 strips 2°C to 8°C
Yellow A46816 8 strips -30°C to -10°C

Genexus™ Pipette Tips

lon Torrent™ Genexus™ Pipette Tips (Cat. No. A40266) are ordered in packs of 12 racks each. The
number of pipette tip racks that are required for your experiment depends on the number of reactions
and the sample type. For the Oncomine™ BRCA Assay GX, 4 racks are sufficient for sequencing up to

16 samples on a single GX5™ Chip lane.

Item

Cat. No.

Quantity

Storage

Genexus™ Pipette Tips

A40266

12 racks

15°C to 30°C

Genexus™ Conical Bottles

Genexus™ Conical Bottles (Cat. No. A40275) are installed in the sequencing reagents bay and serve as
reservoirs for nucleotide reagent dilutions. For information on when and how to replace the bottles, see
Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0017910).

Component

Quantity

Storage

Genexus™ Conical Bottles

5 bottles

15°C to 30°C
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GX5™ Chip and Genexus™ Coupler

The GX5™ Chip and Genexus™ Coupler (Cat. No. A40269) are ordered as a set that contains two
chips and two couplers. For the Oncomine™ BRCA Assay GX, 1 chip is sufficient for sequencing up to
64 samples (16 samples per lane).

Component Part No. | Quantity Storage
GX5™ Chip 100081364 | 2 chips |15°C to 30°C
ion torrent 6 xAOXO+%
Genexus™ Coupler 100081252 | 2 couplers

Genexus™ Sequencing Kit

22

The lon Torrent™ Genexus™ Sequencing Kit (Cat. No. A40271) provides reagents and solutions sufficient
to sequence up to 2 full chips.

(4 bottles total)

Component Part No. Quantity Storage
Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C
Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C
Genexus™ Bottles 1 and 3 A40274 2 bottles each
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General laboratory supplies and reagents

General laboratory supplies and reagents

Item Source
MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with Barcode 4483352, 4483354
Thermo Scientific™ Adhesive PCR Plate Foils AB0626
Microcentrifugel'! MLS
2-, 20-, 200-, and 1,000-pL pipettes and appropriate filtered tips MLS
Nuclease-free microcentrifuge tubes, 1.5-mL or 1.7-mL MLS
Vortex mixer with a rubber platform MLS
Gloves, powder-free nitrile MLS
Ice buckets and ice -
Nuclease-free water, molecular biology grade MLS
Isopropyl alcohol, 70% solution MLS
Wipes, disposable lint-free MLS
(Optional) Uninterruptible Power Supply (UPS)! MLS

1 Must fit standard 0.2- and 1.5-mL microcentrifuge tubes and generate 15,000 x g. To convert the RPMs of your centrifuge to RCF in
units of gravity, see tools.thermofisher.com/content/sfs/brochures/TR0040-Centrifuge-speed.pdf.

[ For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you use an uninterruptible
power supply that is compatible with 2500 W output or higher.
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Guidelines for assay handling and preparation
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Use only the reagents and supplies that have been verified for the Oncomine™ BRCA Assay GX.
For a list of verified reagents and supplies, see “Required materials not supplied for use with

the Genexus™ Integrated Sequencer” on page 20 and “Recommended materials for use with the
Oncomine™ BRCA Assay GX” on page 16.

Use good laboratory practices to minimize cross-contamination of products. Keep all tubes sealed
until immediately before loading onto the Genexus™ Integrated Sequencer.

We recommed using controls to identify or rule out reagent contamination. For a list of verified
controls, see “Genexus™ Controls” on page 17.

Minimize freeze-thaw cycles of the BRCA DNA Pool 1 and BRCA DNA Pool 2 tubes. Thaw only the
number of panel tubes that are required for a given experiment and keep the thawed panels at 4°C
until ready to use. Store unused panels at —30°C to -10°C.

Note: One set of panels (BRCA DNA Pool 1 and BRCA DNA Pool 2 tubes) is sufficient for
processing up to 16 samples.

Do NOT store the BRCA DNA Pool 1 and BRCA DNA Pool 2, Genexus™ Strip 1, and Genexus™
Strip 2-AS on the Genexus™ Integrated Sequencer for more than 24 hours before starting an
instrument run.
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Guidelines for preventing contamination

We recommend following these guidelines to prevent cross-contamination of samples and controls
between and within sequencing runs.

Personal protective equipment

* Wear a lab coat that is reserved for sequencing work and is laundered frequently. If possible,
change to a fresh lab coat before setting up a run, or use new sleeve covers.

* Wear fresh gloves to load the instruments, including during the loading of the sequencing chip and
coupler. Do not remove gloves to install the sequencing chip.

* |f you are using positive controls and a no-template control (NTC) in the run, change gloves
between dispensing these controls, and if applicable, between dispensing samples and controls in
sample plate wells.

Equipment and instrument cleaning

* [f you are preparing samples and sample plates in a hood (recommended), illuminate the hood with
UV light for 15 minutes before use.

¢ Before use, wipe working surfaces of the hood or bench where samples or sample plates are
handled, and other equipment such as vortexers, microcentrifuges, and pipettors with lint-free
wipes moistened with DNAZap™ decontamination solutions. Wipe with solution 1 first, then follow
with solution 2. Alternatively, a 10% solution of commercial bleach can be used. Follow with wiping
of bench and equipment surfaces with wipes moistened with 70% isopropanol or 70% ethanol.

* Before and after a run, sequentially wipe instrument deck surfaces with lint-free wipes moistened
with the two DNAZap™ decontamination solutions. Follow with wiping of deck surfaces with wipes
moistened with 70% isopropanol or 70% ethanol. The robotic pipettor arm can also be cleaned in
this manner.

IMPORTANT! Do not spray decontamination solution or alcohol solution directly onto deck
surfaces or into deck openings. Instead, use a lint-free wipe moistened with solution to clean
surfaces. Do not use bleach to clean instrument surfaces.

* We recommend that you centrifuge the sample plate after sealing. Ensure that the centrifuge has
been wiped down and cleaned before centrifuging the plate.
Workflow tips

* After dispensing a positive control or sample (if applicable) in a sample plate well, do not pass
the end of the used tip over wells intended for other samples or NTC. This practice minimizes the
chance of depositing microdroplets in adjacent wells.

* If you dilute samples on the sample plate and vortex the plate after sealing, apply the foil seal
carefully between wells with an applicator before vortexing to ensure that the seal is complete and
contamination between wells does not occur.

* |f possible, have a pipettor and tips reserved for dispensing only NTC.
* Before disposal, close or cap used sample and positive control tubes to avoid creation of aerosols.
* Avoid touching the foil seals of the reagent strips, barcode plate, and sample plate.
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When loading the sequencer deck for a run, install the sample plate last.

After a run, seal the PCR amplification plate with a foil seal before removing the plate from the PCR
amplification station. Sealing the plate before removal helps prevent contamination of libraries if
libraries are recovered for reuse.

Guidelines for panel and reagent use and handling

26

Use only the reagents and supplies that have been recommended in “Recommended materials for
use with the Oncomine™ BRCA Assay GX” on page 16 and “Recommended materials for nucleic
acid isolation, quantification, and quality control” on page 16.

Keep panel tubes capped until immediately before loading in the Genexus™ Integrated Sequencer.

If using, thaw positive controls on ice for 30 minutes. After the positive controls are completely
thawed, vortex the tubes, then centrifuge to collect tube contents. Return to ice before loading into
sample plate.

IMPORTANT! Ensure that contents of the control tubes are completely thawed before adding to
the sample plate.

Equilibrate or thaw the following reagent strips at room temperature for 30 minutes before loading
in the sequencer.

— Genexus™ Strip 1
— Genexus™ Strip 2-AS (or Genexus™ Strip 2-HD)
— Genexus™ Strip 3-GX5™ (or Genexus™ Strip 3-GX7™)

Thaw Genexus™ Strip 4 on ice for 30 minutes before loading in the sequencer.

IMPORTANT! Ensure that the contents of strips that are stored frozen are completely thawed
before loading in the sequencer.

Thawed library and templating strips can be vortexed on a platform vortexer to dissolve precipitate
or dislodge air bubbles. If you vortex, you must centrifuge the strips to collect tube contents using
the Genexus™ Strip Centrifuge Adapter to hold strips during centrifugation.

For information about obtaining and using the Genexus™ Strip Centrifuge Adapter, see “Centrifuge
library and templating reagent strips using the Genexus™ Strip Centrifuge Adapter” on page 96.

Keep the sample plate, thawed panel, Genexus™ Strip 2-AS (or Genexus™ Strip 2-HD), and
Genexus™ Strip 4 on ice or at 4°C until ready to load in the sequencer.

Do not freeze-thaw the panel. Thaw only the number of panel tubes that are required for an
instrument run. Discard unused panel tubes after they are thawed. Store panel tubes at —-30°C to
-10°C.

If you are using an assay that uses lon AmpliSeq™ HD chemistry, do not combine the contents

of panel tubes. Forward and reverse primers must remain separate until they are combined by the
sequencer as part of the on-instrument library preparation workflow.

Do not store primer pool tubes or reagent strips on the sequencer for more than 24 hours before
starting an instrument run.
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Guidelines for Genexus™ Integrated Sequencer operation

* Follow guidance that is provided by Genexus™ Software when you plan a run to determine which
consumables must be loaded and which consumables can be reused from a previous run.

¢ Follow guidance that is provided by the software when you plan a run to determine how many
samples can be run with a given assay or assays in an instrument run. The number of samples that
can be included in a sequencing run depends on multiple factors.

Limiting factor Description

The number of available The maximum number of available barcodes per run is 32.

barcodes in the barcode plate | |IMPORTANT! When libraries are prepared on the Genexus™
Integrated Sequencer, each target amplification reaction for a
sample requires a unique barcode.

Maximum number of target One library strip pair has the reagents necessary for 4 target
amplification reactions per run | amplification reactions, or 4 barcodes. With a maximum of 8 library
strip pairs loaded, a maximum of 16 samples can be run using the
Oncomine™ BRCA Assay GX, which contains 2 primer pools.

The number of primer pools per | Given the limits of 32 target amplification reactions, and 32 available
assay barcodes, the number of samples in a run multiplied by the total
number of primer pools in the assays that are used in a run cannot
exceed 32.

The number of unused lanes on | A maximum of 4 lanes are available on a single GX5™ Chip.
an installed chip

The minimum read count per The minimum read count per sample parameter is set during assay
sample for an assay creation.

® One library strip pair is needed for each primer tube position 1-8 that is filled in a run.
* One template strip pair is needed for each chip lane that is used in a run.

* Consumables are configured to support sample batch sizes in multiples of four samples. The most
efficient use of consumables occurs when samples are run in multiples of four.

® Each GX5™ Chip can accommodate up to 16 samples per lane, or 15 samples and 1 no-template
control.

¢ |f a chip installed in a sequencer has unused lanes, do not remove it unless you are sure that
you want to replace it with a new chip. After a partially used chip has been removed from the
sequencer, it cannot be reinserted and reused. The sequencer cannot track lane usage after chip
removal.

* You can remove a chip in one of the following situations.
— After all the lanes of a chip are used in a run, the chip shuttles to the install position and you
are asked to remove the used chip.

— When you select a run plan that requires more lanes than are available on the installed chip,
you are asked to remove the partially used chip, and the sequencer performs a post-chip
clean. In addition, you must clear consumables from the lower sequencing reagents bay, even
if only a single lane of the chip was used.

Oncomine™ BRCA Assay GX User Guide 27



[ Q]

Chapter 3 Before you begin
Before each use of the kit

The Genexus™ Integrated Sequencer can track used and unused barcodes in barcode plates in
Genexus™ Software 6.2.0 and later, enabling you to swap plates between runs if needed, and
reload a partially used barcode plate for a run if a sufficient number of barcodes are available on
the plate.

After loading in the sequencer, reusable consumables, such as barcode plate, chips, and
sequencing reagents bay components, must be used within 14 days for optimal results.

Before each use of the kit

28

Thaw assay reagents as indicated:

Thaw BRCA DNA Pool 1 and BRCA DNA Pool 2 on ice or at 4°C for at least 30 minutes and keep
on ice until immediately before loading onto the Genexus™ Integrated Sequencer.

Equilibrate Genexus™ Strip 1 and Genexus™ Strip 3-GX5™ at room temperature for at least
30 minutes before loading onto the Genexus™ Integrated Sequencer.

Thaw Genexus™ Strip 2-AS and Genexus™ Strip 4 on ice or at 4°C for at least 30 minutes and keep
on ice until immediately before loading onto the Genexus™ Integrated Sequencer.

IMPORTANT! Ensure that the strip contents are completely thawed before installing in the sequencer.

When thawed, gently tap tubes and strips on the benchtop to remove any bubbles and collect the
contents at the bottom of each tube. For information about preparing all reagents and consumables for
loading onto the instrument, see Chapter 3, “Before you begin”.

Note: If tapping fails to dislodge a bubble, you can dislodge large bubbles using the technique that is
described in Chapter 3, “Before you begin”.
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Precautions

Avoid nucleic acid contamination

IMPORTANT! A primary source of contamination is spurious nucleic acid fragments from previous
sample processing steps. Do not introduce amplified DNA into the work area where the instrument is
located.

Avoid chip damage

IMPORTANT! To avoid possible damage to the chip due to electrostatic discharge, ground yourself
before picking up a chip or placing a chip on a surface such as a lab bench. For example, touch the
metal trim on the chip compartment before inserting or removing a chip from the chip clamp.

Avoid strong electromagnetic radiation

WARNING! Do not use the instrument in close proximity to sources of strong electromagnetic
radiation (for example, unshielded intentional RF sources), as these sources can interfere with proper
operation.

Protection by equipment

A WARNING! The protection that is provided by the equipment can be impaired if the instrument is
operated outside the environment and use specifications, the user provides inadequate maintenance,
or the equipment is used in a manner that is not specified by the manufacturer (Thermo Fisher
Scientific).
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Runs plans that are created in Genexus™ Software contain the settings that are used in sample
purification, library preparation, templating, sequencing, and analysis, including sample information and
plate location, assays, and barcodes. Run plans are used to track samples, consumables, and chips
throughout purification, library preparation, templating, sequencing, and data analysis.

For more information about run planning, see the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409) or the software help system.
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Types of Oncomine™ BRCA Assay GX runs

The type of run that you plan depends on your instrument configuration, assay, and sample type.

Genexus™ Software guides you step-by-step through the process to set up a run. The software prompts
you to select required information and consumables, then provides a printed run setup guide to

help you load consumables on the Genexus™ Integrated Sequencer and the Genexus™ Purification
Instrument, if applicable.

Table 2 Types of runs for use with the Oncomine™ BRCA Assay GX

Run type Description
Sample to An integrated run for sequential and automated nucleic acid purification, quantification,
Result and sequencing. This run type requires the Genexus™ Purification Instrument to be

connected to the sequencer.

Nucleic Acid to | A sequencing run that starts with purified nucleic acid samples of known concentration
Result as input. Purified nucleic acids can be isolated and quantified using the Genexus™
Purification Instrument in stand-alone configuration. Alternatively, you can use other
manual purification and quantification kits to isolate purified nucleic acid samples. For
a list of recommended kits, see “Recommended materials for nucleic acid isolation,
quantification, and quality control” on page 16.

For more information about planning other types of runs, see the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409) or the software help system.

System-installed assays for use with the Oncomine™ BRCA
Assay GX

The following system-installed assays are available in the Genexus™ Software 6.8 for use with the
Oncomine™ BRCA Assay GX. Each system-installed assay is configured with settings that are optimized
for a specific sample type.

Assay name Sample type

Oncomine™ BRCA - GX5 Germline - DNA - w4.1.1 (Whole blood DNA only) DNA

Oncomine™ BRCA - GX5 Somatic - DNA - w.4.1.1 (FFPE DNA only)

Note: Make sure to update your software to the latest available versions of the system-installed
assays. For more information, contact your field service representative. For information on how to
perform software and assay package updates, see the software help system.

You can use the system-installed assays in your run plan without change. To modify any assay settings,
copy the system-installed assay that best represents your sequencing experiment and sample type,
then edit assay settings as needed.

For more information about assays, see the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409) or the software help system.
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Enter samples in the Genexus™ Software

Genexus | lon Torrent Dashboard Samples Runs Results Assays

Filtier Saenplers Iry... = Selected Samples-0

Sampie Name T Tags T CreatedOn  + T Appt T Samgple Type T

In Genexus™ Software, the data and attributes that characterize a purified nucleic acid—or a specimen
that requires nucleic acid purification and quantitation—to be sequenced are called samples.

Before you plan a run in the Genexus™ Software, you must first enter sample information in the software
to assign sample names and provide other information.

From the Samples menu, you can add samples in multiple ways. For more information on creating and
managing samples, see the software help system, or the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409).

About integrated run planning

32

The Genexus™ Purification Instrument can be used in either a standalone configuration or an integrated
configuration to purify nucleic acids from up to 12 samples in a single run. The standalone configuration
yields an archive plate with purified and quantified nucleic acid samples that can be used in multiple
downstream applications. The integrated configuration yields a 96-well output plate, in addition to the
archive plate, that can be used directly in a Genexus™ Integrated Sequencer Sample to Result run.

Note: If using the Genexus™ Purification Instrument in standalone configuration, proceed to the
appropriate purification chapter and follow the guidance for on instrument run planning.

When using the Genexus™ Purification Instrument in integrated configuration, plan a Sample to Result
(“Plan a Sample to Result run” on page 33) or Nucleic Acid to Result (“Plan a Nucleic Acid to

Result run” on page 35) sequencing run in the Genexus™ Software. A Sample to Result run integrates
automated nucleic acid purification and sequencing.

* Sample to Result—start from unprocessed samples and isolate nucleic acid on the Genexus™
Purification Instrument, then load the purified and quantified nucleic acid samples directly into the
Genexus™ Integrated Sequencer for library preparation, templating, and sequencing.

* Nucleic Acid to Result—pipet purified and quantified nucleic acid samples into a 96-well sample
input plate and load into the Genexus™ Integrated Sequencer for library preparation, templating,
and sequencing.

Note: The Genexus™ Purification Instrument is not required for Nucleic Acid to Result sequencing
runs.

When you plan a Sample to Result run, nucleic acid isolation is performed in a separate batch for
each sample type (for example, FFPE samples and whole blood). The Genexus™ Purification Instrument
can run one nucleic acid isolation batch at a time. You can run different nucleic acid isolation batches
simultaneously on multiple purification instruments or sequentially on a single instrument.
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Plan a Sample to Result run

Genexus | lan Torrent Dashboard  Samples

This procedure applies only if a Genexus™ Purification Instrument is used with the Genexus™ Integrated
Sequencer.

Ensure that the following prerequisites are complete before you plan a Sample to Result run.
* Integrate a Genexus™ Purification Instrument with the system.
* Enter sample information into Genexus™ Software. For more information, see the software help
system, or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

Planning a Sample to Result run is organized into five steps: Setup, Assays, Samples, Purification,
and Review. Progress through the steps is tracked in the upper left corner of the Runs / Sample to
Result screen.

1. In the menu bar, click Runs » Sample to Result.

Note: You can also click + Sample to Result in the Runs / Manage Runs screen.

2. In the Setup step, enter or make the following selections.
a. In the Plan section, enter a unique run name.
The name is limited to 50 characters and no spaces are allowed.

b. In the Reporting (Optional) section, enable Generate Report to generate a variant report that
uses the default report template.

c. Click Next.

3. In the Assays step, select the Oncomine™ BRCA - GX5 Germline - DNA - w.4.1.1, the Oncomine™
BRCA - GX5 Somatic - DNA - w.4.1.1 assay, or both to include in the run.

If a chip is installed in the sequencer, the Chip View graphic in the lower left corner indicates the
lanes that are available for sequencing.

a. In the Research Application column for the assay of interest, select research application
DNA to include the assay in the run plan.

b. If more than one assay is included in the run, repeat substep 3a for each additional assay.

c. Click Next.
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4. Inthe Samples step, select the samples that you want to run with each assay.

a.

e.

Select the checkbox next to each sample that you want to assign to an assay, then in the
Selected Assays pane, for the assay that you want to use for the selected samples, click
Assign.

The Chip View updates to show the lanes used in the run. Lane usage is calculated based
on the number of samples (including a no template control, if selected) and the minimum read
counts per sample for the assay. Green denotes a chip lane in the run containing assigned
samples within lane capacity. The maximum number of samples per lane is 16 and cannot be
exceeded because the maximum number of barcodes per plate is 32.

Green lane color denotes lane usage and sample assignment within lane capacity.

3 BRCA Somatic 1
et wa.L11

If desired, select NTC to include a no template control and select Control Sample to include
a positive control.
The Chip View updates to show the lanes used in the run for the included controls.

Note: The total number of samples that can be run per lane is 16, including any NTC and/or
Control Sample added to the run plan.

If you selected more than one assay, repeat substep 4a and substep 4b for each assay in the
run plan.

If needed, edit samples using one of the following options.
* (Click View & Remove, make the selections, then click Update.
¢ Click Remove All, to remove all sample assignments for all assays.

Click Next.

5. In the Purification step, review and edit selections.

a.

34

Review and edit purification selections.

Option Description
Protocol Select a protocol from the dropdown list.
Selection

Elution Vol. (uL) | Modify the elution volume within the allowable range, if needed.

Review? * |f selected, the system waits for manual concentration review if the
sample concentration is out of range.

* [f deselected, samples with concentration that is out of range are
automatically excluded from sequencing.

Note: Regardless of the setting, this selection overrides the Review? setting
of the assay.
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b. Review and edit the information for control samples, if applicable.

Option Description

Conc. (ng/pL) Review and edit the concentration of control samples, if needed.

Kit Barcodes Enter the extraction kit barcode for each control sample, if needed.

c. Click Next.

6. In the Review step, review the run plan summary, then click Save & Print to print the run setup
guide, if desired. Click Save to save the run without printing.

The run plan appears in the Manage Runs screen with the name that you specified.

Note: A run can include multiple purification batches. For more information, see the software help
system, or the the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

The run plan summary lists the following details:

¢ the consumables that are required for * the consumables that are required for
purification sequencing
* how much volume to load ¢ details about the assay or assays.

* where to load samples

Tip: Click Sequencing to expand the sequencing section of the run plan summary.

IMPORTANT! The consumables required for sequencing can change. After purification, review
the run plan in the Runs / Manage Runs screen for updated sequencing consumable information.
For more information, see the software help system, or the the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409).

Proceed to the appropriate purification kit chapter to prepare and purify samples.

Plan a Nucleic Acid to Result run

You can plan a run for sequencing that starts with nucleic acid samples. In Genexus™ Software 6.8 and
later, a run that starts with nucleic acid samples is called a Nucleic Acid to Result run.

When performing a Nucleic Acid to Result run, start from purified nucleic acid samples that are loaded
in the Genexus™ Integrated Sequencer for library preparation, templating, and sequencing

IMPORTANT! The Genexus™ Purification Instrument is not required for Nucleic Acid to Result
sequencing runs.

1. In the menu bar, click Runs » Nucleic Acid to Result.

Note: Alternatively, you can click 4+ Nucleic Acid to Result in the Runs / Manage Runs screen.
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2. In the Setup step, enter or make the following selections.
a. In the Plan section, enter a unique name.
The name is limited to 50 characters and no spaces are allowed.

b. (Optional) In the Reporting (Optional) section, ensure that Generate Report is enabled to
generate a variant report using the default report template.

c. Click Next.

3. In the Assays step, select the Oncomine™ BRCA - GX5 Germline - DNA - w.4.1.1, the Oncomine™
BRCA - GX5 Somatic - DNA - w.4.1.1 assay, or both to include in the run.

a. In the Research Application column for the assay of interest, select the research application
DNA to include each assay in the run plan.

After selecting an assay and the research application for the assay, the list is filtered to show
compatible assays that can be selected and run at the same time.

b. If more than one assay is included in the run, repeat substep 3a for each extra assay.
c. Click Next.

4. Inthe Samples step, select the samples that you want to run with each assay.

a. Select the checkbox next to each sample that you want to sequence, then in the Selected
Assays pane, for the assay that you want to use for the selected samples, click Assign.

b. If you selected more than one assay, repeat substep 4a for each assay in the run plan.

c. If needed, edit samples in one of the following ways.
* (Click View & Remove, make the selections, then click Update.
¢ Click Remove All, to remove all sample assignments for all assays.

d. Click Next.

5. In the Sample Plate step, review position assignments in the sample plate. Drag-and-drop
samples and no template controls to edit the location of samples and controls, if applicable.

a. If desired, enter the extraction kit barcode for one or more samples or controls. For a single
sample, in the row of the sample of interest, in the Kit Barcodes column, enter the extraction
kit barcode or control kit barcode, if applicable. For multiple samples or controls, select the
samples and controls, then click [ Assign Kit Barcodes. In the Assign Kit Barcodes dialog
box, enter the extraction kit barcode for the samples, and if applicable, enter the barcode for
the no template control.

b. Modify the concentration of samples, if needed. For a single sample, in the row of the sample
of interest, in the Conc. (ng/ul) column, edit the concentration.
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c. Ensure that sample plate information is correct, then click Next.

6. In the Review step, review the run plan summary, then click Save & Print to print the run setup
guide, if desired. Click Save to save the run without printing.
After saving, the run appears in the Manage Runs screen in the run list with the name you
specified.

Before sequencing, the DNA samples must be transfered to a 96-well sample input plate.

* |f starting from FFPE samples, see “Dilute the samples and load the sample input plate—Nucleic
Acid to Result run” on page 64.

* |f starting from blood, see “Dilute the samples and load the sample input plate—Nucleic Acid to
Result run” on page 91.

Lane usage by sample type

The capacity of the GX5™ Chip varies depending on the sample type. Chip capacity information
provided in Table 3 applies to assays that use system-installed settings only. For Oncomine™ BRCA
Assay GX, each run uses one lane on the GX5™ Chip, which accommodates 16 samples or 15
samples with NTC. If needed, you can modify the number of samples that can be loaded onto a

chip lane by copying a system-installed assay and adjusting the Minimum Read Count Per Sample
parameter. For more information, see the software help system, or Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409), and “Guidelines for Oncomine™ BRCA Assay GX settings” on page 154.

IMPORTANT! Modifications to system-installed assay settings have not been validated. We
recommend using system-installed assay settings. Consult your local Field Service Engineer before
modifying default assay settings.

Table 3 Lane usage by sample type (system-installed Oncomine™ BRCA Assay GX settings only)

Sample typell Number of available lanes!?] Capacity
FFPE DNA 1 16 samples or
or 15 samples with NTC
Blood DNA

[ Only one sample type per lane.
] A maximum of 1 lane can be used in a single run.
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B Unload purified samples . ... e 60

Note: The procedures described in this chapter only apply to purification of DNA from FFPE samples
on the Genexus™ Purification Instrument using the lon Torrent™ Genexus™ FFPE DNA and RNA
Purification Kit. For information on purification of DNA from other sample types using the Genexus™
Purification Instrument, see Chapter 6, “Genexus™ Multisample DNA Purification Kit protocol”.
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Y A

Genexus™ FFPE DNA Purification workflow

3 hr

Plan a purification run (page 40)

IMPORTANT! If performing a Sample to Result sequencing run, plan the run
in the Genexus™ Software. For more information see “Plan a Sample to Result
run” on page 33.

To purify samples for use in Nucleic Acid to Result runs or other
non-sequencing applications, run the Genexus™ Purification Instrument in
standalone configuration. Create a new purification run plan or copy/edit an
existing purification run plan that best represents your experiment, then edit the
settings as needed. Purification run plans contain instrument settings that are
used in sample purification.

Prepare samples from FFPE curls (page 45)
OR

Prepare samples from FFPE slides (page 47)

Samples are deparaffinized and digested with protease in preparation for
isolation of DNA.

Load the Genexus™ Purification Instrument (page 49)

The purification run plan is selected and the run initiated. The instrument
performs a prerun UV clean, then reagents and consumables are loaded on
to the instrument.

Start the run (page 59)

After the sample plate and all reagents and consumables have been loaded the
instrument door is closed and the run started.

D ¢ &

Note: Sample quantification adds ~2 hours to the run time.

Oncomine™ BRCA Assay GX User Guide

39



S Chapter 5 Genexus™ FFPE DNA and RNA Purification Kit protocol
Plan a purification run (standalone configuration)

Genexus™ FFPE DNA Purification workflow

Unload the purified nucleic acids (page 60)

If performing a Sample to Result run, remove the 96-Well Nucleic Acid Output
Plate, add any required control samples and proceed to sequencing of the
purified samples. Remove and seal the 48-Well Nucleic Acid Archive Plate,
then store as directed.

If performing a Nucleic Acid to Result run or purifying nucleic acids in
standalone configuration for use in other downstream applications, remove and
seal the 48-Well Nucleic Acid Archive Plate, then store as directed or proceed
to sequencing of the purified sample.

Used reagents and consumables are removed from the instrument and a UV
clean is performed.

Note: The Quantitation Plate requires equilibration to room temperature for at least 30 minutes before
use. To save time experienced users can take the Quantitation Plate out of 4°C storage before creating
a purification run plan and preparing samples.

Plan a purification run (standalone configuration)

Note: If running the Genexus™ Purification System in integrated configuration, see “Plan a Sample to
Result run” on page 33 to plan a Sample to Result run in the Genexus™ Software.

In standalone configuration, plan a purification-only run through the instrument touchscreen. After
purification is complete, all purified samples are transferred to an archive plate for storage.
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Add a purification run plan (standalone configuration)

Note: We recommend that you plan the run before preparing your samples and loading into the
FFPE DNA and RNA Purification Plate 1. However, experienced users can save time by creating the
purification run plan during the protease digestion step of sample preparation.

1. Enter your username and password to sign in to the instrument.

2. Tap Run, then tap Add plan.

VPS-BETA-0014 el Select Run Plan

a6 PS-BETA- Standalone Config

ct purification run plan

Purification run plans Date created

20-11-03

3. Tap in the entry box, enter a unique name for the run plan, then tap Done » Next.

4. Select the lon Torrent™ Genexus™ FFPE DNA and RNA Purification Kit, then tap Next.
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5. Select the FFPE_DNA_v1 purification protocol, then tap Next.

Note: The FFPE_DNA_RNA_v1 and FFPE_RNA _v1 purification protocols are not currently
supported with the Oncomine™ BRCA Assay GX.

6. Enable or disable Quantitation after Purification.

Run Options

Note:

. The Quantitation Plate is required even if Quantitation after Purification is disabled.

. Disabling Quantitation after Purification may reduce the purification run time by up to
2.5 hours.

. Quantitation requires up to 5 pL of the eluted sample. If the expected sample yield is limiting,
manual sample quantitation may be preferred to preserve sample.

7. Accept the default elution volume. If needed, select the desired elution volume from the dropdown
list, then tap Next.

8. (Optional) Change the number of samples and the sample details.

a. In the Manage Samples screen, deselect extra samples (for example, if you are only running
ten samples, deselect samples 11 and 12).

b. Tap on a sample ID to select the sample.
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c. Tap Edit, enter a new Sample ID and any Notes, then tap Save.
d. Repeat substep 8b and substep 8c for each additional sample.

e. Click Next.

Manage Samples

9. Review the Purification Run Plan Details. Tap Edit to change any of your selections, otherwise
tap Next.

Purification Run Plan Details

The new purification run plan appears in the list of available Purification Run Plans.

To delete an existing run plan, see the Genexus™ Purification System User Guide (Pub. No.
MANO0018475).
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Prepare samples

Procedural guidelines

* Perform all steps at room temperature (20°C-25°C) unless otherwise noted.

* When mixing samples by pipetting up and down, avoid creating bubbles.

* Wear clean gloves and a clean lab coat.

* (Change gloves whenever you suspect that they are contaminated.

* Open and close all sample tubes carefully. Avoid splashing or generating aerosols of the samples.

* Volumes for reagent mixes are given per sample. We recommend that you prepare master mixes
for larger sample numbers. To calculate volumes for master mixes, refer to the per-well volume and
add 5-10% overage.

* Incubation at 60°C can be extended 1 hour (2 hr total time) to increase DNA yields followed by the
90°C incubation for 1 hour.

* We recommend using a plate centrifuge that holds the AutoLys M Tube Rack in "landscape"
orientation.

@ Landscape orientation—recommended

Note: Place AutolLys M Tube Rack in the centrifuge with the arrow on the cover pointing outward as
shown.

@ Portrait orientation—not recommended

* The plate chiller shuts off 60 minutes after run completion. Remove the 96-Well Nucleic Acid
Output Plate and 48-Well Nucleic Acid Archive Plate with purified nucleic acids from the instrument
within 1 hour of run completion. Proceed immediately to sequencing or properly store the nucleic
acids until use.

* The Quantitation Plate requires equilibration to room temperature for at least 30 minutes before
use.

Before each use of the kit

* We recommend the use of incubators when using AutoLys M Tubes.
* Preheat incubators to 60°C and 90°C.
* Prepare Protease Digestion and DNase Digestion solutions immediately before use.

* (Centrifuge purification plates for 30 seconds at 1,000 x g to collect the contents.

Materials required

* Genexus™ FFPE DNA and RNA Purification (Part. No. A45532)
— FFPE DNA and RNA Purification Plate 1

— Proteinase K (red cap)
— FFPE Protease Buffer
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AutoLys M TubelLifter or Pliers
AutoLys M Tubes and Caps
AutoLys M Tube Rack

Plate centrifuge

Incubators (see “Recommended materials for nucleic acid isolation, quantification, and quality
control” on page 16 for a list of recommended incubators)

Prepare 1X Protease Digestion Master Mix

Prepare the 1X Protease Digestion Master Mix immediately before use.

1.

3.

Invert the FFPE Protease Buffer and Proteinase K tubes supplied in the kit 5X each, then briefly
centrifuge.

In a 1.5-mL low-retention microcentrifuge tube, prepare a 1X Protease Digestion Master Mix as
indicated, where n is the number of tissue samples.

Component Volume per reaction
FFPE Protease Buffer (n+ 1) x 225 pL
Proteinase K (red cap) (n+1)x10pL
Total volume (n+ 1) x 235 pL

Vortex for ~5 seconds to mix, then briefly centrifuge to collect the contents.

Prepare FFPE curl samples with AutoLys M Tubes

Note: We recommend the use of AutoLys M Tubes for the preparation of FFPE samples. Alternatively,
CitriSolv™ Clearing Agent, xylene or equivalent solution can be used for removal of paraffin from the
FFPE samples. For more information, see the Genexus™ Purification System User Guide (Pub. No.
MANO0O018475).

Digest with Protease in AutoLys M Tubes

Note: To minimize the amount of time between protease digestion and starting the purification run on
the instrument we recommend that you prepare the reagents and consumables that are required by the
instrument during the 90°C incubation (step 6).

1.

2.

Label an AutolLys M tube for each FFPE tissue sample.
Add each FFPE section curl to a separate labeled tube.

Place AutoLys M tubes in an AutoLys M Tube Rack, then centrifuge at 2000 x g for 1 minute to
collapse the curl prior to the addition of buffer.

Pipet 235 pL 1X Protease Digestion Master Mix into each labeled tube.

Note: Ensure the samples are submerged in the Protease Digestion Master Mix.
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5. Cap each tube securely to limit evaporation, then incubate at 60°C for =60 minutes in an AutoLys

10.

46

M Tube Rack.

Note: Incubation at 60°C can be extended to 2 hours to increase DNA vyields.

Incubate at 90°C for 60 minutes.

Note:

. If using a single incubator, keep sample in the incubator while the temperature increases. Start
timing when the temperature reaches 90°C.

. Set up the FFPE DNA and RNA Purification Plate 1 during the incubation.

. Prepare the reagents and consumables that are required by the instrument during the
incubation. See “Prepare the consumables” on page 50.

. Equilibrate the Quantitation Plate to room temperature during the incubation.

Allow samples to cool to room temperature for 3-5 minutes before proceeding to lift the tubes.

Lift the tubes. The following steps describe use of the AN
AutoLys M TubelLifter to process up to 24 samples
simultaneously. For more information on use of the
AutoLys M TubeLifter see the AutoLys M TubeLifter
User Guide (Pub. No. MANOQO17676). Alternatively,
AutoLys M Tube Pliers can be used to process tubes
individually.
a. Ensure the AutolLys M TubelLifter lever is in
Position A (straight up) and the slider is in
Position 1.

b. Slide the 24-well AutoLys M Tube Rack containing
the lysed samples into the AutoLys M TubelLifter.

C. Press the lever down from Position A to
Position B, then remove the rack from the lifter. @ Position A
®@ Position B

. . . ® Position C
Slide the AutoLys M Tube Locking Lid onto the rack,

then centrifuge the samples at 2000 x g for 10 minutes.

Note: Ensure the embossed arrow of the AutoLys M Tube Locking Lid points away from the center
of rotation (landscape orientation) when placed in the centrifuge (see page 44).

Separate filter from the outer tube.
a. Adjust the position of the AutoLys M TubeLifter slider to position 2.

b. Remove the AutoLys M Tube Locking Lid, then slide the rack into the AutoLys M TubelLifter.
c. Press the lever down from Position B to Position C.

Keep the samples on ice.
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Proceed to “Add samples to FFPE DNA and RNA Purification Plate 1” on page 51.

STOPPING POINT If needed, samples can be stored over night at —20°C.

Prepare FFPE slide samples with AutoLys M Tubes

Note: We recommend the use of AutoLys M Tubes for the preparation of FFPE samples. Alternatively,
CitriSolv™ Clearing Agent, xylene or equivalent solution can be used for removal of paraffin from

the FFPE samples. For more information, see Genexus™ Purification System User Guide (Pub. No.
MANO0O018475).

Collect the tissue

1. Label an AutoLys M Tube for each FFPE tissue sample.

Label each tube (cap and side) with its Sample ID using a marker that is resistant to xylene and
ethanol.

2. Pipet 235 pL 1X Protease Digestion Master Mix into each labeled tube.

3. Pipet 2-4 pL of 1X Protease Digestion Master Mix from the labeled tube evenly across the fixed
tissue section on the slide to pre-wet the tissue section.

Larger sections may need an additional 2—4 pL of 1X Protease Digestion Master Mix.

4. Use a sterile disposable scalpel or clean razor blade to scrape the tissue in a single direction, then
collect the tissue into a cohesive mass on the tip of the scalpel blade.

5. Carefully insert the scalpel blade with the tissue mass
into the 1X Protease Digestion Master Mix in the
AutoLys M Tube. Rinse the tissue from the blade
into the buffer, then ensure that the entire mass is in
solution.

6. Remove and inspect the blade to ensure that no tissue
remains on it.

7. Inspect the slide to ensure that all the tissue is
removed (the slide should be translucent). Discard the
scalpel in a waste container for sharp objects.

8. Gently flick the tube to mix and to immerse the tissue.

If the tissue adheres to the sides of the tube, use a pipette tip to push the tissue into the solution or
centrifuge briefly to immerse the tissue in the solution.
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Prepare samples

Digest with protease

To minimize the amount of time between protease digestion and starting the purification run on the
instrument, prepare the reagents and consumables that are needed by the instrument during the 90°C
incubation (step 2).

1. Incubate at 60°C for =60 minutes in an AutoLys M Tube Rack.
Incubation at 60°C can be extended to 2 hours to increase DNA yields.

2. Incubate at 90°C for 60 minutes.
* |f using a single incubator, keep the sample in the incubator while the temperature increases.
Start timing when the temperature reaches 90°C.
* Set up the FFPE DNA and RNA Purification Plate 1 during the incubation.
* Prepare the reagents and consumables that are needed by the instrument during the
incubation. See “Prepare the consumables” on page 50.

* Equilibrate the Quantitation Plate to room temperature during the incubation.
3. Allow samples to cool to room temperature for 5 minutes before proceeding to lift the tubes.

4. Lift the tubes. The following steps describe use of the
AutolLys M TubelLifter to process up to 24 samples
simultaneously. Alternatively, AutoLys M Tube Pliers
can be used to process tubes individually.

a. Ensure that the AutoLys M TubelLifter lever is

in Position A (straight up) and the slider is in
Position 1.

b. Slide the 24-well AutoLys M Tube Rack that
contains the lysed samples into the AutoLys M
TubelLifter.

c. Press the lever down from Position A to
Position B, then remove the rack from the lifter.

For more information about use of the AutoLys M @ Position A
Tubelifter, see the AutoLys M TubelLifter User Guide ® Pposition B
(Pub. No. MANOO17676). ® Position C

5. Slide the AutoLys M Tube Locking Lid onto the rack, then centrifuge the samples at 2,000 x g for
10 minutes.

IMPORTANT! Ensure that the embossed arrow of the AutoLys M Tube Locking Lid points away
from the center of rotation (landscape orientation) when placed in the centrifuge (see “Procedural
guidelines” on page 44).

6. Separate the filter from the outer tube.
a. Adjust the position of the AutoLys M TubeLifter slider to position 2.
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b. Remove the AutoLys M Tube Locking Lid, then slide the rack into the AutoLys M TubelLifter.
c. Press the lever down from Position B to Position C.
Keep the samples on ice or at 4°C.

Proceed to “Add samples to FFPE DNA and RNA Purification Plate 1” on page 51.

STOPPING POINT If needed, samples can be stored overnight at 4°C or frozen at -30°C to —10°C.

Load the Genexus™ Purification Instrument and start the
run

This section describes how to perform the following procedures.
* Set up the instrument for use by loading all of the required reagents and consumables.
e Start a Genexus™ Purification Instrument run.

Note: Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.

Materials required

* Genexus™ FFPE DNA and RNA Purification (Part. No. A45532)
— FFPE DNA and RNA Purification Plate 1

— FFPE DNA and RNA Purification Plate 2
— DNase (yellow cap)
— DNase Buffer (blue cap)
- 12-Well Tip Comb
* Genexus™ Nucleic Acid Quantitation (Part. No. A45538)
— Quantitation Plate
— Quantitation Tube
* Genexus™ Purification Supplies 2 (Part. No. A45574)
— 2 Purification Tip Cartridges
— 48-Well Nucleic Acid Archive Plate
— 48-Well Nucleic Acid Archive Plate Seal
* 96-Well Nucleic Acid Output Plate
* P200 pipette and filtered tips
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Prepare the consumables

50

Note: Consumables can be prepared during the protease digestion 90°C incubation step to save time.

Remove all cartridges and consumables from their packaging, then place them on the bench at room
temperature. Prepare the following cartridges and consumables.

e Genexus™ Purification Supplies 2

— 2 Purification Tip Cartridges

— 48-Well Nucleic Acid Archive Plate

— 48-Well Nucleic Acid Archive Plate Seal
e 12-Well Tip Comb

Equilibrate the Quantitation Plate

IMPORTANT! Allow at least 30 minutes for the Quantitation Plate to equilibrate to room temperature.

The Quantitation Plate is required even if your run plan does not include sample quantitation.

The Quantitation Plate can be equilibrated to room temperature during the protease digestion to save
time.

Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.

Add 1X DNase Digestion Master Mix to the FFPE DNA and RNA Purification Plate 2

Note: Addition of DNase is not required if purifying only DNA (purification protocol FFPE DNA is
selected for the run). Proceed directly to “Add samples to FFPE DNA and RNA Purification Plate 1” on
page 51.

The FFPE DNA and RNA Purification Plate 2 contains magnetic beads in row H.

1. Vortex the DNase Buffer and DNase supplied in the kit for ~5 seconds each, then briefly centrifuge
to collect the contents.

2. In a 1.5-mL low-retention microcentrifuge tube, prepare a 1X DNase Digestion Master Mix as
indicated, where n is the number of tissue samples.

Component Volume per reaction
DNase Buffer (n+1) x99 pL
DNase (n+1)x1.0pL
Total volume (n+1)x100 pL

3. Vortex for ~5 seconds to mix, then briefly centrifuge to collect the contents.

4. Centrifuge the FFPE DNA and RNA Purification Plate 2 at 1,000 x g for 30 seconds to collect the
contents.
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5. Carefully remove the plate seal without disturbing the
contents.

6. Pipet 100 puL 1X DNase Digestion Master Mix into each
well that is used in Row A of the FFPE DNA and RNA
Purification Plate 2.

Add samples to FFPE DNA and RNA Purification Plate 1
The FFPE DNA and RNA Purification Plate 1 contains magnetic beads in row B.

1. Centrifuge the plate at 1,000 x g for 30 seconds to collect the contents.

IMPORTANT! Do not create bubbles when preparing the plate.

2. Inspect the plate to ensure that the contents of all rows are at the bottom of the wells.

3. Carefully remove the plate seal without disturbing the
contents.

4. Transfer 200 pL of each sample to an individual well in
row A of the prefilled FFPE DNA and RNA Purification
Plate 1.

Add samples to consecutive wells starting with sample 1 in well A1, through sample 12 in well A12
as defined in the run plan. Do not skip wells.

A precipitate can form, but this does not interfere with the DNA binding. Proceed directly to the
next step.

Reagent consumables cannot be reused.

You can add the samples to the FFPE DNA and RNA Purification Plate 1 and load the plate in the
Genexus™ Purification Instrument as the final steps of loading the instrument. This can be done to
help ensure that other components are successfully loaded and accepted by the instrument before
adding samples of possibly limited supply to the purification plate.
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Start the purification run

1. In the instrument touchscreen, tap Run, then tap to select the run plan that you created for this
run.

Standalone Config

ANA_sxample

2. Ensure that the run plan selected is correct, then tap Next.

3. (Optional, standalone configuration) Import sample information.

The import overwrites the existing Sample ID and Notes information for each sample. That is, if
the run plan has 6 samples, the sample import file must include information for at least 6 samples.

To import sample information, prepare a CSV sample import file and save it to a USB drive. See
“Create a template for importing samples in standalone configuration purification run plans” on
page 156.

a. In the Sample Assignment screen, tap Manage Samples.
b. In the Manage Samples screen, tap Import.
c. In the Sample Import screen, tap Import to proceed.

d. Insert the USB drive that contains the sample import CSV file into the USB port on the front of
the purification instrument. In the Sample Import screen, select the USB drive, then navigate
to and select the sample import file.

e. (Optional) Tap Details to view the CSV file that lists the sample names to be imported.

f. Tap Import, then in the Import Successful screen, tap OK.
The imported sample information is shown in the Manage Samples screen. If needed, select
a sample, then tap Edit to modify the Sample ID or Notes.

4. Tap Next.
The instrument performs a 2-minute UV cleaning, then unlocks the door.
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5. Lift the instrument door to the stop.

(1) Hold here, then lift.

Load the Genexus™ Purification Instrument

IMPORTANT!

. Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.

. Ensure that all components are clean and dry before loading them onto the instrument.

. Ensure that the reagent and quantitation station compartments are free of condensate before loading
components. If needed, use a lint-free wipe to dry the compartment.

Follow the on-screen prompts to load the instrument.

Load Deck
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Load FFPE DNA and RNA Purification Plate 1 & 2

1. Load the FFPE DNA and RNA Purification Plate 1 (DNA plate) prepared in step 4 of “Add samples
to FFPE DNA and RNA Purification Plate 1” on page 51.

2. Load the FFPE DNA and RNA Purification Plate 2 (RNA plate) prepared in step 6 of “Add 1X DNase
Digestion Master Mix to the FFPE DNA and RNA Purification Plate 2” on page 50.

@ FFPE DNA and RNA Purification Plate 1
position

@ FFPE DNA and RNA Purification Plate 2
position

Load the 12-Well Tip Comb, Purification Tip Cartridges, 96-Well Nucleic Acid Output
Plate, and 48-Well Nucleic Acid Archive Plate
1. Unwrap, then load a new 12-Well Tip Comb.

Ensure that the 12-Well Tip Comb is straight and that the tabs are not bent or broken. If needed,
gently bend the tip comb in the opposite direction to the curvature to straighten the tip comb
before installing it.

() 12-Well Tip Comb position
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2. Unwrap, then load a new 48-Well Nucleic Acid Archive Plate.

@ 48-Well Nucleic Acid Archive Plate
position

3. (Integrated configuration) Load a new 96-Well Nucleic Acid Output Plate into the output plate
position.
The 96-Well Nucleic Acid Output Plate is not required when performing the purification in
standalone configuration. The samples are in the 48-Well Nucleic Acid Archive Plate on completion
of the purification run.
After a Sample to Result purification run, the 96-Well Nucleic Acid Output Plate becomes the
sample plate to be loaded in the Genexus™ Integrated Sequencer.

(1) 96-Well Nucleic Acid Output Plate
position
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4. Unwrap two new Purification Tip Cartridges, remove the cover to expose the pipette tips, then load
the cartridges in positions 1 and 2.

@ Purification Tip Cartridges position 1
@ Purification Tip Cartridges position 2

a. Pull the locking mechanism handle forward (callout 1), then place the tip box in the open
position.

b. Push the locking mechanism handle back (callout 2) to lock the tip box in place.

(1) Unlocked (forward) (2 Locked (back)
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Load the quantitation reagents and consumables

Note:
. Protect the Quantitation Plate from light to prevent photobleaching of the preloaded reagents.

. The Quantitation Plate is required even if your run plan does not include sample quantitation.
. The Quantitation Tube is not required if your run plan does not include sample quantitation.

1. Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.
2. Load the Quantitation Plate in position 2.

@ Quantitation Tube position
(2 Quantitation Plate position

a. Pull the locking mechanism handle forward, then place the Quantitation Plate in the open

position.

b. Push the locking mechanism handle back to lock the plate in place.

(@ Unlocked (forward) (@) Locked (back)
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[N

3. (If needed) Slide and hold the quantitation module cover to the left, then insert the Quantitation
Tube. Press down firmly to properly seat the tube, then allow the module cover to close.

WARNING! Do not force the module cover closed. Forcing the module cover closed can
damage the instrument.

@ Open @ Closed

Confirm that consumables are installed correctly

IMPORTANT! To ensure correct and safe instrument operation, confirm that all consumables are
installed correctly on the deck before you start a run. The instrument vision system confirms that
required reagents are in place, no reagents are expired, and foil seals are removed. The vision system
does not verify all aspects of the consumable setup before beginning each run.

1. Confirm the following.

Foil seals are removed from the purification plates. Do not remove foil seal from the
Quantitation Plate.

Each component is at the correct location and in the correct orientation. Press down on all
plates and cartridges to ensure that they are firmly seated in place.

The Tip Combs are in place.

The Quantitation Plate is in the correct location, is in the correct orientation, and is locked in
place.

(If needed) The Quantitation Tube is firmly seated in the quantitation module.

Each Purification Tip Cartridge is in the correct location, in the correct orientation, and locked
in place.

If the vision system detects an error, the location indicator does not turn gray in the touchscreen.

2. If needed, tap Help, then accept each warning message appropriately to proceed.
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Start the run

1. When all reagents and consumables are loaded in the Genexus™ Purification Instrument, tap Next.

2. Close the instrument door by pressing down on both top corners. Ensure that the door is locked
after closing it.

The instrument vision system confirms that all reagents are in place and are not expired.

3. Tap Start.

The time remaining until the purification is complete is displayed and the interior lighting turns
green.

* |f you need to stop the run for any reason, tap Cancel, then tap Yes to confirm the
cancellation. A canceled run cannot be resumed. You must restart a run from the beginning.

* The interior lighting turns off during quantitation, then turns blue when the run is complete.

¢ [f the instrument encounters a problem during the run, it aborts the run and displays the error
on the instrument touchscreen. The interior lighting turns red.

When the run is complete, the interior light turns blue, and the touchscreen displays Run Complete.
Quantitation results are available immediately. See “View and export quantitation results” on page 62.
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Unload purified samples

Note: Do not allow purified nucleic acids to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. In the touchscreen, tap Unload. The door unlocks.

Run

Complete

(D Hold here, then lift.
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3. (Integrated configuration) Remove the 96-Well Nucleic Acid Output Plate, containing the purified
sample DNA, ready for the addition of positive or non template sample sequencing controls
(see “Add controls to the sample plate—Sample to Result run” on page 64). Store on ice.

If quantitation was performed, the sample concentration information is visible in the Genexus™
Software. Alternatively, use a Qubit™ Fluorometer to accurately measure sample concentration
manually if needed. For more information, see “Quantify nucleic acid samples” on page 157.

~@@0O000000000
:@@0O000000000
c@@OO000000000
r@@O 000000000
:@O00000000000
r@O0000000000
c@O0000000000
@O 0000000000

® DNA

Note: If not sequencing immediately, seal the plate with an Adhesive PCR Plate Foil (Thermo
Fisher Scientific Cat. No. AB0626), then store purified samples at —20°C for up to 3 months. For
long-term storage (>3 months), transfer samples to labeled low-retention tubes, then store the DNA
samples at —30°C to -10°C.

4. Remove the 48-Well Nucleic Acid Archive Plate, containing the purified sample DNA.

O00000-
000000~
000000 -
000000 -
OO00OO00 -
OO0000®-
OO000O0® -~
OO00000-

@ DNAisin wells A1-B4.

Note: (Standalone configuration) If using the purified DNA immediately, transfer the sample DNA
to a sample input plate for sequencing. For more information, see “Dilute the samples and load
the sample input plate—Nucleic Acid to Result run” on page 64. To determine the sample
concentrations, see “View and export quantitation results” on page 62.

5. Seal the plate with a 48-Well Nucleic Acid Archive Plate Seal.

Store purified samples at —20°C for up to 3 months. For long-term storage (>3 months), transfer
samples to labeled low-retention tubes, then store the DNA samples at -30°C to -10°C.
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View and export quantitation results

Purification runs that include sample quantitation produce sample concentration results that can be
accessed after the run is complete. In integrated configuration, view the Run Report that is available
in the Genexus™ Software to see the sample concentrations. In standalone configuration, sample
concentration results can be accessed from the Run Complete screen or the Home screen as

described here.

1. In the Run Complete screen, tap View report.

Run Complete

&

Unload

The Saved Experiment Reports screen opens. See step 4.

2. At any time after unloading and UV cleaning the instrument, sample concentration results can be
accessed through the Home screen. Tap @) (Settings).

SFODEMOO1

62 Oncomine™ BRCA Assay GX User Guide



Chapter 5 Genexus™ FFPE DNA and RNA Purification Kit protocol @
Unload purified samples 4"

3. In the Settings screen, tap Data Management.

Settings

System tools

Data management

4. Inthe Saved Experiment Reports screen, tap v or A to page through the list. Locate the
Experiment Name of interest, tap in the row to select the experiment, then tap View Report.

Saved Experiment Reports

5. In the Run Report screen, tap Quant Results to view the sample concentration results.

Run Report

6. Insert a USB drive into the USB port on the front of the instrument, then tap Export Report.
Navigate to the file destination, then tap Save.
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Add controls to the sample plate—Sample to Result run

Sample plates created by the Genexus™ Purification Instrument for Sample to Result runs have the
correct volume of samples loaded in the positions specified in the run setup guide. If any controls
were included in the run plan, you need to manually add positive controls and no template controls to
the sample plate, before loading the plate in the sequencer. For more information on the appropriate
controls see “Recommended sample controls” on page 16.

1. Add controls to the sample plate with the volume and in the well positions that are specified in the
run setup guide.

2. Seal the plate with an Adhesive PCR Plate Foil (Thermo Fisher Scientific Cat. No. AB0626).

Note: The use of other plate seals can affect performance.

3. Keep the plate on ice or at 4°C until you are ready to load it in the sequencer.

Proceed to Chapter 7, “Load the sequencer and start a run”.

Dilute the samples and load the sample input plate—Nucleic Acid to Result
run

Note: The Genexus™ Purification Instrument is not required for Nucleic Acid to Result sequencing runs.
Any of the recommended nucleic acid purification kits can be used to purify DNA for use in Nucleic
Acid to Result runs. For more information, see “Recommended materials for nucleic acid isolation,
quantification, and quality control” on page 16.

If sample quantitation was not performed as part of the purification run, use a Qubit™ Fluorometer
to accurately measure sample concentration (see page 157). If you want to run no template controls
or positive sample controls, select an appropriate control for your sample type as recommended in
“Recommended sample controls” on page 16.

1. Use the run setup guide to dilute samples and sample controls, if used, to the required
concentration using nuclease-free water.

IMPORTANT! Make sure to dilute samples to the concentration that was specified in substep 5b
in “Plan a Nucleic Acid to Result run” on page 35.

Table 4 Recommended sample concentration for Oncomine™ BRCA Assay GX

Sample type Recommended nucleic acid concentration

DNA from FFPE 0.8 ng/pL

2. Add 25 pL of diluted samples or sample control to the wells in the sample input plate as specified
in the run setup guide.
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3. Seal the plate with a sheet of Thermo Scientific™ Adhesive PCR Plate Foil (Cat. No. AB0626).

IMPORTANT! Do NOT use other brands of aluminum sealing tape. The use of other plate seals
can affect performance.

4. Keep the sample input plate on ice until ready to load in the sequencer.

Proceed to Chapter 7, “Load the sequencer and start a run”.

Dispose of used consumables and UV clean the instrument

Unload purified nucleic acid samples before disposal of used consumables.

IMPORTANT! Do not allow purified nucleic acids to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. Remove and discard the deep-well sample input plates.
a. Remove the FFPE DNA and RNA Purification Plate 1 from the instrument.

b. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

& WARNING! Liquid waste contains guanidine thiocyanate, dispose of properly.

c. Dispose of the deep-well plate in an appropriate waste container.
d. Repeat substep 1a through substep 1c to discard the FFPE DNA and RNA Purification Plate 2.

2. Unlock, then remove and dispose of the Purification Tip Cartridges in an appropriate waste
container.

3. Unlock, then remove and dispose of the Quantitation Plate.

a. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

WARNING! No data are currently available that address the mutagenicity or toxicity of the
Qubit™ RNA BR Reagent (Component A). This reagent is known to bind nucleic acid and is
provided as a solution in DMSO. Treat the Qubit™ RNA BR Reagent with the same safety

precautions as all other potential mutagens and dispose of the dye in accordance with local
regulations.

b. Dispose of the deep-well plate in an appropriate waste container.

4. Open the quantitation module cover, remove and discard the Quantitation Tube, then allow the
module cover to close.
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5. Close and lock the instrument door by pressing down on both top corners, then tap Start UV
Clean.

The time remaining in the UV cleaning is displayed. When complete, the instrument is ready to
start a new purification run.
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Note: The procedures described in this chapter apply to purification of DNA on the Genexus™
Purification Instrument using the lon Torrent™ Genexus™ Multisample DNA Purification Kit for the
following sample types.

. Whole blood

. Fresh frozen tissue

. Cell lines

For information on purification of DNA from FFPE samples using the Genexus™ Purification Instrument,
see Chapter 5, “Genexus™ FFPE DNA and RNA Purification Kit protocol”.
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Genexus™ Multisample DNA Purification workflow

Plan a purification run (page 70)

IMPORTANT! If performing a Sample to Result sequencing run, plan the run
in the Genexus™ Software. For more information see “Plan a Sample to Result
run” on page 33.

To purify samples for use in Nucleic Acid to Result runs or other
@ non-sequencing applications, run the Genexus™ Purification Instrument in
standalone configuration. Create a new purification run plan or copy/edit an
existing purification run plan that best represents your experiment, then edit the
settings as needed. Purification run plans contain instrument settings that are
used in sample purification.

Prepare samples (page 74)

Samples are processed based on the sample type prior to adding to the
Multisample DNA Purification Plate and loading on to the instrument for
purification of DNA.

Load the Genexus™ Purification Instrument (page 79)

The purification run plan is selected and the run initiated. The instrument
performs a pre-run UV clean, then consumables are loaded on to the
instrument. DNA Enhancer solution, sample, and Proteinase K are added to
the Multisample DNA Purification Plate, then immediately loaded on to the
instrument for purification of DNA.

Start the run (page 85)

After the sample plate and all reagents and consumables have been loaded the
instrument door is closed and the run started.

00 E &

Note: Depending on the number of samples, quantification adds ~1 hour to
the run time.
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Genexus™ Multisample DNA Purification workflow

Unload the purified nucleic acids (page 86)

If performing a Sample to Result run, remove the 96-Well Nucleic Acid Output
Plate, add any required control samples and proceed to sequencing of the
purified samples. Remove and seal the 48-Well Nucleic Acid Archive Plate,
then store as directed.

If performing a Nucleic Acid to Result run or purifying nucleic acids in
standalone configuration for use in other downstream applications, remove and
seal the 48-Well Nucleic Acid Archive Plate, then store as directed or proceed
to sequencing of the purified sample.

Used reagents and consumables are removed from the instrument and a UV
clean is performed.

Note: The Quantitation Plate requires equilibration to room temperature for at least 30 minutes before
use. To save time experienced users can take the Quantitation Plate out of 4°C storage before creating
a purification run plan and preparing samples.

Plan a purification run (standalone configuration)

Note: If running the Genexus™ Purification System in integrated configuration, see “Plan a Sample to
Result run” on page 33 to plan a Sample to Result run in the Genexus™ Software.

In standalone configuration, plan a purification-only run through the instrument touchscreen. After
purification is complete, all purified samples are transferred to an archive plate for storage.
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Add a purification run plan (standalone configuration)

Note: We recommend that you create the run plan before preparing your samples and loading into the
Multisample DNA Purification Plate.

1. Enter your username and password to sign in to the instrument.

2. Tap Run, select Purification Only, then tap Add plan.

VPS-BETA-0014

Standalone Config

3. Tap in the entry box, enter a unique name for the run plan, then tap Done » Next.

4. Select the lon Torrent™ Genexus™ Multisample DNA Purification Kit, then tap Next.
Select Kit

Select purificat
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5. Select the appropriate purification protocol, then tap Next.

Select Protocol

Sample type Input volume Select
Whole blood 50-100 pL Blood 50-100 pL
100-200 pLl"] Blood 100-200 pL
200-400 pL Blood 200-400 pL

[l Default value in ADF

6. Enable or disable Quantitation after Purification.

Note:
. The Quantitation Plate is required even if Quantitation after Purification is disabled.

. Disabling Quantitation after Purification may reduce the purification run time by up to 1 hour.

. Quantitation requires up to 10 pL of the eluted sample. If the expected sample yield is limiting,
manual sample quantitation may be preferred to preserve sample.

7. Accept the default elution volume. If needed, select the desired elution volume from the dropdown
list, then tap Next.

8. (Optional) Change the number of samples and the sample details.

a. In the Manage Samples screen, deselect extra samples (for example, if you are only running
11 samples, deselect sample 12).

b. In the Manage Samples screen, tap on a sample ID to select the sample.
c. Tap Edit, enter a new Sample ID and any Notes, then tap Save.
d. Repeat substep 8b and substep 8c for each additional sample.

e. Click Next.

Oncomine™ BRCA Assay GX User Guide 71



M Chapter 6 Genexus™ Multisample DNA Purification Kit protocol
~ " Plan a purification run (standalone configuration)

Manage Samples
g P

9. (Optional) Import sample information.

Note:

. Importing sample information overwrites the existing Sample ID and Notes information for each
sample selected.

. In standalone configuration, you must prepare a CSV sample import file and save it to a USB
drive to import sample information. For more information, see page 156.

a. In the Manage Samples screen, select the samples for which sample information is being
imported, then tap Import.

b. The Sample Import screen opens, tap Import to proceed.

c. Insert the USB drive containing the sample import CSV file into the USB port on the front of
the purification instrument. In the Sample Import screen, select the USB drive, then navigate
to and select the sample import file.

d. (Optional) Tap Details to view the CSV file listing the sample names to be imported.

e. Tap Import, then in the Import Successful screen, tap OK.
The imported sample information is shown in the Manage Samples screen. If needed, edit
imported sample information as described in step 8.
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10. Review the Purification Run Plan Details. Tap Edit to change any of your selections, otherwise
tap Next.

Purification Run Plan Details

Select Run Plan
0 PS-BETA-

Standalone Gonfig

ation run plan

Plan Name:

Number

Elution Volume DNA:

The new Run Plan will now appear in the list of available Purification Run Plans.

Prepare the Quantitation Plate and consumables

Cartridges and consumables needed:

* Genexus™ Multisample DNA Purification (Part. No. A45533)
— Multisample DNA Purification Plate
- 12-Well Tip Comb

* Genexus™ Nucleic Acid Quantitation, Broad Range (Part. No. A45537)
— Quantitation Plate Broad Range
— Quantitation Tube

* Genexus™ Purification Supplies 1 (Part. No. A45529)
— Purification Tip Cartridge
— 48-Well Nucleic Acid Archive Plate
— 48-Well Nucleic Acid Archive Plate Seal

* P200 pipet and filtered tips

¢ 96-Well Nucleic Acid Output Plate

Equilibrate the Quantitation Plate

The Quantitation Plate is required even if your run plan does not include sample quantitation.

IMPORTANT!
. Protect the Quantitation Plate from light to prevent photobleaching of the preloaded reagents.

. Allow at least 30 minutes for the Quantitation Plate to equilibrate to room temperature.

. Experienced users can save time by isolating cell-free plasma from whole blood while the
Quantitation Plate equilibrates.
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1. Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.

2. Place the plate and Quantitation Tube on the bench next to the Genexus™ Purification Instrument.

Prepare the consumables

IMPORTANT! Store all kit components containing liquid in the upright orientation.

Remove all cartridges and consumables from their packaging, then place them on the bench at room
temperature.

Prepare the following cartridges and consumables:
¢ Genexus™ Purification Supplies 1
— Purification Tip Cartridge
— 48-Well Nucleic Acid Archive Plate
— 48-Well Nucleic Acid Archive Plate Seal
e 12-Well Tip Comb

Prepare samples

Procedural guidelines

* Perform all steps at room temperature (20-25°C) unless otherwise noted.
* When mixing samples by pipetting up and down, avoid creating bubbles.
* When working with whole blood:

— Wear clean gloves and a clean lab coat.

— Change gloves whenever you suspect that they are contaminated.
— Open and close all sample tubes carefully. Avoid splashing or spraying samples.
- Use a positive-displacement pipettor and RNase-free pipette tips.

— Clean lab benches and equipment periodically with 10% bleach solution and rinse with 70%
ethanol.

* The plate chiller shuts off 60 minutes after run completion. Remove the 96-Well Nucleic
Acid Output Plate (Integrated configuration) or 48-Well Nucleic Acid Archive Plate (Standalone
configuration) with purified nucleic acids from the instrument within 1 hour of run completion.
Proceed immediately to sequencing or properly store the nucleic acids until use.

Before each use of the kit

¢ Keep samples on ice or at 4°C until use.

* Centrifuge purification plates for 30 seconds at 1,000 x g to collect the contents.
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Materials required

Genexus™ Multisample DNA Purification (Part No. A45535)
* Multisample DNA Purification Plate
* Enhancer solution
* Proteinase K

Fisherbrand™ Bead Mill 24 Homogenizer
Whole Blood Samples

1. Determine the volume (=50-400 pL) of each whole blood sample.

2. To each sample, add DNA Homogenization Buffer to a total volume of 400 pL.
For example, to 200 L whole blood add 200 yL DNA Homogenization Buffer. To 400 pyL whole
blood do not add DNA Homogenization Buffer.

IMPORTANT! For frozen samples, add DNA Homogenization Buffer directly to the frozen sample
to help in thawing.

3. Vortex, or pipet up and down at least 10 times, to thoroughly mix.

Proceed directly to “Start the purification run” on page 52. Samples are loaded in step 4 of “Add
samples to Multisample DNA Purification Plate” on page 83.

Prepare tissue samples

Fresh or frozen tissue DNA yields can vary based on the tissue type. Use the amounts suggested in
Table 5. For more information on expected DNA vyield by tissue type, see “Example tissue yields” on
page 77. Adjust input amount based on your results.

Use a bead mill homogenizer when processing small amounts of tissue and use a rotor-stator tissue
homogenizer when processing larger amounts of tissue. Alternate methods of cell disruption can also
be used. Do not exceed 5 mg of homogenized tissue for high yielding tissues or 10 mg of homogenized
tissue for low yielding tissues as sample input to the Multisample DNA Purification Plate.

Table 5 Recommended input amount based on tissue type

. Recommended tissue:DNA Maximum Multisample DNA Purification
Tissue type Homogenization Buffer ratiol'l . . o
Plate tissue input amount!2]
(mg:pL)
Low-yield tissue 1:40 10 mg
High-yield tissue 1:80 5 mg

' Do not exceed the indicated ratio when homogenizing the sample before loading on the purification plate.
@' Do not exceed the indicated amount as input into the sample purification plate.
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. Cut the sample into appropriately sized pieces. For larger samples, we recommend cutting the

material into long, thin strips for faster homogenization.

Weigh the tissue sample, then calculate and add the recommended volume of DNA
Homogenization Buffer.

For example, for 5.0 mg high-yield tissue add 400 yL DNA Homogenization Buffer or for 25 mg
low-yield tissue add 1.0 mL DNA Homogenization Buffer.

Maintain the recommended tissue-to-buffer ratio if using more or less tissue.

Homogenize the samples following manufacturer instructions for your homogenizer.

When homogenizing large amounts of tissue, use a rotator-stator tissue homogenizer in 10 second
pulses on ice or at 4°C.

Visually inspect the samples. If homogenization is incomplete, repeat step 3.

Transfer the lysate to a new tube. Ensure that no beads are carried over if using a bead mill
homogenizer.

Keep homogenized samples on ice or at 4°C until use.

Proceed to “Start the purification run” on page 52. Samples are loaded in step 4 of “Add samples
to Multisample DNA Purification Plate” on page 83.

STOPPING POINT If not proceeding directly to sample loading, store homogenized samples at —-90°C to
-70°C.

Prepare cultured cell samples

76

Up to 4 x 108 cultured cells can be processed per sample.

1.

3.

Centrifuge cells in culture media at 100 x g for 5 minutes at 4°C, then carefully remove the
supernatant without disturbing the cell pellet.

Thaw previously frozen cell pellets on ice or at 4°C, then remove as much culture media as
possible without disturbing the cell pellet.

(Optional) Wash the cell pellet.
a. Resuspend the cell pellet in 1/2 volume of 1X PBS.

b. Centrifuge cells at 100 x g for 5 minutes at 4°C, then carefully remove the supernatant without
disturbing the cell pellet.

Add 400 pL of DNA Homogenization Buffer (provided) to each sample cell pellet, set a P1000
pipettor to 300 L, then slowly pipet up and down 10-15 times.

IMPORTANT! The sample can be viscous. Pipet up and down thoroughly to ensure complete
mixing.

Proceed to “Start the purification run” on page 52. Samples are loaded in step 4 of “Add samples to
Multisample DNA Purification Plate” on page 83.
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Example tissue yields

Table 6 Recommended input amount based on tissue type

Recommended tissue:DNA Maximum Multisample DNA

Tissue type Homogenization Buffer ratiol'l Purification Plate tissue | Potential yield[®!
(mg:pL) input amount(?

High yielding tissues

High-yield tissue (25 mg) 1:80 5mg 10-30 g
Liver (25 mg) 1:80 5 mg 10-30 pg
Brain (25 mg) 1:80 5 mg 15-30 ug
Thymus (25 mg) 1:80 5 mg 15-30 pg
Kidney (25 mg) 1:80 5mg 15-30 ug
Spleen (25 mg) 1:80 5mg 15-75 g
Mouse tail (1.2 cm tip) 1:80 5 mg 10-25 ug

Low yielding tissues

Low-yield tissue (25 mg) 1:40 10 mg 5-10 ug
Lung (25 mg) 1:40 10 mg 5-10 pg
Heart (25 mg) 1:40 10 mg 5-10 pg
Breast (25 mg) 1:40 10 mg 5-10 pg

' Do not exceed the indicated ratio when homogenizing the sample before loading on the purification plate.
' Do not exceed the indicated amount as input into the sample purification plate.
Bl All yields are approximate and not indicative of purification performance.

Load the Genexus™ Purification Instrument and start the
run

This section describes how to perform the following procedures.
* Set up the instrument for use by loading all of the required reagents and consumables.
e Start a Genexus™ Purification Instrument run.

Note: Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.
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Start the purification run

1. In the instrument touchscreen, tap Run, then tap to select the run plan that you created for this
run.

Standalone Config

ANA_sxample

2. Ensure that the run plan selected is correct, then tap Next.

3. (Optional, standalone configuration) Import sample information.

The import overwrites the existing Sample ID and Notes information for each sample. That is, if
the run plan has 6 samples, the sample import file must include information for at least 6 samples.

To import sample information, prepare a CSV sample import file and save it to a USB drive. See
“Create a template for importing samples in standalone configuration purification run plans” on
page 156.

a. In the Sample Assignment screen, tap Manage Samples.
b. In the Manage Samples screen, tap Import.
c. In the Sample Import screen, tap Import to proceed.

d. Insert the USB drive that contains the sample import CSV file into the USB port on the front of
the purification instrument. In the Sample Import screen, select the USB drive, then navigate
to and select the sample import file.

e. (Optional) Tap Details to view the CSV file that lists the sample names to be imported.

f. Tap Import, then in the Import Successful screen, tap OK.
The imported sample information is shown in the Manage Samples screen. If needed, select
a sample, then tap Edit to modify the Sample ID or Notes.

4. Tap Next.
The instrument performs a 2-minute UV cleaning, then unlocks the door.
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5. Lift the instrument door to the stop.

(1) Hold here, then lift.

Load the Genexus™ Purification Instrument

IMPORTANT!

. Do NOT load any consumables onto the instrument until after the instrument has performed the
prerun UV cleaning.

. Ensure that all components are clean and dry before loading them onto the instrument.

. Ensure that the reagent and quantitation station compartments are free of condensate before loading
components. If needed, use a lint-free wipe to dry the compartment.

Follow the on-screen prompts to load the instrument.

Load Deck

@ 96-Well Nucleic Acid Output Plate, only needed when performing the purification in integrated configuration.

Oncomine™ BRCA Assay GX User Guide 79



@ Chapter 6 Genexus™ Multisample DNA Purification Kit protocol

Load the Genexus™ Furification Instrument and start the run

Load the 12-Well Tip Comb, Purification Tip Cartridge, 96-Well Nucleic Acid Output
Plate, and 48-Well Nucleic Acid Archive Plate

1.

Unwrap, then load a new 12-Well Tip Comb.

Ensure that the tip comb is straight and that the tabs are not bent or broken. If needed, gently
bend the tip comb in the opposite direction to the curvature to straighten the tip comb before
installing it.

(@ 12-Well Tip Comb position

2. Unwrap, then load a new 48-Well Nucleic Acid Archive Plate.

@ 48-Well Nucleic Acid Archive Plate
position

3. (Integrated configuration only) Load a new 96-Well Nucleic Acid Output Plate into the output plate

80

position.
The 96-Well Nucleic Acid Output Plate is not required when performing the purification in
standalone configuration.

After a purification run, the 96-Well Nucleic Acid Output Plate becomes the sample plate to be
loaded in the Genexus™ Integrated Sequencer.
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(1) 96-Well Nucleic Acid Output Plate
position

4. Unwrap a Purification Tip Cartridge, remove the cover to expose the pipette tips, then load it in
position 1.

@ Purification Tip Cartridge position 1

a. Pull the locking mechanism handle forward, then place the tip box in the open position.

(1) Unlocked (forward) (2 Locked (back)

b. Push the locking mechanism handle back to lock the tip box in place.
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Load the quantitation reagents and consumables

Note:
. Protect the Quantitation Plate from light to prevent photobleaching of the preloaded reagents.

. The Quantitation Plate is required even if your run plan does not include sample quantitation.
. The Quantitation Tube is not required if your run plan does not include sample quantitation.

1. Centrifuge the Quantitation Plate at 1,000 x g for 30 seconds to collect the contents.
2. Load the Quantitation Plate in position 2.

@ Quantitation Tube position
(2 Quantitation Plate position

a. Pull the locking mechanism handle forward, then place the Quantitation Plate in the open
position.

b. Push the locking mechanism handle back to lock the plate in place.

(@ Unlocked (forward) (@) Locked (back)
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3. (If needed) Slide and hold the quantitation module cover to the left, then insert the Quantitation
Tube. Press down firmly to properly seat the tube, then allow the module cover to close.

WARNING! Do not force the module cover closed. Forcing the module cover closed can
damage the instrument.

@ Open @ Closed

Add samples to Multisample DNA Purification Plate

The Multisample DNA Purification Plate contains magnetic beads in row D.

1. Briefly centrifuge the sealed Multisample DNA Purification Plate at 1000 x g for 30 seconds to
collect the contents. Alternatively, gently flick or tap the plate on the bench to force the reagents to
the bottoms of the tubes.

IMPORTANT! Do not create bubbles when preparing the plate.

2. Inspect the plate to ensure the contents of all rows are at the bottom of the wells. If needed repeat
step 1.

3. Carefully remove the plate seal without disturbing the
contents.

4. Add the samples to the Multisample DNA Purification
Plate as indicated in Table 7.

IMPORTANT!
. Do not pre-mix the DNA Enhancer solution and Proteinase K.

. Do not change the order of pipetting.

. Add samples to consecutive wells beginning with sample 1 in well A1, through sample 12 in well
A12. Do not skip wells.

. Once all components are added, proceed immediately to the instrument processing. There is no
need for manual mixing beforehand.

a. Add X pL DNA Enhancer solution to each well in Row A of the Multisample DNA Purification
Plate.

b. Add Y pL sample to each well in Row A.
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5.

c. Add Z pL Proteinase K solution to each well in Row A.

Table 7
DNA Enhancer solution (X pL) Sample Volume (Y pL) Proteinase K Volume (Z pL)
Sample type: whole blood
5 50 5
10 100 10
20 200 20
30 300 30
40 400 40
Sample type: fresh frozen tissue
— 400 —
Sample type: cell lines
40 400 40

Immediately load the 96 deep-well Multisample DNA Purification Plate with the samples in

position 1.

@ Multisample DNA Purification Plate position
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Start the run

1. When all reagents and consumables are loaded in the Genexus™ Purification Instrument, tap Next.

2. Close the instrument door by pressing down on both top corners. Ensure that the door is locked
after closing it.

The instrument vision system confirms that all reagents are in place and are not expired.

3. Tap Start.

The time remaining until the purification is complete is displayed and the interior lighting turns
green.

* |f you need to stop the run for any reason, tap Cancel, then tap Yes to confirm the
cancellation.

* The interior lighting turns off during quantitation, then turns blue when the run is complete.

¢ [f the instrument encounters a problem during the run, it aborts the run and displays the error
on the instrument touchscreen. The interior lighting turns red.

When the run is complete, the interior light turns blue, and the touchscreen displays Run Complete.
Quantitation results are available immediately. See “View and export quantitation results” on page 88.
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Unload purified samples

IMPORTANT! Do not allow purified samples to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. In the touchscreen, tap Unload. The door unlocks.

Complete

(1) Hold here, then lift.

3. (Sample to Result run) Remove the 96-Well Nucleic Acid Output Plate that contains the purified
sample DNA that is ready for the addition of positive or nontemplate sample sequencing controls.
For more information, see “Add controls to the sample input plate—Sample to Result run” on
page 90.. Store on ice or at 4°C. If quantitation was performed, the sample concentration
information is visible in the Genexus™ Software. Alternatively, use a Qubit™ Fluorometer to
accurately measure sample concentration manually, if needed.

For more information, see “Quantify nucleic acid samples” on page 157.
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STOPPING POINT If not sequencing immediately, for example while waiting for a second purification
batch, seal the plate with an Adhesive PCR Plate Foil (Cat. No. AB0626), then store the plate at
—20°C for up to 3 months. For long-term storage (>3 months), transfer the samples to labeled
low-retention tubes, then store the samples at -30°C to —10°C for up to 36 months.

4. Remove the 48-Well Nucleic Acid Archive Plate that contains the purified sample DNA in rows
A1-8 and B1-4.

@ DNAis in wells A1-A8 and B1-B4. Purification runs
can accommodate up to 12 samples per run in
standalone configuration.

Note: (Standalone configuration) If using the purified DNA immediately, transfer the sample DNA
to a sample input plate for sequencing. For more information, see the relevant assay user guide
for Nucleic Acid to Result run guidance. To determine the sample concentrations, see “View and
export quantitation results” on page 88.

5. For short-term storage, seal the plate with a 48-Well Nucleic Acid Archive Plate Seal. Store the
plate at —20°C for up to 3 months. For long-term storage (>3 months), transfer samples to labeled
low-retention tubes, then store the DNA samples at —-30°C to —10°C for up to 36 months.

If the archive plate is thawed during short-term storage, transfer the samples into labeled low-
retention tubes. Do not reseal the archive plate with the used plate seal.
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View and export quantitation results

88

Genexus™ Purification Instrument runs that include sample quantitation produce sample concentration
results that can be accessed after the run is complete. When integrated with the Genexus™ Software,

sample concentration information is automatically available in the software and used for Sample to
Result runs.

In standalone configuration, results can be accessed from the Run Complete screen or the Home
screen, then exported to a USB for transfer to the Genexus™ Software.

1. In the Run Complete screen, tap View report.

Run Complete

&

Unload

The Saved Experiment Reports screen opens. See step 4.

2. At any time after unloading and UV cleaning the instrument, sample concentration results can be
accessed through the Home screen. Tap @ (Settings).

SFODEMOCO1
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3. In the Settings screen, tap Data Management.

Settings

System tools

Data management

4. Inthe Saved Experiment Reports screen, tap v or A to page through the list. Locate the
Experiment Name of interest, tap in the row to select the experiment, then tap View Report.

Saved Experiment Reports

| A_P020.08_07_18_42 02 sierrn_gnp-0016-8-sslipe
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5. In the Run Report screen, tap Quant Results to view the sample concentration results.

Run Report

6. Insert a USB drive into the USB port on the front of the instrument, then tap Export Report.
Navigate to the file destination, then tap Save.

Sample concentration information is automatically transferred to the Genexus™ Software and used
for Sample to Result runs.

Add controls to the sample input plate—Sample to Result run

The 96-Well Nucleic Acid Output Plate created by the Genexus™ Purification Instrument for Sample to
Result runs have the correct volume of samples loaded in the positions specified in the run setup guide
for use as the sample input plate on the Genexus™ Integrated Sequencer. If any controls were included
in the run plan, you need to manually add positive controls and no template controls to the sample
input plate, before loading the plate in the sequencer. For more information on the appropriate controls
see “Recommended sample controls” on page 16.

1. Add controls to the sample input plate with the volume and in the well positions that are specified
in the run setup guide.

2. Seal the plate with a sheet of Thermo Scientific™ Adhesive PCR Plate Foil (Cat. No. AB0626).

IMPORTANT! Do NOT use other brands of aluminum sealing tape. The use of other plate seals
can affect performance.

3. Keep the sample input plate on ice until ready to load in the sequencer.

Proceed to Chapter 7, “Load the sequencer and start a run”.
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Dilute the samples and load the sample input plate—Nucleic Acid to Result
run

Note: The Genexus™ Purification Instrument is not required for Nucleic Acid to Result sequencing runs.
Any of the recommended nucleic acid purification kits can be used to purify DNA for use in Nucleic
Acid to Result runs. For more information, see “Recommended materials for nucleic acid isolation,
quantification, and quality control” on page 16.

If sample quantitation was not performed as part of the purification run, use a Qubit™ Fluorometer to
accurately measure sample concentration. If you want to run no template controls or positive sample
controls, select an appropriate control for your sample type as recommended in “Recommended
sample controls” on page 16.

1. Use the run setup guide to dilute samples and sample controls, if used, to the required
concentration using nuclease-free water.

IMPORTANT! Make sure to dilute samples to the concentration that was specified in substep 5b
in “Plan a Nucleic Acid to Result run” on page 35.

Table 8 Recommended sample concentration for Oncomine™ BRCA Assay GX

Sample type Recommended nucleic acid concentration

DNA from blood 0.8 ng/uL

2. Add 25 pL of diluted samples or sample control to the wells in the sample input plate as specified
in the run setup guide.

3. Seal the plate with a sheet of Thermo Scientific™ Adhesive PCR Plate Foil (Cat. No. AB0626).

IMPORTANT! Do NOT use other brands of aluminum sealing tape. The use of other plate seals
can affect performance.

4. Keep the sample input plate on ice until ready to load in the sequencet.

Proceed to Chapter 7, “Load the sequencer and start a run”.

Dispose of used consumables and UV clean the instrument

Unload purified DNA samples before disposal of used consumables.

IMPORTANT! Do not allow purified DNA to sit on the instrument. Store as directed or use in
sequencing reactions within 60 minutes.

1. Remove and discard the deep-well sample input plates.
a. Remove the Multisample DNA Purification Plate from the instrument.
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b. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

& WARNING! Liquid waste contains guanidine thiocyanate, dispose of properly.

c. Dispose of the deep-well plate in an appropriate waste container.

2. Unlock, then remove and dispose of the Purification Tip Cartridge in an appropriate waste
container.

3. Unlock, then remove and dispose of the Quantitation Plate.

a. Dispose of the liquid waste by tipping the deep-well plate on one corner and pouring the
waste into an appropriate liquid biohazardous waste container.

WARNING! No data are currently available that address the mutagenicity or toxicity of the
Qubit™ RNA BR Reagent (Component A). This reagent is known to bind nucleic acid and is
provided as a solution in DMSO. Treat the Qubit™ RNA BR Reagent with the same safety
precautions as all other potential mutagens and dispose of the dye in accordance with local
regulations.

b. Dispose of the deep-well plate in an appropriate waste container.

4. Open the quantitation module cover, remove and discard the Quantitation Tube, then allow the
module cover to gently close.

IMPORTANT! Do not allow the module cover to spring shut.

5. Close and lock the instrument door by pressing down on both top corners, then tap Start UV
Clean.

The time remaining in the UV cleaning is displayed. When complete, the instrument is ready to
start a new purification run.
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After you have planned a run in Genexus™ Software, use the run setup guide provided by the software
to load samples in the sample plate, and to determine which consumables to load in the sequencer.
Follow the step-by-step instructions in the sequencer touchscreen during run setup. The vision system
of the sequencer tracks the addition of consumables in real-time and alerts you if a component is
loaded in an incorrect position, or if an incorrect quantity is loaded.

Before you begin

Before setting up a sequencing run, review general procedural guidelines for handling panels, reagents,
and samples to minimize the chance of contamination. For more information, see “Guidelines for panel
and reagent use and handling” on page 26 and “Guidelines for preventing contamination” on page 25.

1. Remove the library and templating strips from their packaging in the refrigerator or freezer, and
prepare them for loading in the sequencer.
¢ Equilibrate or thaw the following reagent strips at room temperature for 30 minutes.
- Genexus™ Strip 1

— Genexus™ Strip 2-AS. If you are delayed in loading, keep the thawed strips on ice or at
4°C until you load them in the sequencer.

— Genexus™ Strip 3-GX5™ (or Genexus™ Strip 3-GX7™)

¢ Thaw Genexus™ Strip 4 by laying the strips on ice for 30 minutes, or incubating at 4°C for
30 minutes. If you are delayed in loading, keep the thawed strips on ice or at 4°C until you
load them in the sequencer.

IMPORTANT! Ensure that contents of strips that are stored frozen are completely thawed before
installing in the sequencer.

2. Remove primer pool tubes in tube carriers that are needed for the run from the freezer, then thaw
at room temperature for 30 minutes. After thawing, gently tap the primer pool tube or tubes on a
bench surface to ensure that contents are collected at the bottom of the tubes. Keep the tubes and
carriers on ice or at 4°C until you load them in the sequencer.

3. If you are installing a new Genexus™ Cartridge, thaw the cartridge at room temperature for
30 minutes before installing in the sequencer.
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4. Genexus™ Strip 1, Genexus™ Strip 3-GX5™, and Genexus™ Strip 3-GX7™ contain magnetic beads
in one or two positions, yellow or brown in color, that sometimes get trapped in the upper
"keyhole" of the tube. Dislodge these beads from the keyhole before installing the strip in the
sequencer. Use the following procedure for each strip.

Note: If you have a Genexus™ Strip Centrifuge Adapter, vortex the strips on a platform vortexer
to dislodge air bubbles and magnetic beads or to dissolve precipitate, then briefly centrifuge the
strips using the adapter to collect the contents at the bottom of the tubes. For more information,
see “Centrifuge library and templating reagent strips using the Genexus™ Strip Centrifuge Adapter
on page 96.

”

a. Invert the strip 3—4 times to dislodge beads that are trapped in the keyholes.

b. To remove any remaining beads and liquid from the
keyholes, grasp the strip at one end with the strip
seal facing up, then swing the strip with a rapid,
downward centrifugal arm motion, ending with a
sharp wrist-flick.

c. Grasp the strip at the other end, then repeat the
centrifugal motion.
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d. Check tube positions for significant amounts of beads that are still trapped in keyholes (see
the following figure), then repeat the centrifugal motion, if needed. It is acceptable if a few
beads remain in the keyhole or on the tube wall, but most should be either in suspension or in
a pellet at the bottom of the tube.

Example Genexus™ Strip 3-GX5™ before (upper) and after (lower) inversion. The carrier has been removed to
show tube contents more easily.

@ Magnetic beads trapped in keyholes @ Magnetic beads dislodged from keyholes

Note:

. It is not necessary to resuspend the magnetic beads completely —it is only necessary to
dislodge most of the beads that can be trapped in the keyhole. The instrument resuspends
the beads during the run when needed.

. Fine bubbles can form above the liquid in some tubes after inversion. These bubbles do not
affect the run.

5. Inspect all strips for large bubbles lodged under the surface of the liquid or at the bottom of each
tube or well. Gently tap the strips on a benchtop to dislodge any bubbles without splashing the
contents onto the upper tube walls. If tapping fails to dislodge a bubble, use the technique that is
described in substep 4b until large bubbles are dislodged.
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Centrifuge library and templating reagent strips using the
Genexus™ Strip Centrifuge Adapter

96

You can use the Genexus™ Strip Centrifuge Adapter as a holder for centrifuging library and templating
strips to collect contents after vortexing the strips. Vortexing and centrifuging strips is recommended
to decrease errors in the workflow due to air bubbles in strip wells or beads trapped near the foil seal.
Users can request this part from a Thermo Fisher Scientific Field Service Engineer.

Note: The Genexus™ Strip Centrifuge Adapter can also be used to centrifuge Genexus™ Primer Pool
Tubes.

Use of the adapter requires a centrifuge with buckets that support the height of the adapter at 44 mm
so that buckets swing freely in the centrifuge rotor when loaded with strips. For more information, see
“Recommended materials for use with the Oncomine™ BRCA Assay GX” on page 16.
Genexus™ Strip Centrifuge Adapter

(D 44 mm height

To use the Genexus™ Strip Centrifuge Adapter, follow these steps.

1. After thawing, vortex each strip at maximum speed for 5-10 seconds while rocking the strip from
side to side.

2. Load the strips in the adapters in a balanced orientation, then place each adapter loaded with
strips in the centrifuge. The centrifuge buckets must support the height of the adapters loaded
with strips.

3. Centrifuge the strips at 300 x g for 15 seconds.

4. Remove strips from the adapters, then inspect the strips to ensure that contents have been
collected and air bubbles are not present.

5. If brown magnetic beads are still visible in the tube keyhole near the foil seal, invert the strip to
resuspend the contents, then repeat step 3.

Note: It is not necessary to dislodge all the beads trapped in a keyhole—dislodging most beads is
sufficient.
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6. Repeat step 1 through step 4, if needed, for the remaining library and templating strips to be
loaded in the sequencer.

7. After centrifugation, keep each strip on ice or 4°C until you are ready to load the strips in the
sequencer.

Load the sequencer and start a run

1. Tap Run on the sequencer home screen to start the loading procedure.

Genexus Integrated Sequencer

2. In the Run Selection screen, select the run that you want to use from the list.

Run Selection

Run List

Cancel

Note: If you select a run that requires more lanes than are available on a currently installed chip, a
dialog box appears giving you the option to install a new chip, or cancel. If you proceed with a new
chip, a post-chip clean is performed, then the sequencer prompts you to perform the following
steps:
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. Clear Deck . Clear Sequencing Reagents
. UV Clean . Load Sequencing Reagents
. Load Deck

3. In the Review Run screen, confirm the run selections, then tap Next.

Review Bun

DNA, Fus v

NA FL

The deck door opens automatically.

Note:

. If the instrument vision system detects consumables loaded on the deck, the sequencer
prompts you to remove the consumables, then starts a UV Clean.

. Select the Do Force Clean checkbox if there will be an unused lane or lanes on the installed
chip after the run, but you want to start your next run on a new chip after the current run. A force
clean automatically cleans the instrument after the run, eliminating the need for an operator to
perform the cleaning procedure manually between the completion of the current run and the
next run. Selecting Do Force Clean renders all lanes of the installed chip unusable after the run.
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4. Inthe Load Deck screen, the sequencer instructs you step by step to load each required
consumable in a highlighted position on the deck. The sequencer detects the loading of each
consumable in real time and advances to the next component automatically.

Load Deck

IMPORTANT!

Ensure that you remove the primer pool tube cap or caps before installing the tube carrier on the
deck.

Ensure that you load the correct type of barcode plate and library strip 2 for the type of run

you are setting up. The sequencer displays a warning if you have installed consumables that are
incompatible with the run you have selected, for example, a Genexus™ Barcodes AS plate or
Genexus™ Strip 2-AS in an HD run.

Ensure that you remove the lids from all the boxes of Genexus™ Pipette Tips before you load the
boxes in the sequencer. The sequencer vision system cannot distinguish tip boxes with lids from
boxes without lids.

After removing the tip box lid, visually inspect tip boxes to ensure that all tips are seated level

in the tip rack before and after placing on the instrument deck. If a bent or damaged tip is
suspected, replace the tip box with a new tip box. Re-racking of tips from partially used boxes is
not supported and can cause some tips to seat at an angle, which can affect run performance.
Ensure that all tip boxes sit level on the deck by visually inspecting all boxes across the tip
station. Reseat the boxes before starting the run, if needed.

Do not use third-party pipette tips or re-rack third-party tips into used Genexus™ Pipette Tips
boxes. Use of third-party tips can result in sequencing run failure.

Load instrument plates, including the PCR plate, barcode plate, enrichment plate, and sample
plate, into position by pressing down firmly and evenly on all sides and corners of each plate.
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Note:

. A primer pool tube carrier can only be installed with
the position 1 tube in the back row of the Primer =
Pool Tube Station. Follow the guidance in the run U O @
setup guide for loading the primer pool tube carrier or
carriers in the correct position and order in the station.

. If the sequencer cannot read the correct loading of
an unexpired consumable, tap Help in the lower left
corner of the screen to override the block. After using
this override, the name of the consumable will not @ Position 1
appear in the run summary consumables list. ® Position 2

5. If prompted, insert a new GX5™ Chip and Genexus™ Coupler. Insert the chip into the chip install
slot with the chip notch oriented down and toward the front of the instrument.

() Notched corner of chip

Note: A chip shuttle under the deck moves the installed chip to loading and sequencing positions
during the run.

IMPORTANT! Insert the Genexus™ Coupler so that it is level to properly align with the GX5™ Chip.
A coupler that is installed at an angle or is not level will not align properly to the chip and can result
in a failed run.

6. When the deck consumables have been loaded, lock the library and templating strips in place by
sliding the latches toward the rear of the deck.

Note: We recommend that you load the sample plate last.
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Cancel

If a chip is detected and the strip latches are closed, the Close Deck Door screen appears.

7. Close the deck door, then tap Next.

Close Deck Door

Close the deck door, then press Next

¢ If you installed a new chip in the sequencer, the sequencer prompts you to open the
sequencing reagents bay doors to empty the waste and remove used sequencing reagents
bay consumables. Proceed to step 8.

¢ If you are using a chip that was previously installed and has sufficient lane capacity for the run,
the sequencer prompts you to start the run.

IMPORTANT! The cartridge and bottles in the sequencing reagents bay must be replaced every
time that a new chip is installed, regardless of how many lanes were used in the previous chip.
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8. Follow on-screen instructions to empty the waste in the Waste carboy, remove waste pipette
tips, remove the used Genexus™ Bottle 1, Genexus™ Bottle 2, Genexus™ Bottle 3, and Genexus™
Cartridge, then tap Next.

Clear Sequencing Reagents

Empty and repl

IMPORTANT!

. Ensure that you empty and replace the Waste carboy and the waste pipette tip bin.

. After replacing the emptied Waste carboy, ensure that you reinsert the waste tube into the
carboy.

. Follow all applicable local, state/provincial, and/or national regulations when recycling or
disposing of consumables and liquid waste.

9. Install a new Genexus™ Bottle 1, Genexus™ Bottle 2 (two required), Genexus™ Bottle 3, and
Genexus™ Cartridge.

Load Sequencing Reagents
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IMPORTANT!

. Before installing, gently invert each Genexus™ Bottle 2 five times to mix—avoid vigorous mixing.
Inspect the plastic nozzles for any pinches or deformations. To avoid pinching or folding of the
plastic nozzle, install the bottles straight-on, not at an angle.

. The installed reagents can be used for up to 14 days on the sequencer with full performance.
After 14 days, you may observe reduced performance.

After reagents have been installed, the Close Sequencing Reagent Bay Door screen appears.

10. Close the sequencing reagents bay doors.

Close Sequencing Reagent Bay Door

After the doors are closed, the sequencer automatically starts the run.

At the beginning of the run, the instrument chip coupler check verifies the chip, checks for leaks,
then calculates run time.

A sequencing run encompasses the following stages:

1. Starting 5. Pre-sequencing
2. |Initializing 6. Sequencing

3. Library Prep 7. Cleaning

4. Templating

At each stage, the instrument shows the time remaining on the touchscreen.

Note: The time remaining shown on the screen does not include run analysis time.
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~ " Clear the instrument deck and perform a UV Clean

Sequencing

CLEL
o0 iy,
&Y %,

00:31:24
B Library Prep

%apun®®

When the run finishes, the sequencer displays the Run Complete screen.

Note: If all the lanes of a chip are used, the chip shuttles to the install position. You are asked to
remove the chip and coupler, and clear the sequencing reagents.

Clear the instrument deck and perform a UV Clean

After a run completes, remove used consumables from the deck and perform a UV Clean to ready the
instrument for the next run.

1. In the Run Complete screen, tap Next to start removal of used consumabiles.

Sequencing

Run
Complete

The deck door opens.
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2. In the Clear Deck screen, the sequencer provides step-by-step instructions by highlighting the
components to be removed. Unlock the library and templating strips by sliding the latches toward
the front of the deck, then remove the used strips. Remove the remaining deck components

specified by the sequencer.

Clear Deck

rip 1 in position 1

3. Inspect the Genexus™ Filter in the liquid waste disposal port and verify that no standing liquid is
present. If standing liquid is present, manually remove the liquid with a pipette, then pull out the
filter. Test the filter with water to determine if a clog is present.

¢ [f the Genexus™ Filter is clogged, replace it with a new filter. For more information, see
"Replace the Genexus™ Filter" in the Genexus™ Integrated Sequencer User Guide (Pub. No.
MANO0017910).

¢ |f the Genexus™ Filter does not appear to be clogged, a line clog downstream of the filter is
implicated. Contact Technical Support and report a possible deck liquid waste line clog.

4. When finished, close the deck door, then tap Next.

Close Deck Door

Close the deck door, then press Next

A two-minute UV Clean starts.
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Sequencing

’bﬁﬁ“ "#ﬁ&

00:01:58

UV Clean

Yay uﬂ":‘ﬁ

5. After UV cleaning, if all the chip lanes were used, the sequencing reagents bay doors unlock. Open
the doors, remove used components from the bay and empty the Waste carboy, then tap Next.

Clear Sequencing Reagents

IMPORTANT! Do not discard or remove the conical bottles, unless alerted by the sequencer
to replace the bottles after a conical bottle flow rate test. For more information, see Genexus™
Integrated Sequencer User Guide (Pub. No. MAN0O017910).

IMPORTANT! Follow all applicable local, state/provincial, and/or national regulations when
recycling or disposing of Genexus™ Integrated Sequencer consumables and liquid waste.

CAUTION! The Genexus™ Bottle 1 (small waste bottle) contains small amounts of formamide.
Dispose of this waste appropriately.

6. After removal of used components, close the sequencing reagents bay doors, then tap Next.
The sequencer returns to the home screen.
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Genexus |Ion Torrent Dashboard Samples Runs Results Assays

Results [/ Sample Results Sample Results

Run Results
Non Archived ~ Selected Samples: 0 (' Refrash Columns =

Verification Results

Sample Name h 4 Assay Name T Run Name T Sample Status T QC Status T Started On T Updated On

Use the Results menu to review results and data analysis, and to perform data management tasks. You
can view results sorted by sample or by run.

Selection Description
Click Results » Sample Results Select this option to review completed sample results and reports.
Click Results » Run Results Select this option to review completed run results and reports by
assay.

Click Results » Verification Results | Select this option to review data from completed verification runs
that were performed during sequencer installation or performance
qualification.
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Review run results

In the Results / Run Results screen, runs that are pending, in progress, or complete are listed. Runs
with a status of failed, aborted, or stalled are also listed.

You can filter the list of run results by clicking Y (Filter) in a column of interest, then entering a full or
partial run or assay hame, or other applicable filter term.

The following run information appears in the Results / Run Results screen.

Column Description

Run Name The unique name of the run given when it was created in the software. Click a run name to open
the Run Summary.
Runs that are reanalyzed are listed with & (Reanalysis) after the run name. For more information,
see the software help system, or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

Assay Name | The name of the assay selected for the run. You can view the Assay Name and corresponding
Assay Full Name for all assays in the Assays » Manage Assays screen.

Run Status The status of the run. For example, Analysis In Progress, Executing Plugins, Analysis Completed,

Terminated, Archival: In Progress, Purification In Progress, or Purification Completed).

For purification runs that have a status of Purification In Progress, Purification Complete, or for
failed or aborted purification runs, you can place the pointer over the shaded number, in the Status
column to view the status of each purification batch for the run. The shaded number, such as 1

or 2, represents a purification batch for the run. For example, a status can be 1 Completed, 2
Started, and 3 Planned, which indicates that the first batch is complete, the second batch has
started, and the third purification batch has not yet started, but is planned. For more information
about purification batches, see “About integrated run planning” on page 32.

Total Samples

The total number of samples in a run.

PCR Plate A unique identifier for the 96-well plate used for library preparation and templating. For more
Number information, see Genexus™ Software Help.

Started On The date and time when the run was started.

Updated On The date and time when the last action was completed on the run.

You can also perform the following actions in the Results / Run Results screen.
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Option Description
Actions | Available action links for a run are shown when you place the pointer over the row of a run. The actions
that are available depend on the type of run.
¢ Delete—Delete the run.
¢ BAM Uploader—Upload run information to another Genexus™ Integrated Sequencer or to lon
Reporter™ Software for further analysis.
BAM Uploader is not available for BAM run results or for archived runs in which BAM files have been
removed.
For more information, see the software help system.
¢ Audit—View the audit trail for the run.
* CSA—Download customer support archive (CSA) log files for the run to help with troubleshooting.
¢ Assign PCR Plate—Enter a unique identifier for the 96-well plate used for library preparation and
templating.
Actions | These actions are available only for Sample to Result runs.
* View Plan—View detailed run plan information.
* Review—Review samples that do not have a concentration within a specified threshold after
purification, but before library preparation.
For more information, see “Review samples for Sample to Result runs” on page 114.
¢ Abort—Enables you to abort a run after purification, but before sequencing. This action is available
when the run status is Purification Review Required, or when the run status is Purification
Completed and some purification samples have been excluded from sequencing.
Actions | Available action links for a run are shown when you select the checkbox to the left of the Run Name.

® (Clear—Deselect the selected run or runs.

* Retain Data—Click to keep run data regardless of disk cleanup settings. To undo, select Release
Data.

¢ Archive Data—Click to archive run data. Select run data options (Sequencing Output, Intermediate
Files) in the Archive Confirmation dialog box. Analysis Results are selected by default and are not

optional.
* Delete—Delete the run data of the selected run or runs.
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View the run summary

110

The run summary provides an overview of the run. The information that is displayed includes the

name of the assay used in the run, sample locations, information about the reagents used in the run,
primer tube positions, and instrument information. Metrics from sample purification are also provided, if
applicable.

1.

2.

In the menu bar, click Results » Run Results.

In the Run Name column, click the run name of interest.

The Run Summary tab opens.

Review the run summary.

Action

Procedure

View the assay metrics.

In the Assays section, click the assay name of interest.

View the sample locations in an image
of a 96-well sample plate.

In the Sample Locations section, click PCR Plate View.

Reanalyze a run with a new assay.

In the upper right corner of the screen, click
+++ (More Options) » Reanalyze.

Run plugins on the sequencing data
after a sequencing run is complete.

In the upper right corner of the screen, click
«++ (More Options) » Run Plugin.

Download customer support archive
(CSA) log files for the run to help with
troubleshooting.

In the upper right corner of the screen, click
«++ (More Options) » CSA.

Upload results to another Genexus™
Integrated Sequencer or to lon

Reporter™ Software for further analysis.

In the upper right corner of the screen, click
+++ (More Options) » BAM Uploader.

View the history of variant
classifications.

In the upper right corner of the screen, click

«++ (More Options) » Variant Audit.

The information is available only for results that include
variant classifications.

View the run report.

Click the Run Report tab.

Oncomine™ BRCA Assay GX User Guide




Chapter 8 Review data and results a8
Review run results

The run summary

The run summary displays run information, assays used in the run, sample locations, metrics from
sample purification, information about the reagents used in the run, primer tube positions, and
instrument information.

Depending on the type of the run and the selections made in the run plan, the run information can
include the following items.

Table 9 Run information

ltem Description
Run Name The name of the run.
Started On The date and time when the run was started.

Completed On

The date and time when the run was completed.

Run Status The status of the run.

Report Template | If the option to generate a report was enabled in the run plan, the report template used is listed.

Chip Type The semiconductor sequencing chip used in the run, such as the lon Torrent™ GX5™ Chip.

Library Chemistry | The type of library chemistry used in the run, such as lon AmpliSeq™ HD.

Server The lon Reporter™ Software account or the Genexus™ Software account and the respective
software version that was selected for uploading BAM files when the run is complete.

Run Type The type of run. For example, Nucleic Acid to Result.

Table 10 Sequencing instrument information

Item

Description

Instrument Name

The name of the sequencer.

Instrument Serial Number

The serial number of the sequencer.

Status The status of the sequencing portion of the run.

Operator The name of the person who was signed in the Genexus™ Integrated Sequencer when
the sequencing run was performed.

Start Date The date and time when the run was started on the sequencer.

Completion Date

The date and time when the run was completed on the sequencer.

Sequencing Flows

The number of flows performed by the sequencer.
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Table 11 Purification instrument information

Item

Description

Purif. Instrument

The name of the purification instrument.

Instrument Serial Number | The serial number of the purification instrument.

Status The status of the purification portion of the run for the batch.

Operator The name of the person who was signed in the Genexus™ Purification Instrument when
purification was performed.

Start Date The date and time when the batch was started on the purification instrument.

Completion Date

The date and time when the batch was completed on the purification instrument.

Purif. Batch

The nucleic acid isolation batch.

Table 12 Assays table

ltem

Description

Assay Full Name

The name of the assay used in the run. Click the assay name to display the details of the
assay.

Assay Name

An abbreviated name of the assay or assays used in the run.

Analysis Version

The version of the assay used for analysis.

Research The research application for the assay, such as DNA or DNA and Fusions.
Application
Lane The chip lane or lanes used in the sequencing run for the assay.

Total Samples

The total number of samples sequenced for the assay. A single sample can correlate with
multiple wells on the plate for some assays when multiple nucleic acid types are contained
within the sample.

Updated
Annotations

The information that is shown depends on the settings and the type of the assay.

* The name and version of the annotation source that is applied to the sample result is
shown when an assay is configured to use the latest annotations but the annotation that
is applied to the results is not the latest annotation source.

* No information is shown in the column (the value is blank) when the latest annotation set
version is applied to the result, regardless of whether the assay is configured to use the
latest annotation source.

¢ No information is shown in the column (the value is blank) when an assay is configured
to not use the latest annotation source, and instead uses a fixed version of an annotation
source.

* N/Ais shown when an assay does not use an annotation set.
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Table 13 Purification Samples table

Item

Description

Batch ID

When the run includes more than one purification batch, the Batch ID is listed. The Batch ID,
such as 1 or 2, indicates the purification group for each sample.

Sample Name

The unique identifier created when the sample was entered into the software.

Sample Type

A term that describes the sample, for example, FFPE or Blood (Plasma).

Nucleic Acid Type

DNA, RNA, or DNA+RNA.

Conc. (ng/pl)

The concentration of the sample measured by the purification instrument.

In some instances, such as when purification is in progress or when the sample is a no-
template control, the values is listed as N/A.

If the concentration is not within the QC concentration range specified by the assay, a Quantity
Not Sufficient (QNS) alert is displayed.

QC Conc. Range
(ng/pl)

The QC concentration range for the assay.

Batch Status

The run status of a purification batch.

The status can be N/A, Planned, Review, Started, Aborted, or Completed.

Archive Position

The sample positions in the archive plate.

Sample positions can be in rows A to D and in columns 1 to 8.

Library Prep

An indicator of whether the sample is selected for sequencing.
. (Checkmark) — indicates that the sample is selected for sequencing.
*  (@-(No icon) indicates that the sample is not selected for sequencing.

* N/A - indicates that purification has not started or is in progress.

Table 14 Sample

Locations table

Item

Description

PCR Plate View

Click to view the sample locations in an image of a 96-well sample plate.

Well Pos.

The well position indicates the location of the sample on the plate.

Library Batch ID

The unique identifier created for the library batch. This information is available only for Library to
Result runs.

Sample Name

The unique identifier created when the sample was entered into the software.

Nucleic Acid Type

The sample nucleic acid type, such as DNA, RNA, or TNA.

Vol. (pl)

The volume of the sample.

Conc. (ng/pl)

The concentration of the sample.

Dilution Factor

The dilution factor of the sampile.
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Table 14 Sample Locations table (continued)

Item

Description

Kit Barcodes

The barcode for the kit used for nucleic acid extraction, if applicable.

Barcode

The name of the barcode adapter or adapters that are associated with the sample, for example,
lonHDdual_0101.

Assay Name

The assay that was used to sequence the sample for the indicated well position.

Library Position

The plate location of libraries. For completed runs that were planned using samples, the Library
Position indicates the location of unused libraries that can be sequenced by planning and
initiating a library run.

Table 15 Reagents table

Item

Description

Consumable

Consumables used in the run, such as the PanelKit and LibraryKit, are listed.

Barcode

The consumable barcode, if applicable.

Part #

The consumable part number, if applicable.

Expiration Date

The consumable expiration date, if applicable.

Lot #

The consumable lot number, if applicable.

The Primer Tube Positions table shows an image that indicates the locations of the primer pool tubes.

Review samples for Sample to Result runs

A Sample to Result run integrates nucleic acid purification and sequencing. When you create a
Sample to Result run plan, you can include an option that allows samples to be reviewed before library
preparation starts. Samples that do not meet a specified concentration threshold after purification have
a run status of Purification Review Required.

For more information about Sample to Result runs, see “About integrated run planning” on page 32.

You can also apply this option when you create an assay. For more information, see the software help

system.

1. In the menu bar, click Results » Run Results.

Note: Sample to Result runs that require review after purification have a Run Status of
Purification Review Required.

2. In the Run Results screen, place the pointer over the row of the run plan of interest, then click
Review.

The Purification Samples screen opens.
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3. Review the concentration for each sample, then select the checkbox in the row for each sample
you want to sequence.

4. Click Submit.

The samples are ready for sequencing. For more information, see the Genexus™ Purification System
User Guide (Pub. No. MANO0018475).

Variant report

The variant report is a PDF report of the results for each sample in a sequencing run. You can use
a system-installed report template to generate a variant report, or you can customize the layout and
contents of a variant report.

To make a variant report available for each sample result upon completion of a sequencing run, enable
Generate Report in the Setup step when you plan the run. For more information, see Chapter 4, “Plan

and manage runs”). To generate a variant report after a run is complete, see “Generate a variant report”
on page 115.

When a variant report has been generated for a sample result, it is available for download in three
places:

* In the Results / Sample Results screen when you place the pointer over the row for that sample,
then click the Report link to download the PDF.

* In the variant report pane for the sample results in the Reports tab when you click
: (More) » Download Report.

* In the Results screen for the sample when you click --- (More Options) » Download Files.

Variant reports can be electronically or manually signed by users. Electronic signatures are shown in the
Electronically Signed By section of the report, if the section is included in the report template.

Generate a variant report

You can generate a new variant report for sample results after a run is complete. A & (Lock) in the
variant report indicates that the electronic signature option for the report is locked. After a variant report
is locked, the report cannot be electronically signed by any other user.

You can generate multiple reports for a sample result, if each report is named uniquely, and is
generated in a different language, or uses a different report template.

When generating a customized report, you can update any report template selections. You can use this
procedure to generate multiple reports for a sample, if a unique report name is entered for each report.
For example, you may want to generate reports for different languages, or reports that use different
templates.

1. In the menu bar, click Results » Sample Results.

2. In the Results / Sample Results screen, click the sample of interest in the Sample Name column.

3. Select the Reports tab, then click + Generate Variant Report.
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4. Inthe Generate Report dialog box, change the name of the report that is generated by the
software, if needed, then select the report template and language of the report.

a. If the report template includes the option to include custom images from the results, click
Upload Image, then select the images to include in the report, and enter a title for the image,
and if needed enter a description and footnote for the image.

b. If the option to make custom text Editable on Report Generation was selected when the
report template was created, enter a title in the Custom Text section and if needed, a
description.

The Report Template list includes the report templates that are associated with the assay that was
used in the run. For information about creating report templates, see the software help system, or
the Genexus™ Software 6.8 User Guide.

If you select the same report template that was used to generate a variant report, and have not
locked that report, the new selections you make override the previous variant report.

5. Click Generate.
A draft version of the report is added to the Reports tab.

A pane for the new report is added next to the Run Report pane in the Reports tab. Reports that have
been generated are available for download in the Reports tab, in the Sample Results screen, and in
the ZIP package that contains results files.

Download a variant report

You can download a variant report for a sample result of interest from the Results / Sample Results
screen, from the pane that shows the report, or as part of a download of results files.

1. In the menu bar, click Results » Sample Results.

2. Download the report with one of the following options.

Option Procedure

Download a ZIP file that contains all variant | In the Sample Results screen, click the sample name
reports for a sample result. of interest in the Sample Name column, then click
-+- (More Options) » Download Files.

Download the variant report in PDF format | Click the Reports tab then, in the pane of the report of
from the Reports tab for the sample interest, click (More) » Download Report.
results.

Download the variant report as part of the
results files for a specific sample in the
Results screen.

A ZIP file that contains the PDF report is downloaded to the computer if you download reports
from the Sample Results screen or as part of the results files. A report in PDF format downloads if
you use the Reports tab for the download.
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3. In the Sample Results screen, place the pointer over the row of the sample of interest, then click
Report.

Genexus | ¢ Oashbsnd
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A ZIP file that contains the PDF report downloads automatically.

4. Extract the downloaded files, then open the PDF file in an appropriate viewer.

View sequencing results

For every run, you can view assay-specific results and sample-specific results. Assay-specific results
include assay metrics, such as final read data, and assay-level plugin information, such as execution
of the customer support archive. For more information, see “Assay metrics and the run report” on
page 118 and “Review plugin results in Genexus™ Software” on page 140.

The following sample-specific result information is available.

1. Click Results » Sample Results to view sequencing results for a particular sample.
2. In the Sample Name column, click a sample name.

3. In the Results screen, click the tabs to view the different types of sample-specific results and data.

Tab Description

QC The quality metrics for the sample sequenced in the run. For more information, see “QC results” on
page 123.

Key Findings | An overview of the results for the sample, including Sample Details, Key Metrics, Genes, and
Coverage graphs. For more information, see the software help system.

Variants Detailed variant results for SNVs/Indels and CNVs. For more information, see “View SNV/INDEL
results” on page 131 and “View CNV results” on page 134.

Plugins Results generated from the plugins associated with the assay used to analyze the sequenced
sample. For more information, see “Review plugin results in Genexus™ Software” on page 140.

Reports You can download and generate summaries of run results. There are two types of reports:

* Run reports — include assay metrics and the record of reagents that were used in a run. For
more information, see “Download a run report” on page 122.

* Variant reports — include the variant results for each sample in a sequencing run, reagents used,
and QC evaluation metrics. For more information, see “Variant report” on page 115.
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Assay metrics and the run report

The run report provides detailed information, such as various chip metrics for the run, and well and lon
Sphere™ Particles (ISPs) statistics. For runs with multiple assays, metrics are provided for each assay in
the run. Sequencing metrics are shown at the top of the screen, followed by sample-specific metrics in
the Run Samples table. Read data for individual samples for the assay are listed in the Run Samples

table.

Barcode-specific metrics for barcodes that are included in the run are listed in the Barcodes With
Reads Reported table, which follows the Run Samples table. The CSA file for the run contains
information for barcodes that are not assigned to samples in the run. Information in the CSA file can
help you troubleshoot results, if needed. For more information, see the software help system.

Table 16 Run Report

Metric Description
Loading The number and percentage of total addressable wells on the chip that contain an ISP.
Enrichment The number and percentage of wells ISPs that contain live ISPs.

Library

The number and percentage of wells with live ISPs that contain Library ISPs.

Combined Final
Reads

For runs that include resequencing, the combined final reads is the sum of library reads from
both sequencing and resequencing.

Final Reads Library reads passing all filters that are recorded in the output BAM files. This value can be
different from the total number of reads due to technicalities associated with read trimming
beyond a minimal requirement.

Total Bases The number of filtered and trimmed base pairs that are reported in the output BAM file.

Combined Total
Bases

For runs that include resequencing, the combined total bases is the sum from sequencing
and resequencing.

Raw Read Accuracy

The raw read accuracy across each individual base position in a read calculated as, (1-
[total errors in the sequenced reads]/[total bases sequenced]) x 100. Raw read accuracy

is measured at each base across the length of the read and is based on 1x sequencing
coverage; raw read accuracy is not based on consensus accuracy across multiple reads for
the same base position.

Wells with ISPs

The number of wells that contain an ISP.

Unenriched

The number and percentage of wells with ISPs that do not contain live ISPs.

Total Addressable
Wells

Wells on the chip that can be physically reached by a library.

Empty Wells

The percentage of total addressable wells on the chip that do not contain an ISP.

Wells with Live ISPs

Loaded wells with ISPs with a signal of sufficient strength and composition to be associated
with the library or control fragment key.

Wells with Library
ISPs

Loaded wells with live ISPs with a key signal that is identical to the library key signal.
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Table 16 Run Report (continued)

Metric Description
Control ISPs Loaded wells with live ISPs with a key signal that is identical to the control fragment key
signal.
Filtered out The total percentage of filtered reads, or the sum of the percentages of polyclonal, low
quality, and adapter dimer reads.
Polyclonal Wells with a live ISP that carries clones from two or more templates.
To view polyclonal metrics, mouse over the first low quality portion (gray) of the Final Reads
bar plot.
Final Reads 58.39% (3 Filtered out 41.61%
30,735,120
Final Reads(30,735,120) / Wells with Library 5P5|:52,635,12i1-% Polyclonal: 15935106 (30.27%) |
Low Quality Loaded wells with a low or unrecognizable signal.
To view polyclonal metrics, mouse over the second low quality portion (gray) of the Final
Reads bar plot.
Final Reads 58.39% (@ Filtered out 41.61%
30,735,120
Final Reads(30,735,120) / Wells with Library 15Ps(52,635,124) L\} Low Quality: 3208258 (6.13)
Adapter Dimer Loaded wells with a library template of an insert size less than 8 bases.

To view adapter dimer metrics, mouse over the lightest gray portion of the Final Reads bar
plot.

Final Reads 43.57% @ Filtered out 56.44%

52,494,934 s
Adapter Dimer: 10862794 (9.02%)

Final Reads(52,494,934) / Wells with Library ISPs(120,492,758)

Note: In assays using lon AmpliSeq™ HD library chemistry, adapter dimer reads represent a
small proportion of total reads and can be seen by hovering the pointer over the right end of
the Final Reads bar.
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Table 16 Run Report (continued)

Metric

Description

Loading Density

A visual representation of chip loading. Red color indicates areas of higher density of
loading. Blue color indicates areas of lower density of loading. The following example shows
a sequencing experiment where two lanes on the chip are uniformly loaded with ISPs.

Loading Density

Table 17 Run Samples

The Run Samples table lists read data for each individual sample in the assay.

Column

Description

Sample Name

The unique identifier created when the sample was entered in the software.

Nucleic Acid Type The sample nucleic acid type, such as DNA, RNA, or TNA.

Barcode The unique identifiers of the dual barcode pair assigned to the DNA and/or RNA library for
a sample.

Total Reads The total number of filtered and trimmed reads with the listed dual barcodes assigned to

the sample.

Mean Read Length

The average length, in base pairs, of usable library reads for each sample.

=Q20 Bases

The total number of called bases that have =99% accuracy (or less than 1% error rate)
aligned to the reference for the sample.

Mapped Reads

The number of reads that are mapped to the reference file.

On Target Reads

The percentage of sequencing reads mapped to any target region of the reference.

Mean Depth

The average number of reads of all targeted reference bases.

Uniformity

The percentage of bases in all targeted regions (or whole genome) with a depth of
coverage =20% of the mean read coverage.

Read Length Histogram

A histogram that presents all filtered and trimmed library reads that are reported in the
output BAM file (Y-axis) and the mean read length in base pairs (X-axis).

0 50 0o 150 200 250 300
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Table 18 Barcodes with Reads Reported

The Barcodes with Reads Reported table lists barcode-specific metrics

Column Description

Barcode The unique identifiers of the dual barcode pair assigned to the DNA and/or RNA library for a
sample.

Total Reads The total number of filtered and trimmed reads with the listed dual barcodes assigned to the
sample. The reads are independent of length reported in the output BAM file.

Mean Read Length | The average length, in base pairs, of usable library reads for each sample.

=Q20 Bases The total number of called bases that have =99% accuracy (or less than 1% error rate) aligned
to the reference for the sample.

Download information about run samples

Information about each sample in a run, such as the barcode for the sample and the total reads, are
shown in the run samples table. You can download the information shown in the run samples table.

—

In the menu bar, click Results » Run Results.

2. In the Run Results screen, in the Run Name column, click the run name of interest.

w

Click the Run Report tab, then scroll to the Run Samples table.
4. In the upper right corner above the Run Samples table, click Export to Excel.

An XLSX file that contains the information shown in the run samples table is downloaded.

Read length histograms are not included in the file.

Download reads reported by barcodes

Metrics for the barcodes that are included in a run are listed in the barcodes with reads reported table.
You can download the information shown in the barcodes with reads reported table.

—

In the menu bar, click Results » Run Results.
2. In the Run Results screen, in the Run Name column, click the run name of interest.
3. Click the Run Report tab, then scroll to the Barcodes with Reads Reported table.

4. In the upper right corner above the Barcodes with Reads Reported table, click [} Export to
Excel.

An XLSX file that contains the information shown in the barcodes with reads reported table is
downloaded.

Read length histograms are not included in the file.
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View resequencing metrics

For assays that include resequencing, you can view resequencing metrics when a run is complete.

—

In the menu bar, click Results » Run Results.
2. In the Run Results screen, in the Run Name column, click the run name of interest.

3. In Select Assay, select the assay name of interest.
The assay metrics for the sequencing run are shown.

4. Click Resequencing Metrics.

The resequencing assay metrics are shown. For more information, see “Assay metrics and the run
report” on page 118.

Run report

122

The run report includes assay metrics and the record of reagents that were used in a run. For
information about the contents of the run report, see “Assay metrics and the run report” on page 118. If
you entered extraction kit barcodes for samples or control samples when you prepared library batches
or when you planned the run, the extraction kit barcodes are listed in the run report.

View a run report
You can view or download a run report in Genexus™ Software.

For information to download a run report, see “Download a run report” on page 122.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, click the sample name of interest in the Sample Name column.

3. Click the Reports tab.

A pane for the run report and each variant report that has been generated is shown. The name of
the report is listed at the top of the pane.

4. In the Run Report pane, click View Report.
The run report opens in a new browser tab.

Download a run report

You can download a run report summary in PDF format.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, click the sample name of interest.
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3. Click the Reports tab.

Multiple panes including a Run Report pane, a Variant Report pane, and any panes for
customized reports that have been generated are shown.

4. Inthe Run Report pane, click Download Report to download a run report summary in PDF

format.

QC results

The quality control (QC) metrics for each sample that was sequenced in a run are displayed in

Genexus™ Software.

If a sample fails a single test metric, the sample fails that QC test. A sample must meet all QC
parameter thresholds of a particular QC test in order to pass. The QC status is divided into the following

categories.

. (Passed) indicates the sample passed all QC metrics.

* X (Failed) indicates the sample failed a QC metric.

® — (Not Calculated) indicates a sample did not undergo QC analysis.

The data displayed in the screen depend on the assay that was used in the run.

Metricll

Description

Purification QC

Quality control information for nucleic acid extraction that is performed on a
Genexus™ Purification Instrument.

Sample Concentration RNA

The concentration of extracted RNA after purification.

Sample Concentration DNA

The concentration of extracted DNA after purification.

Sample Concentration TNA

The concentration of extracted TNA after purification.

Run QC General run quality control information.

Final Reads Library reads passing all filters that are recorded in the output BAM files. This value
can be different from the total number of reads due to technicalities associated with
read trimming beyond a minimal requirement.

Key Signal The average signal after software processing for library ISPs that identically match

the library key (TCAG).

Key Signal — Resequencing

The average signal after software processing for library ISPs that identically match
the library key (TCAG) for the resequencing run. This metric is only shown for assays
that include resequencing.

Percent Loading

The number of wells with ISPs divided by the number of the total addressable wells
in arun.

Percent Loading -
Resequencing

The number of wells with ISPs divided by the number of the total addressable
wells in the resequencing run. This metric is shown only for assays that include
resequencing.

Raw Read Accuracy

The average raw accuracy across each individual base position in a read, where raw
read accuracy is calculated as 100 * (1 - (sum(per base error)/sum(per base depth))).
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Metricll

Description

Templating QC—CF-1
Control

Sequencing quality metrics of the control fragment. These metrics indicate
templating success.

Average Reads Per Lane

The number of CF-1 reads divided by the number of chip lanes used in the run.

Base Call Accuracy

The probability that a given base is called correctly.

1 — (total number of errors for all positions in CF-1) / (total number of CF-1 base
reads).

Mean AQ20 Read Length
(bp)

Average length, in base pairs, at which the accuracy rate is 299% for CF-1 reads.

Sample QC—DNA

Sequencing quality metrics of the sample DNA library.

MAPD

MAPD (Median of the Absolute values of all Pairwise Differences) is a quality metric
that estimates coverage variability between adjacent amplicons in CNV analyses. A
MAPD value of <0.5 indicates an acceptable level of coverage variability. High MAPD
value typically translates to a lower coverage uniformity. Lower coverage uniformity
can result in missed or erroneous CNV calls. If the MAPD QC threshold is not met,
CNVs are not called. The MAPD metric does not affect SNVs/INDEL calls.

Mapped Reads

The total valid mapped reads.

Mean AQ20 Read Length
(bp)

The average length, in base pairs, at which the accuracy rate is 299% for all aligned
reads of a library.

Mean Read Cov

The number of average reads per amplicon.

Molecular Uniformity

Uniformity of molecular coverage for all amplicons.

Mean Read Length (bp)

The average length, in base pairs, of final library reads for the sample.

Uniformity of Amplicon
Coverage

The percentage of amplicons that had at least 20 percent of the average number
of reads per amplicon. Cumulative coverage is linearly interpolated between nearest
integer read depth counts.

Median Mol Cov

The median number of functional molecule reads per amplicon calculated over all
amplicons in the assay.

This metric is applicable to lon AmpliSeq™ HD library chemistry only.

Uniformity of Base
Coverage

The percentage of reads with a depth of coverage =20% of the mean read coverage
at each position.

This metric is applicable to lon AmpliSeq™ HD library chemistry only.

Read Length Histogram

The histogram presents all filtered and trimmed DNA library reads that are reported
in the output BAM file (Y-axis) and the mean read length in base pairs (X-axis). The
shape of the histogram should closely resemble the library size distribution trace
without the adapter sequences.
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Metricll

Description

Read Ratio for Inline
Controls (Endogenous to
Spike-ins)

The ratio of genomic sample reads to control reads for each inline control amplicon.

Note: The Read Ratio for each inline control amplicon is expected to be
approximately 3 with 10 ng DNA input for both lon AmpliSeg™ and lon AmpliSeq™
HD chemistries.

NTC QC - DNA

DNA Sequencing quality metrics of the no-template control.

Average Base Coverage
Depth

The average number of DNA reads of all targeted reference bases.

Mean Read Length (bp)

The average length, in base pairs, of final DNA library reads for the no template
control.

Read Length Histogram

The histogram presents all filtered and trimmed reads for the no template control that
are reported in the output BAM file (Y-axis) and the mean read length in base pairs
(X-axis).

Read Ratio for Inline
Controls (Endogenous to
Spike-ins)

The ratio of no template control sample reads to control reads for each DNA inline
control amplicon.

[ For BAM to Result runs, only the Sample QC—DNA metrics are shown.

View key findings

You can view the Key Findings for a sample starting from either sample results or run results.

In the menu bar:

¢ Click Results » Sample Results, then click a sample name.

¢ C(Click Results » Run Results, then click a run name to open the Results / Run Results screen. In
the Run Name column, click a run name to open the Results screen, then select a sample from
the Select Sample dropdown list.

Results /| BRCA_GX28_R157494_NA12878_99C_RNO2 ¥ / BRCA SOMATIC DNA514-0.0.4 ¥ / NA12878_R157494_GX28_R01_93C_RN02 ¥

NA12878_R157494_GX28_R01_99C_RNO02

SNVs/Indels Filter

Summary QC v Variants Plugins

Columns ™~

Oncomine BRCA (5.14) * (74 of 81 Variants) Export

Oncomine™ BRCA Assay GX User Guide 125



P2 Chapter 8 Review data and results
View sequencing results

Key Findings

The Key Findings table shows details about the sample, a summary of key metrics for the run, key
variants detected in the sample, and coverage plots for genes assayed in the run.

Note: The Key Findings table is by default the first view that is first shown for sample results.

The information that is displayed depends on the assay that was used in the run.

Table 19 Sample Details

Section

Description

Sample Name

A unique identifier representing the sample.

Collection Date

The date that the sample was collected.

Gender

The biological sex of the sample: Female, Male, or Unknown.

Sample Type

A term that describes the sample, for example, FFPE or DNA.

Application Category

The application type of the sample.

Cancer Type

The type of cancer that is represented by the sample.

Cancer Stage

The stage of the cancer from which the sample was collected.

%Cellularity(']

The percentage of tumor cellularity in the sample. This is a whole number between
1 and 100. The % Cellularity attribute is entered when a sample is created. The attribute is
applicable to FFPE samples only.

' Metric is shown only for some assays.

Table 20 Key Metrics

Section

Description

Target Coveragel'l

Target base coverage
at Nx

The percentage of reference genome bases covered by at least N reads.

Amplicon Summary

Average Base
Coverage Depth

The average number of reads of all targeted reference bases. This is the total number of
base reads on target divided by the number of targeted bases, and therefore includes any
bases that had no coverage.
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Table 20 Key Metrics (continued)
Section Description

Uniformity Of Base The percentage of bases in all targeted regions (or whole genome) with a depth of

Coverage coverage =20% of the mean read coverage. Cumulative coverage is linearly interpolated
between the nearest integer base read depths.

Percent Reads On The percentage of filtered reads that are mapped to any targeted region relative to all

Target reads mapped to the reference. A read is considered on target if at least one aligned
base overlaps at least one target region. If no target regions (file) was specified, this value
will be the percentage of reads passing uniquely mapped and/or non-duplicate filters, or
100% if no filters were specified.

[l Metrics are shown only for analyses that run the coverageAnalysis plugin.

The Key Variants matrix

The Key Variants matrix provides a color-coded visual representation of the variant results. When the
application category of the sample is Solid Tumor or Cancer (Germline) the genes that are shown

in the Key Variants matrix are determined by the filter chain and the gene list applied to the results.

You can change the filters that are applied to expand or restrict the genes that are shown. For more
information, see “View the Key Variants matrix” on page 127. For more information about gene lists, see
the software help system.

Each tile in the Key Variants matrix represents one gene and indicates whether a variant is detected
or not. Note that a single gene is represented with multiple tiles when there are multiple mutations
detected in that gene.

View the Key Variants matrix

The Key Variants matrix provides a color-coded visual representation of the variant results. When the
application category of the sample is Cancer or Cancer (Germline) the genes that are shown in the
Key Variants matrix are determined by the filter chain and the gene list applied to the results. You can
change the filters that are applied to expand or restrict the genes that are shown.

Each tile in the Key Variants matrix represents one gene and indicates whether a variant is detected
or not. Note that a single gene is represented with multiple tiles when there are multiple mutations
detected in that gene.
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You can view a color-coded visual summary of variant results in Genexus™ Software.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name.

The Results screen opens to the Key Findings tab, which shows the Sample Details, Key
Metrics, the Key Variants, and the Coverage Graphs.

3. Refine the genes that are shown in the Key Variants matrix.

Action Procedure
Hide genes that were not Select or deselect the Not Assayed checkbox.
included in an assay but are in

a gene list.

Refine the genes that are shown | . Click Edit Filters.

in the Key Variants matrix.
4 b. To refine or expand the genes, change one or both of the

filters.
* Select a different filter chain or no filter chain.
* Select a different gene list or no gene list.
For more information, see “Search and filter variant results” on
page 139.
c. Click Save.
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510_R165314_F00121397_Rp02  qc Key Findings  Variants Plugins Reports

Sample Details

Sample Name Collection Date Gender Sample Type pplication Category Cancer Type Cancer Stage Cellularity

510_R165314_FO0121397_Rp02 O JUN 2022 Unknown FFPE Solid Tumor Unknown Primary Origin Unknawn NjA
Key Metrics

Target Coverage Amplicon Summary
rget b B A rage Dept Uniformity Of Base Coverage Percent Reads on Targe

100.00% 99.81% 2999 97.72% 98.23%

Key Variants

§ ] [ E— ] [ 2 :] - Oncomine Extended (6.8) filter chain and No gene listapplied 42 10

BRCAL CNY BRCAL cNY BRCAZ CNY BRCA2 chy BRCAZ SNVjIndel
BRCA1 exon 8 deletion BRCA1 exon 22 deletior BRCAZ exon 9 deletion BRCAZ exon 3 duplication BRCAZ K284911s°15
AA Change: p.Lys284oilefsTer1s

Allele Frequency: 0.8507

Example Key Variants matrix

(1) Color coded legend to the variant tile matrix.

Key Variants Detected —A gene is present in the gene list, variants are called by the Oncomine™ Variant Annotator
plugin, and the variants are Key Variants. Genes that are called are listed in the Variants tab with Present in the
Call column. Key Variants are listed in the Variants tab, with a value of Yes in the Key Variant column. For more
information about gene lists, see the software help system.

Other Variants Detected —A gene is present in the gene list and variants are called by the Oncomine™ Variant
Annotator plugin, but the variants are not Key Variants. Genes that are called are listed in the Variants tab with
Present in the Call column. Variants that are not Key Variants are listed in the Variants tab, with a value of No in the
Key Variant column.

None Detected —A gene is present in the gene list but no variants are called by the Oncomine™ Variant Annotator
plugin.
Not assayed —A gene is present in the gene list, but is not included in the panel used in the assay.

@ Edit filters —Allows you to select an available filter chain and gene list. Changes of the filter chain or gene list change
the genes that appear in the Key Variants matrix.

@ Variant Name —The name of the variant. The Variant Name is a hyperlink to the pileup for the variant in the
Variants tab.
Gene tiles in the Key Variants matrix

Each blue tile in the Key Variants matrix represents a variant and summarizes information for the
variant.

P

BRCA1 smwmdell—@

@——AA Change: p.Asn1029ArgfsTers

@——Allel-le Frequency: 0.271

®

@ The gene name.

@ The Variant Name - link to the variant details in the Variants tab.

@ The amino acid change using Human Genome Variation Society (HGVS) nomenclature.

@ The number of variant read counts divided by the total number of read counts for the sample.
@ The variant type.
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View the amplicon coverage

You can view DNA exon amplicon coverage in Genexus™ Software to help you determine whether

the sequencing reads across a gene are uniform and sufficient. The default genes that are shown are
determined by the gene list that is designated as default for the cancer type of the sample. You can also
view amplicon coverage graphs for more genes. These amplicon coverage graphs provide a high-level
overview of coverage. More detailed coverage information is also available in the software.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name to open the Key Findings tab in the Results screen.
3. Scroll to the amplicon Coverage Graphs.

4. Review the coverage graphs.

5. To show coverage graphs for more genes, scroll to the bottom of the screen. Click Show
Coverage for Gene, then select the gene of interest.

6. You can adjust the amplicon coverage graph with the pointer and the buttons in the upper right
corner of each graph. The coverage graphs change to show coverage for the selected gene.

Action Procedure
Zoom in on a region of interest. Click @ one or multiple times.
Zoom out for an expanded view. Click @ one or multiple times.
Revert to the default view. ¢ (Click @ one or multiple times.
¢ (Click Reset.
Move the image left or right in the screen. | After you zoom in, click-drag at any position in the image.
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Example amplicon coverage graph

Here is an example of an amplicon coverage graph for the BRCA gene.
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@ Base coverage is shown on the y-axis on a logarithmic scale.
@ The location of the known hotspots are denoted with gray bars.

@ The location and span of the amplicons are represented with orange bars. You can hover the mouse over an orange

bar to view the amplicon name.

@ The location and span of the transcript track is denoted with green bars. You can hover the mouse over the green bar

to view the exon number.

@ The line along the x-axis is broken to indicate that the graph is discontinuous to show exons.

(®) The genome coordinate position is shown on the x-axis.

@ Called variants are indicated with a vertical line above the blue coverage plot. The variants noted in the graph depend
on the filter chain applied to the results in the Key Variants matrix. For more information, see “The Key Variants

matrix” on page 127.

You can place the pointer over the hotspots that are represented with gray lines to view the hotspot name.

You can zoom into or out of, or reset, the graph. For more information, see “View the amplicon coverage” on page 130.

View SNV/INDEL results

You can view the SNVs/Indels results for a sample. The SNVs/Indels table lists the calls and other

information for the SNV and INDEL variants that are analyzed in each sample in a run.

1. In the menu bar, click Results » Sample Results.
2. Click a sample name to open the Results screen.

3. Click the Variants tab.
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4. Click SNVs/Indels to view the SNVs/Indels table.
For more information about the data displayed in the table, see “SNVs/Indels table” on page 132.

5. (Optional) Click Export in the upper right corner of the screen to export the results data in XLS or
TSV format, if needed.

The information that is included in the file is based on the gene list, the filters that are applied to
each column, and filter chain that is applied

* The file in XLS format contains the information that is shown in the SNV/Indels variant table.

* The file in in tab-separated value format (TSV) format contains the information that is shown
in the SNV/Indels variant table, and information for table columns that are available but not
currently shown in the SNV/Indels table. The file also includes information that is listed in the
Annotations table.

SNVs/Indels table

The data displayed in the table depend on the assay that was used in the run. Results in the table
can be filtered using the filtering tools. For more information, see “Search and filter variant results” on

page 139.

Column

Description

User Classifications

User-defined classification to selected from the list.

For more information, see Genexus™ Software Help.

Variant ID

The name of the hotspot as defined in the Browser Extensible Data (BED) file.

Click the link to view more annotation information.

Variant Name

The name of the variant.

Key Variant Indicates whether or not the variant is a key variant.
Possible values are Yes or No.
This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Locus The chromosome and position of the detected variant.

Oncomine Variant
Class

The type of SNV or INDEL at the locus based on Oncomine™ annotations.
* LongDel — A 40-bp deletion in BRCA1 called by the end-point detection method.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Oncomine Gene
Class

The change in molecular function of the altered gene product due to the mutation, based
on Oncomine™ annotations:

* |oss-of-function — the altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.
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Column

Description

Gene

The gene name. Click the link to open the View Annotation Sources window to view
additional information. For more information, see Genexus™ Software Help.

AA Change

Identification of the amino acid change using Human Genome Variation Society (HGVS)
nomenclature.

Ref

The reference base or bases at that locus.

Alt

The alternate base or bases at that locus (A, G, C, T).

Type

The type of variant that is detected.
* snp (single nucleotide polymorphism)
*  mnp (multi-nucleotide polymorphism)
* ins (insertion)
® del (deletion)

e complex

Call

Indicates the presence or absence of an SNV/Indel variant. When the default filter chain

is applied, only the variant calls that are designated with PRESENT (HOMOZYGOUS) or
PRESENT (HETEROZYGOUS) are displayed in the results table. To view all calls, including
calls that do not pass the required filter thresholds, apply the No Filter option or download
the Variants (.vcf) file (see “Results files” on page 142).

e PRESENT (HOMOZYGOUS) or PRESENT (HETEROZYGOUS)—Indicates a high
confidence call that passes all filter thresholds at a given variant position.
—  When the default filter chain is applied, PRESENT (HOMOZYGOUS) or PRESENT
(HETEROZYGOUS) indicates the presence of the ALT (alternative) allele.

— When the No Filter option is applied or when viewing the Variants (.vcf) file,
Present does not imply the presence of the ALT (alternative) allele. To infer the
presence of the ALT allele, refer to the Alt column.

* NO CALL—While some evidence for the presence of a variant exists, the call does not
pass one or more filters that are required for a high confidence variant call.

* ABSENT —Indicates the presence of a variant that differs from the reference allele at
a given position, however, this nucleotide is not an ALT allele that is targeted by this
assay.

Call Details

The reason why a variant is reported as No Call.

Effective Read Depth

The number of reads covering the position.

Alt Allele Read Count

The number of reads containing the alternate allele.

Nuc Change

The position and identity of the nucleic acid change.

Allele Fraction

The number of variant read counts divided by the total number of read counts for the
sample.

Allele Frequency (%)

The allele frequency, represented as a percentage.
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View CNV results

You can view the CNVs results for a sample. The CNVs table lists the calls and other information for the
copy number variants (CNVs) analyzed in each sample in a run.

1. In the menu bar, click Results » Sample Results.
2. Click a sample name to open the Results screen.
3. Click the Variants tab.

4. Click CNVs to view the CNVs table.
For more information about the data displayed in the table, see “CNVs table” on page 134.

5. (Optional) Click Export in the upper right corner of the screen to export the results data in XLS or
TSV format, if needed.
The information that is included in the file is based on the gene list, the filters that are applied to
each column, and filter chain that is applied

* The file in XLS format contains the information that is shown in the SNV/Indels variant table.

* The file in tab-separated value (TSV) format contains the information that is shown in
the SNV/Indels variant table, and information for table columns that are available but not
currently shown in the SNV/Indels table. The file also includes information that is listed in the
Annotations table.

CNVs table

The data displayed in the table depend on the assay that was used in the run. Results in the table
can be filtered using the filtering tools. For more information, see “Search and filter variant results” on
page 139.

IMPORTANT! (FFPE samples only) If % Cellularity value for a sample is set to <100, then the
magnitude of copy number gain or loss can be decreased. For more information, see the software help
system.

Column Description

User Classifications | A user-defined classification selected from the list.

For more information, see the software help system.

Key Variant Indicates whether the variant is a key variant.
Possible values are Yes or No.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Variant Name The name of the variant.

Locus The starting position of the first amplicon covering the CNV gene.
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Column

Description

Oncomine Variant
Class

Annotates gene-level and exon-level CNV deletions and duplications.

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Oncomine Gene
Class

The change in molecular function of the altered gene product due to the mutation, based on
the following type of Oncomine™ annotations.

* Loss-of-function — the altered gene product lacks the molecular function of the wild-
type gene

This information is available if the Apply Oncomine Variant Annotations checkbox is
selected in the assay used in the run.

Gene The gene name, which provides a link to the View Annotation Sources dialog box with
additional information about the HotSpot ID.
For more information, see the software help system.

Copy Number The copy number of a CNV gene locus per genome. This column is available when a
positive call is made.

Type Indicates variant type, such as CNV or NA (non-CNV).

Subtype Indicates variant subtype.

* REF - Read count matches reference baseline.

* NO CALL - Read count differs from baseline by non-integer amount; evidence for a
BigDel or BigDup call is weak.

* BigDel - deletion of at least one exon, or multiple exons.
¢ BigDup - Duplication of at least one exon, or multiple exons.
* GeneCNV - whole BRCA1/BRCA2 gene deletion or duplication.

Note: You can use the visualizations in the software to confirm deletions and
duplications. Use the post-corrected visualization to confirm exon deletions and
duplications.

Whole gene deletion or duplication results can be confirmed only in the precorrected
view. That is, if a BRCA1 deletion or duplication (BRCA1DEL or BRCA1DUP) or a
BRCA2 deletion or duplication (BRCA2DELor BRCA2DUP) for a GeneCNV subtype is
shown in the Call Details of the CNV variants table, review the visualization to verify

the direction of the GeneCNV subtype. Click Pre-corrected and Compare the SamplelD
(sid) amplicons to the BRCA1 or BRCA2 genes.
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Column Description
Call Details Indicates exon number or exon region for exon-level CNV calls or GeneCNV subtype
(BRCA1Del and BRCA2Del) and the following calls:
¢ BRCA1Del
e BRCA2Del
¢ BRCA1Dup
¢ BRCA2Dup
e BRCA1INC
¢ BRCA2NC (for NOCALL)
Call Indicates the presence or absence of a CNV. When the default filter chain is applied, only
the CNV-positive calls that are designated with PRESENT are displayed in the results table.
To view all calls, including calls that do not pass the required filter thresholds, apply the No
Filter option or download the Variants (.vcf) file (see “Results files” on page 142).
* PRESENT - indicates a high confidence call that passes all filter thresholds.
* PRESENT (GAIN) — a CNV-positive call that indicates gene amplification; a high
confidence variant call that passes all filter thresholds.
* PRESENT (LOSS) - a CNV-positive call that indicates gene deletion; a high confidence
variant call that passes all filter thresholds.
e ABSENT - the absence of a variant; result is below detection threshold for a CNV call.
®* NO CALL- while some evidence for the presence of a variant exists, the call does not
pass one or more filters that are required for a high confidence variant call.
P-Value The statistical significance of the CNV ratio measurement.

No Call Reason

The reason for reporting a CNV as No Call.

CNV Confidence For BRCA Exon CNV and GeneCNV calls, the CNV Confidence is a Phred-scale score
corresponding to the quality of the CNV call. The 95% upper confidence bound is the ploidy
estimate, where it is 95% certain that the true ploidy is below that value.

Variant ID The name of the hotspot as defined in the BED file.

CNV Ratio The ratio of measured CNV gene locus coverage relative to coverage of non-CNV loci.

Med Read Cov Gene

The median read coverage of targeted CNV gene.

Med Read Cov Ref

The median read coverage of non-CNV reference loci.

Valid CNV Amplicons

The valid number of amplicons spanning the CNV call that pass internal QC. This number
can vary in each run, depending on the quality of the data.
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Visualize exon and whole gene CNVs

In Genexus™ Software, you can visualize read counts of BRCA1 and BRCA2 exons that are normalized
to the Oncomine™ BRCA DNA baseline.

1. In the menu bar, click Results » Sample Results, then in the Sample name column, click the
name of the sample of interest.

2. In the Variants tab, click CNVs to open the CNV results screen.

3. Click Visualization » Exon CNV to visualize exon read _
counts. | Columns ~

x

A plot opens with Normalized Read Counts in log2 scale Exon CNV
for each exon CNV that is detected. @
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Figure 1 Exon-level deletion detected with Oncomine™ BRCA Assay GX.

@ Menu bar that shows the selected results, the assay, and the sample name.
(2) CNVs selection shows the CNV results screen.
@ Toggle selection for Pre-corrected and Post-Corrected plot views.
e Pre-corrected plot shows amplicon coverage data normalized to total reads in a sample.

¢ Post-corrected plot shows amplicon coverage after applying GC-content, amplicon length, and principal
components analysis corrections to the log2 ratios.

@ Scale values of -6 to +2 or -2 to +2, to zoom out or zoom in on the plot.
@ This example shows an exon-level deletion. Exons 14 and 15 are deleted in this example.
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You can use the visualizations in the software to confirm deletions and duplications.

@—T)'pe. PraComected | PostCorracted

Use the post-corrected visualization to confirm exon deletions and duplications. For example, if a
BRCA1 deletion (BRCA1DEL) or a BRCA2 deletion (BRCA2DEL) for a GeneCNV subtype is shown
in the Call Details of the CNV results table, review the visualization to verify the deletion of the gene.
Click Pre-corrected and Compare the SamplelD (sid) amplicons to the BRCA1 genes.

Use the pre-corrected view to confirm whole gene deletion or duplication results. If a BRCA1

deletion (BRCA1DEL) for a GeneCNV subtype is shown in the Call Details of the CNV variants
table, review the visualization to verify the deletion of the gene. Click Pre-corrected and Compare

the SamplelD (sid) amplicons to the BRCA1 genes.

Note: Whole gene deletions and duplications can be confirmed only in the pre-corrected view.
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Figure 2 Verification of duplications with the Oncomine™ BRCA Assay GX.

@ Pre-corrected selection.

@ The location of the SamplelD (sid) amplicons show information about BRCA1 and BRCA2 genes.
@ BRCAT1 genes

(4 BRCA2 genes

@ SamplelD (sid) amplicons

In this example, a BRCA2 duplication can be verified because the sid amplicons are aligned with the BRCA1 genes in the
visualization. Therefore the BRCA1 gene is normal, the sid amplicons are normal and the BRCA2 gene is a duplication.
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Search and filter variant results

You can search and filter to narrow the list of results that are shown in the variant tables. You can
apply filters to columns of information that appear in the screen. The filters, available at the top of each
column, narrow the list of information in any columns to which filters are applied.

For more information, see the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or the
software help system.

1. In the menu bar, click Results » Sample Results.

2. Click a sample name in the Sample Name column.

3. In the Results screen, click the Variants tab.

4. Select the variant class to display the results: SNVs/Indels, Fusions, or CNVs.

5. In the table of variants, in the column heading of
interest, click'Y (Filter).

* |n the search field, enter at least 3 characters, then
click Filter.

* Select the checkbox in the row of each filter that
you want to apply, then click Filter.

Oncomine Variants (S.16) Filt

The options that are available depend on the column e [

and variant class. For example, you can filter data in
the Type column to show one specific variant type.

6. Click {x] Clear Filters to remove all filters and view the full list of run results.

The column or columns to which you applied a filter change to reflect the filter and selected options.
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System-installed filter chains

The following Genexus™ Software system-installed filter chains are available for use with the
Oncomine™ BRCA Assay GX results.

Note: System-installed filter chains are locked and cannot be changed.

System-installed

filter chain Description

Oncomine™ Variants | This filter chain is recommended for use with the Oncomine™ BRCA - GX5 Germline
(6.8) - DNA) Assay. The filter chain reports only Oncomine™-annotated variants.

Oncomine Extended | This filter chain is recommended for use with the Oncomine™ BRCA - GX5 Somatic
(6.8) - DNA) Assay. The filter chain reports all Oncomine™-annotated variants and variants
that can be relevant to cancer due to their inclusion in one or more of the following
classes:

®* CNV variants with FILTER value of GAIN or LOSS.

* Likely somatic mutations based on dbSNP, 5000Exomes, EXAC, and UCSC
Common SNPs annotation source databases. The minor allele frequencies
range lies between 0.0 and 1.0E-6. Mutations must also be nonsynonymous
and occur in exonic or splice-site regions.

¢ Variants with ClinVar annotations of pathogenic or likely pathogenic.

Oncomine™ BRCA Filter chain to filter out non-BRCA1 and non-BRCA2 genes.
(6.8)

No Filter Select this filter chain to remove a previously applied filter chain and view all called
variants.

Review plugin results in Genexus™ Software

140

In Genexus™ Software, you can review plugin results in the Results screen for a sample.
Each plugin that was selected for an assay during assay creation is listed in the Plugins tab.

Results / [Runname] v / [Assay name] v /[Sample name] ¥

[Sample name] QC v Key Findings Variants Plugins Reports

Review coverageAnalysis plugin results

The coverageAnalysis plugin generates a Coverage Analysis Report. This report includes read statistics
and several charts. The statistics and charts that are presented depend on the library type for the
analysis.

The report summary lists the barcode, the sample, the number of mapped reads, the percentage of on
target reads, mean base coverage depth, and base coverage uniformity. Microsoft™ Excel™-compatible
reports are also generated, including differential expression tables. Additional details regarding read
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coverage are also provided on a per-barcode basis, along with a list of gene annotations for each
sequenced region.

You can download coverageAnalysis plugin output files from the Results screen for a sample. For
more information, see “Results files” on page 142 and “Output files generated by the coverageAnalysis
plugin” on page 161.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, click the sample of interest.

3. Click the Plugins tab.
A summary table of the coverage analysis, by barcode, is included in the coverageAnalysis
summary pane.

4. (Optional) From the Executed At dropdown list, select an alternate timestamp, if available, to view
additional reports.

5. (Optional) Click 3 View Log to view the coverageAnalysis log.

6. (Optional) Click Ti] Delete to delete the coverageAnalysis plugin output for the selected timestamp.

IMPORTANT! If you click [i] Delete, the report is deleted without the appearance of confirmation

dialog window. Ensure that you intend to delete the report before clicking [i] Delete.

7. Click - (More) » Download Files to download coverageAnalysis plugin results files.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™
Excel™. To resolve this problem, right-click the file and click Save As to rename the downloaded
file.

8. In the coverageAnalysis summary pane, in the Barcode Name column, click the link in the row of
the barcode of interest.
The detailed Coverage Analysis Report for the barcode opens in a separate window.

Review samplelD plugin results in Genexus™ Software

Use the samplelD plugin to track samples and identify misassignment or possible mix up between
samples and barcodes in a sequencing run. The samplelD plugin produces a unique identification code
(SamplelD) for each barcode.

The samplelD plugin is preconfigured and does not require input. For more information about the
samplelD plugin, see the software help system, or the Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409).

After the sequencing run completes, review the plugin results.

1. In the menu bar, click Results » Sample Results.

2. In the Sample Results screen, in the Sample Name column, click the sample of interest.
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3. Click the Plugins tab.

A summary table of the samplelD results is shown.

4. Click a barcode name to open the Sample ID Report.

5. To return to Genexus™ Software, click back in the browser.

Results files

The following files can be downloaded from the View Results screen for each sample. The files that
are available for download vary depending on the assay used. For lists and descriptions of plugin
output files, see “Output files generated by the coverageAnalysis plugin” on page 161 and “Output files
generated by the samplelD plugin” on page 165.

To download the files, click Results » Sample Results, then click a sample name in the Sample
Name column. In the Results screen, click --- (More Options) » Download Files. In the Download
Files dialog box, select the files to download, then click Download. The selected results files are
downloaded in one ZIP folder.

Selection

File name

Description

Variants

Filtered Variants
(.vcf)

<Sample name> <LibPrepID>
_filtered.vct

Summary of filtered variant results in
variant call format (VCF). The variants
that are included in the VCF file depend
on the filter chain that is applied to the
sample results. For more information, see
Genexus™ Software Help.

All Variants (.vcf)

<Sample name> <LibPrepID>
<analysisID>.vcf

Summary of variant results in variant call
format (VCF).

All Variants (.tsv)

<Sample name> <LibPrepID>
<analysisID>.tsv

The file in TSV format contains the
information that is shown in the variants
table in tab-separated value format (TSV).
The information that is included in the

file is based on the gene list and filter

chain that are applied. In addition to the
information shown in the variants table, the
file includes information for the columns
that are available, but are not selected. The
file also includes information that is listed in
the Annotations table.

Variant Summary
(.tsv)

Summary.tsv

File that lists SNV/INDEL and copy number
results in tab-separated value format (TSV).

Snvs/Indels (.tsv)

Snvindel.tsv

File that lists SNV/INDEL variant results in
tab-separated value format (TSV).

CNV (.tsv) Cnv.tsv File that lists copy number variant results in
tab-separated value format (TSV).
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Selection

File name

Description

Pre-Corrected / -6
to +2 (.png)

boxplot before renorm.png

Visualization of pre-corrected BRCA plot.
The portable network graphic (PNG) image
shows amplicon coverage data normalized
to total reads in a sample with scale values
of -6 to +2.

Pre-Corrected / -2
to +2 (.png)

boxplot before renorm alt.png

Visualization of pre-corrected BRCA plot.
The portable network graphic (PNG) image
shows amplicon coverage data normalized
to total reads in a sample with scale values
of -2 to +2.

Post-Corrected / -6
to +2 (.png)

boxplot after vcib.png

Visualization of post-corrected BRCA plot.
The portable network graphic (PNG) image
shows amplicon coverage data normalized
to total reads in a sample with scale values
of -6 to +2.

Post-Corrected / -2

boxplot after vcib alt.png

Visualization of post-corrected BRCA plot.

to +2 (.png) The portable network graphic (PNG) image
shows amplicon coverage data normalized
to total reads in a sample with scale values
of -2 to +2.

Reports

Lab Report(s)

<language> <samplename> AD
<reporttemplatename> <date>.pdf

A PDF report that contains sample-specific
results. For more information, see “Variant
report” on page 115.

Sample Summaryl'!

Info.csv

Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics,
and instrument summary.

Sequencing results

DNA Unmapped
Bam File (.bam)

<barcode> rawlib.basecaller.bam

Unmapped DNA barcode BAM file; output
after mapping reads to reference.

DNA mapped bam
file (.bam)

merged.bam

Mapped BAM file of combined barcode
reads.

DNA Mapped Bam
Index File (.bai)

merged.bam.bai

Mapped BAM Index file.

DNA Basecaller
FASTAQ File (.fastq)

<barcode> rawlib.basecaller.fastq

FASTQ file of the DNA barcodes used.
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Selection File name Description
DNA Processed merged.bam.ptrim.bam Mapped BAM file of combined barcode
Bam File reads.

DNA Processed
Bam Index

merged.bam.ptrim.bam.bai

Mapped BAM index file.

Test Fragment
Basecaller FASTAQ
File (.fastq)

rawtf.basecaller.fastqg

FASTQ file for the test fragment.

Coverage Analysis

DNA Unmapped
Bam File (.bam)

<barcode> rawlib.basecaller.bam

Unmapped DNA barcode BAM file; output
after mapping reads to reference.

DNA Coverage
Statistics

<DNA Barcode><ExpName>
.stats.cov.txt

A summary of the statistics presented in
the tables at the top of the plugin report.
The first line is the title. Each subsequent
line is either blank or a particular statistic
title followed by a colon (;) and its value.

DNA Chromosome
base coverage
summary

<DNA Barcode><ExpName>.chr.cov.xls

Base reads per chromosome summary
data that is used to create the default view
of the Reference Coverage Chart.

DNA Base depth of
coverage

<DNA Barcode><ExpName>
.base.cov.xls

Coverage summary data used to create the
Depth of Coverage Chart.

DNA Amplicon
coverage summary

DNA Coverage Statistics <DNA
Barcode><ExpName>.amplicon.cov.xls

Coverage summary data used to create the
Amplicon Coverage Chart.

DNA Coverage
Analysis Summary

(.pdf)

DNA Coverage Statistics <DNA
Barcode><ExpName>.summary.pdf

A PDF file that contains the Coverage
Analysis Report, including read statistics
and charts that are generated by the
coverageAnalysis plugin.

Audit and Log

Analysis Log File

analysis.log

Analysis log file.

Run Audit

PlannedRun-AuditTrail.pdf

Contains all audit records pertaining to the
run.

Troubleshooting Files

Log Files(? analysis.log Analysis log file.
summary.<timestamp>.log Start and end time for each time an assay
module is executed for the analysis.
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Selection File name Description
Log Filesl? Info.csv Contains information about the run and
analysis, including software version details,
sample details, library details, run details,
assay details, reagent and consumable
information, run and sample QC metrics,
and instrument summary.
PlannedRun-AuditTrail.pdf Contains the audit trail of the run plan in
PDF format.
various.err Analysis pipeline logs used by field service
. engineers for troubleshooting.
various.out
Other analysis.ini Analysis configuration files, including
analysisSamples.json secondary and tertiary INI files.
VCF Files analysis.vct Summary of variant results in variant call

SmallVariants.vct

SmallVariants.filtered.vct

format (VCF).

Summary of all results for small variant in
variant call format (VCF).

Summary of filtered results for small variant
in variant call format (VCF).

[ Files are available for both custom and system installed assays in Genexus™ Software version 6.8.
[l Separate folders are generated for each sample. If included in the run, separate folders are also generated for an NTC and positive control.

Sign off variant reports

Manager, administrator, and report-level users can electronically sign a variant report for sample results
in Genexus™ Software. A sample result can have multiple variant reports only if each report uses

a different report template, and a different language. However, only one of the reports can include
electronic signatures.

IMPORTANT! If you use the same template and language to regenerate an existing report, the existing
report will be overwritten.

Multiple signatures can be added to the variant report that is used for sign-offs. Account permissions
for electronic signatures are associated with a signature type. A lock-level signature type locks the
report. If your signature permissions are associated with a lock-level signature type and you sign the
report, you will be the last person to sign the report before it is locked.

The filter chain that is applied to the results must be locked before you can electronically sign a variant
report. After users begin to electronic sign-offs, changes cannot be made to the filter chain, gene list, or
classification, and plugins cannot be run for the sample results.
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Chapter 8 Review data and results
Sign off variant reports

The signature information appears in the variant report PDF file or a user-created report, if selected.
For more information, see “Variant report” on page 115. For information about how to create a report
template, see the software help system, or the Genexus™ Software 6.8 User Guide.

Multilanguage support for PDF report generation is provided.

This feature allows you to meet Title 21 CFR Part 11 of Federal Regulations that establishes the
United States Food and Drug Administration regulations on electronic records and signatures, password
policies, and user activity auditing.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, click the sample result of interest in the Sample Name column.

3. In the Reports tab, in a variant report pane that is labeled as Draft, click Sign Off.
The Sign Off Report dialog box opens and shows the name of the report, the template used for
the report, and the following information, which is based on the profile of the user who signs the
report.

* Electronic Signature
* User Name
* Language

4. |n Password, enter the password.
5. In Sign Off Comments, enter a comment.

6. In Footer Field, enter any text that you want to appear in the footer of the PDF report pages.

If you entered footer information in the Footer Field when you created a report template, or if
text was entered during a previous sign off, the same footer information is shown in the Sign Off
Report dialog box. You can edit the text in the Footer Field to change the information that will be
shown in the footer of the PDF report.

7. Select an image to an include with the electronic signature, and enter a description and footnote
for the image, if needed.

Only one image can be added when a report is signed off. If an image was previously added, the
option to add an image is not available.

8. Click Sign Off to confirm the electronic signature.
The pane for the signed variant report is updated to include the signature information for the
variant report. If the electronic signature that is associated with a lock-level signature type is used,
a A (Lock) is shown in the variant report pane and the report is locked.

The report is signed. The Electronic Signatures section of the report pane is updated to include your
username and the signature type for your account. You can hover over the signature type to show the
list of signature types that are completed for the report. If multiple electronic signatures are added to
the report, an electronic signature type for each signer is shown in the Electronic Signatures column of
the sample results table. For more information, see the software help system, or the Genexus™ Software
6.8 User Guide.
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Sign off variant reports

If a signature type used is designated to lock the report, the variant report is signed and locked, and no
other variant reports for the sample result can be signed or generated. If you must change the report,
reanalyze the sample and generate a report for the reanalyzed sample.

You can send notifications for report sign-offs to other users. For more information, see the software
help system, or the Genexus™ Software 6.8 User Guide.
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Oncomine™ BRCA Assay GX

Observation

Possible cause

Recommended action

Sample QC failed

Details: X (Failed) appears
in the QC Status column in
the Results / Sample Results
screen and the QC tab in the
Results screen for a sample.

The concentration of a
nucleic acid sample was
overestimated, resulting in
under-seeding of the target
amplification reaction and low
library yield.

Quantify nucleic acid samples using one

of the recommended quantification methods
listed in “Recommended materials for
nucleic acid isolation, quantification, and
quality control” on page 16. Do NOT use
densitometry methods (such as NanoDrop™
spectrophotometer) for quantifying nucleic
acid samples.

Genexus™ Integrated Sequencer—general and QC

troubleshooting

Observation

Possible cause

Recommended action

A consumable is not
recognized by the sequencer
after loading on the deck

The consumable (for example,
a strip, pipette tip box) is
correctly placed but is not
completely inserted into its
position, causing it to be
misaligned with its expected
position.

Ensure that the consumable is pressed
completely into place. Apply firm pressure on
the item so that it fits snugly into its deck
position.

The barcode of the
consumabile is not readable by
the instrument.

Tap Help in the lower left corner of the

Load Instrument screen and follow on-screen
instructions to override the block manually.
Note that the name of the consumable does
not appear in the list of consumables in the
run summary.

If the behavior continues in subsequent runs,
contact Technical Support.
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Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

A consumable is not
recognized by the sequencer
after loading on the deck
(continued)

Consumable version does

not match the Genexus™
Software version. For example,
a consumable compatible

with Genexus™ Software 6.6

is installed in a sequencer
updated for Genexus™
Software 6.8.

Ensure that you are using consumables
compatible with the software installed on the
sequencer.

Run Status = Failed

Details: In the Genexus™
Software Run Result screen,
the Run Status for a
completed run is listed as
"Failed". In the Sample
Results screen, the Sample
Status is listed as
"BaseCallingActor FAILED".

Chip calibration failed due to a
chip problem, or an instrument
problem.

Repeat the run with a new chip. If the problem
persists, contact Technical Support.

A lane that has been used
is not crossed out in the
sequencer screen

Details: After completion of a
run, the lane used in the run
was not crossed out, so that
the next run could reuse the
lane.

A chip problem caused a
datacollect failure to read
efuse.

In the sequencer screen, tap Settings » Clean
instrument to perform a clean

instrument. For details, see "Perform

a Clean instrument procedure" in the
Genexus™ Integrated Sequencer User Guide
(Pub. No. MANO017910). After cleaning, start a
new run.

The number of sample reads
is low, CF-1 metrics pass QC,
but read ratio of inline controls
is low.

Details: If CF-1 reads per lane,
accuracy, and mean AQ20
read length are good, and
read ratio of inline controls
(endogenous vs. spike-in) is
low (<< 3), a problem with
sample input is indicated.
For more information,

see “Troubleshoot Genexus™
Integrated Sequencer
performance with CF-1 and
inline controls” on page 152.

Nucleic acid input may have
been insufficient, and/or the
nucleic acid was degraded.

For a sample run, re-quantify nucleic acid
samples and/or perform sample QC to ensure
that the expected nucleic acid input and size
was loaded.

If needed, re-isolate and purify nucleic acid
samples.
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Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

The number of sample reads
is low, but CF-1 metrics pass
QC, and read ratio of inline
controls is normal

Details: If CF-1 metrics
passed QC, and read ratio of
inline controls is normal (~ 3),
a problem in library preparation
unrelated to sample input

or quality may be indicated.
For more information,

see “Troubleshoot Genexus™
Integrated Sequencer
performance with CF-1 and
inline controls” on page 152.

One or more of the Genexus™
Strip 1 strips used in the run
had magnetic beads trapped in
the tube 5 keyhole.

Repeat the run with strips that you have
verified have no trapped beads. For more
information, see Chapter 3, “Before you
begin”.

An incorrect assay was
selected for the run, or library
amplification parameters were
not optimal.

Ensure that you have selected the correct
assay and reviewed assay parameters.

Library strips were
inadequately equilibrated to
room temperature (Genexus™
Strip 1), or incompletely
thawed (Genexus™ Strip 2-AS
or Genexus™ Strip 2-HD)
before loading in the
sequencer.

Ensure that Genexus™ Strip 1 strips are
fully equilibrated to room temperature, and
Genexus™ Strip 2-AS strips are completely
thawed before loading in the sequencer.

The number of sample reads is
low, and CF-1 metrics fail QC

Details: If CF-1 metrics failed
QC, a problem in templating
or sequencing is indicated.
For more information,

see “Troubleshoot Genexus™
Integrated Sequencer
performance with CF-1 and
inline controls” on page 152.

One or more of the Genexus™
Strip 3-GX5™ strips used in
the run may have had an
excessive amount of magnetic
beads trapped in the tube 6 or
7 keyhole.

Repeat the run with strips that you have
verified have no trapped beads. For more
information, see Chapter 3, “Before you
begin”.

Template strips were
inadequately equilibrated to
room temperature (Genexus™
Strip 3-GX5™), or incompletely
thawed (Genexus™ Strip 4)
before loading in the
sequencer.

Ensure that Genexus™ Strip 3-GX5™ strips
are fully equilibrated to room temperature,
and Genexus™ Strip 4 strips are completely
thawed before loading in the sequencer.

The sequencing chip or
coupler was defective or leaky.

Repeat the run with new chip and coupler. If
low performance continues, contact Technical
Support.
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Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

The number of sample reads is
low, and CF-1 metrics fail QC

Details: If CF-1 metrics failed
QC, a problem in templating
or sequencing is indicated.
For more information,

see “Troubleshoot Genexus™
Integrated Sequencer
performance with CF-1 and
inline controls” on page 152.

(continued)

The run was started >14 days
after the last initialization was
performed, or on an expired
initialization.

Perform a Clean instrument procedure
(Settings » Clean instrument). For more
information, see "Perform a Clean

instrument procedure" in the Genexus™
Integrated Sequencer User Guide

(Pub. No. MANO017910). After the Clean
instrument procedure, install new a chip, and
new sequencing reagent bottles and cartridge
in the sequencing reagents bay, then repeat
the run.

Note: Reagents are stable on the sequencer
for 14 days, after which you may experience
decreased performance. For more information,
see Appendix A: Troubleshooting in the
Genexus™ Integrated Sequencer User Guide
(Pub. No. MANO017910).
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Troubleshoot Genexus™ Integrated Sequencer performance with CF-1 and inline controls

Troubleshoot Genexus™ Integrated Sequencer performance
with CF-1 and inline controls

You can use quality control results to troubleshoot Genexus™ Integrated Sequencer runs to help identify
the cause of performance problems. If you select the Include Inline Controls checkboxes for DNA

and RNA in the Reagent step when you create an assay, you include the inline control analysis in

the post-run results analysis. Inclusion of a set of six control amplicons (covering a range of amplicon
length) and spike-in nucleic acid into sample library preparation reactions helps determine whether poor
performance is due to insufficient sample input and/or poor sample quality, or is unrelated to sample
input and quality. With 10 ng sample input, the read ratio of endogenous sample reads to spike-in
control reads is expected to be ~3. Using more than 10 ng sample input results in a proportionally
higher read ratio. For example, if you load 20 ng of sample, the read ratio should be ~6.

The CF-1 templating control serves as a check on templating and sequencing performance that is
independent of library preparation.

Use the following table as a guide to help identify the source of performance problems. For
recommended actions, see the troubleshooting topics under “Genexus™ Integrated Sequencer—
general and QC troubleshooting” on page 148.

Run diagnostic

QC category Sample input Library preparation Templating or
Successful run and/or quality problem unrelated to Sequencing
problem sample problem
Sample QC (endogenous Passed Failed Failed Failed
sample reads)
Read ratio for inline controls Normal Low Normal or variable -
(endogenous to spike-in reads) | Read ratio ~3 Read ratio <<3
Templating Control QC - CF-1 Passed Passed Passed Failed

Genexus™ Software

Observation

Possible cause

Recommended action

Cannot sign in to the
Genexus™ Software

attempts.

You have either forgotten your
password or are signed out
due to several failed login

Contact the Genexus™ Software system

administrator.

Batch sample import fails

One or more entries in

the sample-import spreadsheet
contains special characters,
lines breaks, unexpected
spaces, incorrect entry length,
incorrect date formatting, or
other formatting errors.

Check each entry for correct formatting,
correct any errors, and repeat the import.
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Genexus™ Software

Observation

Possible cause

Recommended action

Batch sample import fails
(continued)

Blank rows were copied into
the sample-import template file
from a different source.

Rows that appear empty can contain hidden
formatting that conflicts with the import
function. Start with a clean sample-import
template file, and be careful to copy only those
rows that contain actual data.

The sample import
spreadsheet contains a
nonunique sample name.

Every sample name in the software must be
unique. Ensure that the spreadsheet does not
contain any duplicate sample names, then
repeat the import. Note that the system check
is not case-sensitive, so a sample name of
ABC1 conflicts with abc1.

The headings in the sample
import spreadsheet do not
match the sample attributes in
the software.

The headings must match the sample
attributes in the software exactly. Check the
headings for spelling or other errors.

Map a sample attribute if needed.

The assay | created does not
appear in the menu when | plan
arun

Forgot to lock your assay.

Go to Assay tab » Manage Assays and make
sure that the assay is locked.

Cannot upload my panel or
hotspots

Issues with BED file format or
files do not end in .bed.

Ensure your file is in the correct BED format
and has a .bed extension.

Variants tab is missing hotspot
entries

Details: The remaining entries
are present.

Hotspot BED file contains
entries that are incorrectly
formatted.

Check that BED file entry is correctly
formatted. See the following examples:

SNP entry: chr1 2337276 2337277 SVA_322 0
+ REF=C;0BS=T;ANCHOR=G AMPL

Deletion entry: chr1 201341175 201341180
SVA_497 0 + REF=AGAAG;0OBS=;ANCHOR=C
AMPL

Insertion entry: chr1 236978992 236978992
SVA_621 0 + REF=;0BS=TCTG;ANCHOR=T
AMPL

Ensure that the REF values match the actual
reference coordinate of hg19.

No information for my loci of
interest in the results

The wrong hotspot or BED file
is associated with the assay.

1. Check the hotspot and BED files
associated with the assay. If either is
incorrect, create a new assay.

2. Plan a new run for the sample or sample
library with the correct assay.

3. Repeat sequencing of the sample or
sample library.

The results of the run do not
appear in the Results / Run
Results screen

The instrument disk space is
full.

Clear disk space on the sequencer. For more
information, see "Manually delete run data"
in theGenexus™ Integrated Sequencer User
Guide (Pub. No. MANO017910).

Cannot download run result
files

The run failed.

Create an assay with the correct configuration
for the samples, then reanalyze the samples.
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Guidelines for Oncomine™ BRCA Assay GX settings

In the Genexus™ Software, the system-installed assays are configured with settings that are optimized
for each sample type (see “System-installed assays for use with the Oncomine™ BRCA Assay GX”

on page 31). If needed, you can copy a system-installed assay, then modify settings as needed. For
more information see, the software help system, or Genexus™ Software 6.8 User Guide (Pub. No.
MANO0026409).

Representative metrics for a successful sequencing run

154

The following tables summarize metric values that are expected from successful sequencing runs.

IMPORTANT! The values provided are examples from good quality samples that you can use as
guidelines to set QC threshold values. Set values based on your own internal data to represent the
quality of samples that you typically test in the lab.

Table 21 Example metrics for the Oncomine™ BRCA - GX5 Germline - DNA using DNA isolated from
blood tissue samples

QC metric Value
Run QC
Key Signal 60-87
Percent Loading 75-89%
Raw Read Accuracy 98-99%

Templating QC - CF-1 Control

Average Reads Per Lane 12,000-36,000

Base Call Accuracy 97-99%
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Table 21 Example metrics for the Oncomine BRCA - GX5 Germline - DNA using DNA isolated from

blood tissue samples (continued)

QC metric Value
Mean AQ20 Read Length (bp) 93-115
Sample QC - DNA
MAPD 0.1-0.3

Mapped Reads

600,000-1,100,000

Mean AQ20 Read Length (bp) 86-98
Mean Read Length (bp) 108-138
Uniformity Of Base Coverage 98-100%
NTC QC - DNA

Average Base Coverage Depth 1-46
MeanRead Length (bp) 40-53

Table 22 Example metrics for the Oncomine™ BRCA - GX5 Somatic - DNA using DNA isolated from

tumor FFPE tissue samples

QC metric Value
Run QC
Key Signal 60-87
Percent Loading 75-89%
Raw Read Accuracy 98-99%

Templating QC - CF-1 Control

Average Reads Per Lane

12,000-36,000

Base Call Accuracy 97-99%
Mean AQ20 Read Length (bp) 93-115
Sample QC - DNA

MAPD 0.1-0.4

Mapped Reads

300,000-1,400,000

Mean AQ20 Read Length (bp) 80-95
Mean Read Length (bp) 92-126
Uniformity Of Base Coverage 85-100%
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Table 22 Example metrics for the Oncomine BRCA - GX5 Somatic - DNA using DNA isolated from
tumor FFPE tissue samples (continued)

QC metric Value
NTC QC - DNA
Average Base Coverage Depth 4-37
MeanRead Length (bp) 49-67

Create a template for importing samples in standalone
configuration purification run plans

To use the Import function to import sample information from a USB drive into a standalone
configuration run plan for the Genexus™ Purification Instrument, add the sample information to a CSV
file with a specific format. Follow these steps to create an import template file with a plain text editor, or
with Microsoft™ Excel™ software.

1. Use the format in the follow examples to set up two columns in a CSV file for Sample Name and
Notes. Populate the sample rows with sample hame and notes.

1 Sample Name,Notes

2 CSV
3 CSV
4 C5V
5 CSv
6 CSV
7 C5V
B C5V
& CSV
10 C5V
11 C5V
12 C5V

“ 13 CSv

Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample
Sample

1,05V notes for sanmple
2,C5V notes for sample
3,C5V notes for sample
4,C5V notes for sample
5,05V notes for sanmple
€,C5V notes for sample
7,C5V nmotes for sample
8,C5V notes for sample
9,C5V notes for sample
10,C5V notes for sample 10
11,C5V notes for sample 11
12,C5V notes for sample 12

=1 o Nl W

W

@ Example file if in a plain text editor.
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A

Sample Name
CSV Sample 1
CSV Sample 2
CSV Sample 3
CSV Sample 4
CSV Sample 5
CSV Sample 6
CSV Sample 7
CSV Sample 8
CSV Sample 9
11 [C5V Sample 10
12 [C5V Sample 11
@ 13 |CsV Sample 12

=i = R B = VR B SO W R % R

-t
[

MNotes

CSV notes forsample 1
CSV notes for sample 2
CSV notes for sample 3
CSV notes for sample 4
CSV notes for sample 5
CSV notes for sample 6
CSV notes for sample 7
CSV notes for sample 8
CSV notes for sample 9
CSV notes for sample 10
CSV notes for sample 11
CSV notes for sample 12

@ Example file in Microsoft™ Excel™ software.
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Quantify nucleic acid samples

The Sample Name field populates the Sample ID field in the instrument screen.

2. Save the file using a CSV file format to a USB drive.

IMPORTANT!
. Do not add extra spaces in the headings, or add other columns in either file type.

. If you transfer files between macOS™ and Windows™ computers, extra characters that can cause
errors can be added to files. Check for the presence of extra characters, then delete if found.

. An alert is shown if fewer samples are in the CSV file than are selected for the run, or if two samples
have the same name in the CSV file. No samples are imported until the error is corrected.

Quantify nucleic acid samples

Isolate nucleic acid samples using one of the verified procedures and kits that are listed in
“Recommended materials for nucleic acid isolation, quantification, and quality control” on page 16.

IMPORTANT! The correct input amount of nucleic acid is critical for assay success. Use a Qubit™
Fluorometer to accurately measure sample concentration before you proceed to transferring into a
sample input plate..

Analyze 1 pL of nucleic acid sample using a Qubit™ Fluorometer with one of the following assay kits.
Follow the procedure in the corresponding user guide to prepare samples and standards, then calculate
sample concentration.

Sample type Kit User Guide

DNA Qubit™ dsDNA HS Assay Kit | Qubit™ dsDNA HS Assay Kits User Guide
(Pub. No. MAN0002326)

Qubit™ dsDNA BR Assay Kit | Qubit™ dsDNA BR Kits User Guide (Pub. No. MAN0002325)

Reanalysis

If a run fails to meet one or more QC parameters defined by the assay, you can adjust the assay
parameters and reanalyze a run or a sample from the run.

Reanalysis of runs can start from the alignment, basecalling, or signal processing steps. A sample can
be reanalyzed starting only from the alignment step.

For more information, see the Genexus™ Software 6.8 Help or the Genexus™ Software 6.8 User Guide
(Pub. No. MAN0026409).

coverageAnalysis plugin in Genexus™ Software

Use the coverageAnalysis plugin to view statistics and graphs that describe the level of sequence
coverage produced for targeted genomic regions. The results for a run analyzed with the plugin
vary based on the library type that you select when you configure the plugin. You can export some
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charts as graphics, such as the Amplicon Coverage Chart and the Reference Coverage Chart. The
coverageAnalysis plugin runs by default with the Oncomine™ BRCA Assay GX.

Reads statistics

The library type determines which statistics are presented. The following tables describe the statistics
that are generated by the coverageAnalysis plugin. The statistics that are displayed in your report
depend on the type of library that is used in your sequencing experiment. Definitions are in tooltips.
Almost every statistic, plot, link, and functional widget in the report provides tooltips with definitions.
Place the pointer over a heading or description in the report to view the tooltip.

Table 23 General statistics

Statistic

Description

Number of
mapped reads

The total number of reads mapped to the reference genome.

Percent reads
on target

The percentage of filtered reads mapped to any targeted region relative to all reads mapped

to the reference. If no target regions file is specified, this value will be the percentage of reads
passing uniquely mapped and/or nonduplicate filters, or 100% if no filters were specified. A read
is considered on target if at least one aligned base overlaps at least one target region. A read
that overlaps a targeted region but where only flanking sequence is aligned, for example, due to
poor matching of 5' bases of the read, is not counted.

Amplicon read coverage statistics

The following statistics describe the reads that are assigned to specific amplicons. Each sequence
read is assigned to exactly one of the amplicons specified by the targets file. If a read spans multiple
amplicon targets, the target region that the reads covers most is assigned. In the event of a tie, the
target that is the closest to the 3' end is assigned.

Statistic

Description

Number of amplicons

The number of amplicons that is specified in the target regions file.

Percent assigned
amplicon reads

The percentage of reads that were assigned to individual amplicons relative to all reads
mapped to the reference. A read is assigned to a particular (inner) amplicon region if any
aligned bases overlap that region. If a read might be associated with multiple amplicons, it
is assigned to the amplicon region that has the greatest overlap of aligned sequence.

Average reads per
amplicon

The average number of reads assigned to amplicons.

Uniformity of
amplicon coverage

The percentage of amplicons that had at least 20% of the average number of reads per
amplicon. Cumulative coverage is linearly interpolated between nearest integer read depth
counts.

Amplicons with at
least N reads

The percentage of all amplicons that had at least N reads.
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Statistic

Description

Amplicons with no
strand bias

The percentage of all amplicons that did not show a bias towards forward or reverse
strand read alignments. An individual amplicon has read bias if it has =10 reads and the
percentage of forward or reverse reads to total reads is greater than 70%. Amplicons with
<10 reads are considered to have no strand bias.

Amplicons reading
end-to-end

The percentage of all amplicons that were considered to have a sufficient proportion of
assigned reads (70%) that covered the whole amplicon target from 'end-to-end'. To allow
for error, the effective ends of the amplicon region for read alignment are within 2 bases of
the actual ends of the region.

Amplicon base
composition bias

A number that represents the proportion of amplicons showing low representation (<0.2x
mean reads) in the lower and/or upper quartiles of amplicons ordered by increasing G/C
base pair content of their insert sequences. The value is relative to that in the center 50th
percentile of amplicons and weighted by the standard deviation of representation over all
amplicons. An RMS (root mean square) value is used so that a bias greater in either upper
or lower quartiles produces a larger value than a mean bias seen more equally in both outer
quartiles. The value is 0 if the uniformity of amplicon coverage metric is 100%, however,
the value is not necessarily high at lower amplicon uniformity.

Target base coverage statistics

The following statistics describe the targeted base reads of the reference. A base covered by multiple
target regions is counted only once per sequencing read.

Statistic

Description

Bases in target
regions

The total number of bases in all specified target regions of the reference.

Percent base reads
on target

The percent of all bases covered by reads aligned to the reference that covered bases in
target regions. Clipped bases, deletions, and insertions (relative to the reference) are not
included in this percentage.

If no specific target regions were specified, the whole genome is the targeted regions.

Average base
coverage depth

The average number of reads of all targeted reference bases. This is the total number of
base reads on target divided by the number of targeted bases, and therefore includes any
bases that had no coverage.

Uniformity of base
coverage

The percentage of bases in all targeted regions (or whole genome) that is covered by
at least 20% of the average base coverage depth reads. Cumulative coverage is linearly
interpolated between nearest integer base read depths.

Target base coverage
at Nx

The percentage of target bases covered by at least N reads.
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(continued)

Statistic

Description

Target bases with no

strand bias

The percentage of all target bases that did not show a bias toward forward or reverse
strand read alignments. An individual target base is considered to have read bias if it has
>10 reads and the percentage of forward or reverse reads to total reads is greater than
70%. Target bases with <10 reads are considered to have no strand bias.

Percent end-to-end
reads

The percentage of on-target reads that fully cover their assigned amplicon (insert) from
‘end-to-end'. To allow for error, the effective ends of the amplicon region for read alignment
are within 2 bases of the actual ends of the region.

Example charts generated by the coverageAnalysis plugin

The charts that are generated by the coverageAnalysis plugin include Plot, Overlay, or Display menus
that allow you to customize the data that is displayed in each chart.

Click Q (Search) (in the top right corner of a chart) to open the chart Viewing Options panel, where
you can further customize a chart. Click ? (Help) to open a description of the chart.

~ Depth of Coverage Chart IPIot: Maximum Read Depth ¥ I Zoom Out) ? P

Viewing Options: Automatic Zoom: # Show Legend: ¢ Include Ox Coverage: ¥ Bin Size: 1000

4.0%

1.0%

0.0%
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Bases

Cumulative Bases 80%

Cumulative Bases
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20000 30000 40000 50000 60000 70000 80000 90000

Base Read Depth

Figure 3 Representative Depth of Coverage Chart

The Depth of Coverage Chart shows the distribution of targeted base coverage. The X-axis represents the base read

depth. The left Y-axis represents the number of reads at a given base read depth or a range (bin) of base read depths, as
a percentage of the total number of base reads. The right Y-axis represents the cumulative count of the number of reads
at a given read depth or greater, as a percentage of the total number of reads. The individual orange bars represent the
percentage of reads in the specific range of base read depths. The blue curve measures the cumulative reads at a given
base read depth or greater. If your analysis includes a region of interest file, this chart reflects only target regions (reads
that fall within a region of interest). Use the Plot dropdown list to switch between Maximum Read Depth, 99.9% of All
Reads, and Normalized Coverage plots.
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Representation Plots Display: Pass/Fail vs. Target G/C Content v
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Figure 4 Representation Plots

Use the Display dropdown list to switch between Pass/Fail vs. Target G/C Content, Pass/Fail vs. Target Length,

Representation vs. Target G/C Content, Amplicon Coverage Chart, Mean Target Reads vs Pool, Reference

Coverage Chart, and Representation vs. Target Length plots. This figure shows an example Pass/Fail vs. Target

G/C Content plot.

Output files generated by the coverageAnalysis plugin

You can download coverageAnalysis plugin results files from the Results screen for a sample. For more

information, see “Results files” on page 142.

Note: Sometimes the downloaded file name can be too long to open a file in applications such

as Microsoft™ Excel™. To resolve this problem, right-click the file, click Save As, then rename the

downloaded file with a shorter name.

The following tables describe the files that can be generated by the coverageAnalysis plugin. The list of
files depends on the type of assay template that was selected during assay creation.

Table 24 File download selections in the Genexus™ Software

Selection File Name
DNA Coverage Statistics <DNA Barcode><ExpName>.stats.cov.txt
DNA Chromosome base coverage summary <DNA Barcode><ExpName>.chr.cov.xls

DNA Base depth of coverage <DNA

Barcode><ExpName>.

base.cov.x1ls

DNA Amplicon coverage summary <DNA

Barcode><ExpName>.

amplicon.cov.xls

DNA Coverage Analysis Summary (.pdf) <DNA

Barcode><ExpName>.

summary.pdf

RNA Coverage Statistics <RNA

Barcode><ExpName>.

stats.cov.txt

RNA Amplicon coverage summary <RNA

Barcode><ExpName>.

amplicon.cov.xls

RNA Coverage Analysis Summary (.pdf) <RNA

Barcode><ExpName>.

summary.pdf

TNA Coverage Statistics <TNA

Barcode><ExpName>.

stats.cov.txt

TNA Chromosome base coverage summary <TNA

Barcode><ExpName>.

chr.cov.xls

TNA Base depth of coverage <TNA

Barcode><ExpName>.

base.cov.x1ls

Oncomine™ BRCA Assay GX User Guide

161




Appendix B Supplemental information
coverageAnalysis plugin in Genexus™ Software

Table 24 File download selections in the Genexus Software (continued)

Selection File Name
TNA Amplicon coverage summary <TNA Barcode><ExpName>.amplicon.cov.xls
TNA Coverage Analysis Summary (.pdf) <TNA Barcode><ExpName>.summary.pdf

Table 25 File contents

File Description
Coverage A summary of the statistics presented in the tables at the top of the plugin report. The first line is
Statistics the title. Each subsequent line is either blank or a particular statistic title followed by a colon ()
and its value.
Chromosome Base reads per chromosome summary data that is used to create the default view of the
base coverage Reference Coverage Chart. This file contains the following fields.
summary .

chrom: the name of the chromosome or contig of the reference.

start: the coordinate of the first base in this chromosome. This is always 1.

end: the coordinate of the last base of this chromosome. Also its length in bases.

fwd basereads: the total number of forward strand base reads for the chromosome.
rev_basereads: the total number reverse strand base reads for the chromosome.

fwd trg basereads (if present): the total number of forward strand base reads that
mapped over at least one target region.

rev_trg basereads (if present): the total number of reverse strand base reads that
mapped over at least one target region.

total reads: the total number of sequencing reads that are mapped to individual
contigs.

Base depth of

Coverage summary data used to create the Depth of Coverage Chart. This file contains the

coverage following fields.
* read depth: the depth at which a (targeted) reference base has been read.
* Dbase_cov:the number of times any base was read (covered) at this depth.
Note: Lines (read depths) for which base cov is 0 are omitted to avoid excessively large
files being produced in specific situations.
* base cum_cov: the cumulative number of reads (coverage) at this read depth or greater.
* norm read depth: the normalized read depth (depth divided by average base read
depth).
®* pc base cum_cov:same as base_cum_cov but represented as a percentage of the total
base reads.
162 Oncomine™ BRCA Assay GX User Guide




Appendix B Supplemental information

samplelD plugin
Table 25 File contents (continued)
File Description
Amplicon Coverage summary data used to create the Amplicon Coverage Chart. This file contains the
coverage following fields:
summary .

contig_id:the name of the chromosome or contig of the reference for this amplicon.
®* contig_srt:the start location of the amplicon target region.
Note: This coordinate is 1-based, unlike the corresponding 0-based coordinate in the
original targets BED file.
* contig end: the last base coordinate of this amplicon target region.

Note: The length of the amplicon target is given as tlen = (contig_end - contig_srt + 1).
* region_id:the ID for this amplicon as given as the fourth column of the targets BED file.

® gene_ idorattributes: the gene symbol or attributes field as provided in the targets
BED file.

® gc_count:the number of G and C bases in the target region. The %GC that is uses this
count divided by the amplicon (insert) length.

* overlaps: the number of times this target was overlapped by any read by at least one
base.
Note: Individual reads might overlap multiple amplicons where the amplicon regions
themselves overlap.

¢ fwd e2e:the number of assigned forward strand reads that read from one end of the
amplicon region to the other end.

* rev_eZ2e:the number of assigned reverse strand reads that read from one end of the
amplicon region to the other end.

* total reads: the total number of reads assigned to this amplicon. This value is the sum
of fwd_reads and rev_reads and is the field that rows of this file are ordered by (then by
contig id, srt, and end).

¢ fwd reads: the number of forward strand reads that are assigned to this amplicon.
* rev_reads: the number of reverse strand reads that are assigned to this amplicon.

* covNx: the number of bases of the amplicon target that had at least N reads. There are 3
such columns for the specified coverage tiers, which by default are cov100x, cov350x,
and cov500x.

Coverage A PDF file that contains the Coverage Analysis Report, including read statistics and charts that
Analysis are generated by the coverageAnalysis plugin.
Summary (.pdf)

samplelD plugin

The samplelD plugin produces an identification code (SamplelD) for each barcode in a sample.

The samplelD plugin runs by default with the Oncomine™ BRCA Assay GX, which is a human SNP
genotyping panel, to help ensure that the accuracy of samples increase confidence in sample data
management. The sample ID identification codes produced are composed of the identified human
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sample gender and IUPAC base letters for eight high-frequency noncoding SNPs. lon AmpliSeq™
Sample ID Panel contains nine primer pairs.

For the samples to work with this plugin, the lon AmpliSeq™ library must have been prepared with lon
AmpliSeq™ sample tracking amplicons. SamplelD amplicons are part of the panel.

The samplelD plugin is preconfigured and does not require input.

Sample ID Report

Statistic

Description

Number of mapped reads

The total number of reads mapped to the reference genome.

Number of reads in sample ID
regions

The total number of reads mapped to Sample ID regions.

Percent reads in sample ID regions

The percent of all reads aligned to the reference that covered bases in
Sample ID regions.

Total base reads in sample ID
regions

The total base reads aligned to the reference that covered bases in Sample
ID regions.

Percent base reads in sample ID
regions

The percent of all bases covered by reads aligned to the reference that
covered bases in Sample ID regions.

Male sample ID region reads

Number of reads mapped to the specific male (Y) identification target(s).

Female sample ID region reads

Number of reads mapped to the specific female (X) identification target(s).

Sample ID Regions and Sample ID SNPs

Bases in target regions

The total number of bases in all specified target regions of the reference.

Average base coverage depth

The average number of DNA reads of all targeted reference bases.

Uniformity of coverage

The percentage of target bases covered by at least 0.2x of the average base
coverage depth.

Coverage at 1x

The percentage of target bases covered by at least 1 read.

Coverage at 20x

The percentage of target bases covered by at least 20 reads.

Coverage at 100x

The percentage of target bases covered by at least 100 reads.

164

Oncomine™ BRCA Assay GX User Guide




Appendix B Supplemental information
samplelD plugin

Output files generated by the samplelD plugin

You can download samplelD plugin results files from the Results screen for a sample. For more

information, see “Results files” on page 142.

Note: Sometimes the file name can be too long to open in applications such as Microsoft™ Excel™. To
resolve this problem, right-click the file and click Save As to rename the downloaded file.

Table 26 describes the files that can be generated by the samplelD plugin. The list of files depends on
the application type that was selected during assay creation.

Table 26 File download selections in the Genexus™ Software

Selection

File Name

Tracking Loci Regions (SNPs) File

tracking loci.bed

Aligned Tracking Reads Index (BAl) File

<DNA Barcode><ExpName>.bam.bai

Hard-copy A4 PDF Image Of This Report Page

<DNA Barcode><ExpName>.sampleID.pdf

Tracking Target Regions File

tracking regions.bed

Aligned Tracking Reads (BAM) File

<DNA Barcode><ExpName>.bam

All Variant Calls As a Table File

allele counts.xls
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WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.

Biological hazard safety

A
A
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WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.
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Documentation and support

Related documentation

Document Publication number
Genexus™ Integrated Sequencer User Guide MANO0017910
Genexus™ Integrated Sequencer Quick Reference MANO0017912
Genexus™ Purification System User Guide MANO0018475
Genexus™ Software 6.8 User Guide MANO0026409
Genexus™ Software 6.8 Help MANO0026408 (available in the software)
Qubit™ dsDNA HS Assay Kits User Guide MANO0002326
Qubit™ dsDNA BR Kits User Guide MANO0002325

Note: For additional documentation, see “Customer and technical support”.
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Customer and technical support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers
* Product support information
- Product FAQs
— Software, patches, and updates
— Training for many applications and instruments
® Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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